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Preface

Welcome to the Geneticist Assistant User’s Manual. The purpose of the Geneticist Assistant 
User’s Manual is to answer your questions and guide you through the procedures necessary 
to use the Geneticist Assistant application efficiently and effectively.

Using the manual
You will find the Geneticist Assistant User’s Manual easy to use. You can simply look up the 
topic that you need in the table of contents or the index. Later, in this Preface, you will find a 
brief discussion of each chapter to further assist you in locating the information that you 
need.

Special information about the manual
The Geneticist Assistant User’s Manual has a dual purpose design. It can be distributed 
electronically and then printed on an as-needed basis, or it can be viewed online in its fully 
interactive capacity. If you print the document, for best results, it is recommended that you 
print it on a duplex printer; however, single-sided printing will also work. If you view the 
document online, a standard set of bookmarks appears in a frame on the left side of the 
document window for navigation through the document. For better viewing, decrease the 
size of the bookmark frame and use the magnification box to increase the magnification of 
the document to your viewing preference.

If you do print the document using a single-sided printer, you might see a single 
blank page at the end of some chapters. This blank page has been added solely to 
ensure that the next chapter begins on an odd-numbered page. This blank page in 
no way indicates that your book is missing information.
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Preface
Conventions used in the manual
The Geneticist Assistant User’s Manual uses the following conventions:

• Information that can vary in a command—variable information—is indicated by 
alphanumeric characters enclosed in angle brackets; for example, <Gene ID>. Do not type 
the angle brackets when you specify the variable information.

• A new term, or term that must be emphasized for clarity of procedures, is italicized.

• Page numbering is “online friendly.” Pages are numbered from 1 to x, starting with the 
cover and ending on the last page of the index.

• This manual is intended for both print and online viewing.

• If information appears in blue, it is a hyperlink. Table of Contents and Index entries 
are also hyperlinks. Click the hyperlink to advance to the referenced information.

Assumptions for the manual
The Geneticist Assistant User’s Manual assumes that:

• You are familiar with windows-based applications and basic Windows functions and 
navigational elements.

• References to any third party standards or third party software functions were current as 
of the release of this version of Geneticist Assistant, and might have already changed. 

Organization of the manual
In addition to this Preface, the Geneticist Assistant User’s Manual contains the following 
chapters and appendices:

• Chapter 1, “Getting Started with Geneticist Assistant,” on page 13 details the installation 
requirements and installation procedure for Geneticist Assistant. It also explains how to 
open and log into Geneticist Assistant and it provides an overview of the major 
navigational elements on the main window for the application, the main menu, the 
toolbar, the tabs display area, and the status bar.

• Chapter 2, “Geneticist Assistant Setup and Maintenance,” on page 47 details the objects 
that are available in Geneticist Assistant and how you can add, edit, or delete values for 
these objects. It also details the various settings (reference directory, pathogenicity colors 

Although numbering begins on the cover page, this number is not visible on the 
cover page or front matter pages. Page numbers are visible beginning with the 
first page of the table of contents.
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coverages, and so on) that you can specify for your Geneticist Assistant installation. 
Finally, it explains how to back up the Geneticist Assistant database.

• Chapter 3, “Geneticist Assistant User Management,” on page 69 details how to manage 
users and groups in Geneticist Assistant, including adding new users and groups, deleting 
users and groups, and managing the permissions for users and groups.

• Chapter 4, “Managing Panels and Subpanels,” on page 83 details the management of your 
Geneticist Assistant panels, which includes, adding, modifying and deleting panels, and 
reviewing panel statistics, and adding, modifying, and deleting subpanels.

• Chapter 5, “Managing Patients and Runs,” on page 105 details the management of 
patients. It also details how to add and carry out runs in Geneticist Assistantt.

• Chapter 6, “Geneticist Assistant Data Review - Runs Tab,” on page 155 details all the 
options that are available to you from the Runs tab for reviewing the data that is generated 
by a run.

• Chapter 7, “Geneticist Assistant Data Review - Run Tab,” on page 179 details all the 
options that are available to you from the Run tab for reviewing the data that is generated 
by a run.

• Chapter 8, “Geneticist Assistant Data Review - Sample Tab,” on page 215 details all the 
options that are available to you from the Sample tab for reviewing the data that is 
generated by a run.

• Chapter 9, “Geneticist Assistant Data Review - Variant Tab,” on page 245 details all the 
options that are available to you from the Variant tab for reviewing the data that is 
generated by a run.

• Chapter 10, “Geneticist Assistant Reports,” on page 267 details the generation of the six 
standard reports that are available in Geneticist Assistant. It also details how to generate 
a custom report, which includes only the data that you select.

• Chapter 11, “Geneticist Assistant Tools,” on page 277 details the various tools that are 
available in Geneticist Assistant to assist you with setting up, running, and analyzing 
sample data.

• The Glossary on page 291 provides a detailed definition of specialized terms for 
Geneticist Assistant. 
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Chapter 1
Getting Started with Geneticist 
Assistant

Geneticist Assistant is a web-based tool for the control, visualization, interpretation, and 
creation of a historical knowledge base of next generation sequencing data. This data is used 
to identify potentially pathogenic variants that are associated with specific conditions such as 
hereditary colon cancer. This chapter details the installation recommendations for Geneticist 
Assistant and how to install Geneticist Assistant. It also explains how to launch Geneticist 
Assistant and provides an overview of the major navigational elements for the application, 
including the menu bar, the toolbar, and the main window tabs.

This chapter covers the following topics:

• “Geneticist Assistant System Recommendations” on page 15.

• “Installing the SoftGenetics License Server” on page 16.

• “Installing Geneticist Assistant on a Windows OS” on page 17.

• “Installing the Geneticist Assistant Database Server on a Linux OS” on page 19.

• “Starting and Logging in to Geneticist Assistant” on page 21.

• “Upgrading Geneticist Assistant” on page 27.

• “The Geneticist Assistant Main Window” on page 28.

• “Setting Display Preferences in the Geneticist Assistant Main Window” on page 31.

• “Searching the Geneticist Assistant Database” on page 44.
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Chapter 1
Getting Started with Geneticist Assistant
Geneticist Assistant System Recommendations
You must have Administrator rights for the computer on which you are installing Geneticist 
Assistant.

Table 1-1: Geneticist Assistant Recommended Hardware Specifications

Client and/or Server

Operating System • Windows 7, 8, or 10 64 bit (Recommended)

• Windows Vista (64 bit)

• Windows Server 2008 (64 bit)

• Windows Server 2012 (64 bit)

Processors Two cores (64 bit)

RAM • 8 GB (Client)

• 4 GB (Server)

Minimum: 2 GB for client and server

Hard Drive • Solid State Drive

• 100 GB (Minimum)

Note: Virtual Machines are supported.

Table 1-2: Geneticist Assistant Data Specifications

Database Client

• 4 GB disk space (Minimum) • 50 GB space for reference and annotation data

• Starts at 15 MB and grows slowly • BAM files - Ca. the same size as raw FASTQ data

• Backup with mysqldump

• Low IOPS

Table 1-3: Geneticist Assistant Software Details

Server Client

• Apache 2.2 (Latest) • Qt 4.84

• mod_wsgi (Latest) • Bamtools 2.1.1

• OpenSSL (Latest) • Zlib 1.2.8

• MySQL 5.6 (Latest) • Qjson 2.1

• Python 2.7 (Latest) • OpenSSL 0.9.7

• Django 1.6 (Latest)

• South (Latest)

• Setuptools (Latest)

• MySQLdb (Latest)
Geneticist Assistant User’s Manual 15
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Installing the SoftGenetics License Server
Before you install Geneticist Assistant, if you have a purchased version of Geneticist 
Assistant, then you must install the SoftGenetics license server. The license server is a 
central location either locally or on a network where software application licenses are stored 
and can be accessed by users of the application. After you install and open Geneticist 
Assistant for the first time, you will be prompted to configure Geneticist Assistant to connect 
to the SoftGenetics license server so that you can use Geneticist Assistant. The executable to 
install the SoftGenetics license server is named SrvSetup_<>_exe and it is available from 
SoftGenetics’s ftp site. Contact SoftGenetics for assistance in obtaining this file. 

If you are running a trial version of Geneticist Assistant, then you do not need to 
set up the SoftGenetics license server. You can simply indicate that you are 
running a trial version after you log in to Geneticist Assistant.
16 Geneticist Assistant User’s Manual



Chapter 1
Getting Started with Geneticist Assistant
Installing Geneticist Assistant on a Windows OS
SoftGenetics provides a single standard executable file—Geneticist AssistantSetup< >.exe—
for the installation of both the Geneticist Assistant client and the database server. You must 
have Administrator rights on the computer(s) on which you are installing Geneticist 
Assistant. You can install the client and the database server on the same computer or on 
different computers. When the installer first opens, Server is not selected and Client is 
selected. 

• If you are installing the client and database server on the same computer, then you must 
select Server before you click Install. 

• If you are installing the client and database server on different computers, then:

• When you run the installer on the computer on which you are installing the Geneticist 
Assistant client, you must leave the Server option cleared and the Client option 
selected. 

• When you run the installer on the computer on which you are installing the database 
server, you must select the Server option and clear the Client option.

Figure 1-1:  Geneticist Assistant Installation wizard, Client/Server options

When you install Geneticist Assistant, you are prompted to create the Administrator role for 
the installation. By default, the Username is set to Administrator, but you can always enter a 
different value. The password cannot contain any spaces. If you intend to implement 
additional password requirements, then the password must also adhere to these planned 
requirements. Figure 1-2 on page 18 shows the requirements that you can specify for user 
passwords after Geneticist Assistant is installed. (See “To specify the Geneticist Assistant 
password requirements” on page 63.)
Geneticist Assistant User’s Manual 17
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Figure 1-2:  User password requirement options

The email address is the address that is linked to the Administrator account.

Figure 1-3:  Administrator Setup dialog box

The Geneticist Assistant client is installed in C:\Program Files\Softgenetics\Geneticist 
Assistant and you cannot change this location. The Apache HTTP server is installed in the 
directory C:\Program Files (x86)\Apache2.2_forGA and you cannot change this location. 
The Python programming language is installed to a directory on your hard drive with the 
version number embedded. For example, version 2.7 of Python is installed in C:\Python27.

The Geneticist Assistant executable is configured to look for any available local 
port during installation; however, if an error message is displayed that the Apache 
service could not be started, you might have a conflict with an application that is 
already using the selected port such as Skype. Contact SoftGenetics for assistance.
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Installing the Geneticist Assistant Database 
Server on a Linux OS

To install Geneticist Assistant database server on a Linux OS, you must do the following:

• Create the Geneticist Assistant database.

• Set up the Geneticist Assistant database server.

• Create and migrate the initial database contents.

• Configure Apache2.

• Test the installation.

To create the Geneticist Assistant database
1. If it is not already installed, install OpenSSH.

2. Verify that python2.7 is installed.

3. Install the following components in the order indicated:

4. Create the database, and then replace the username and password with the password that 
you created during the mysql-server setup. 

     

You must still install the Geneticist Assistant client on a Windows OS. See 
“Installing Geneticist Assistant on a Windows OS” on page 17.

Component Installation

apache2 sudo apt-get install apache2

libapache2-mod-wsgi sudo apt-get install libapache2-mod-wsgi

mysql sudo apt-get install mysql-server mysql-client

pip sudo apt-get install python-pip

Django 1.6.11 sudo pip install Django==1.6.11

South sudo pip install south

python-mysqldb sudo apt-get install python-mysqldb

There is no space after -u and -p:
mysql -u<username> -p<password> -e "create database softgenetics”
Geneticist Assistant User’s Manual 19
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To set up the Geneticist Assistant database server
1. Download the Geneticist Assistant database server.

2. Extract the Geneticist Assistant server.

3. Move the Geneticist Assistant server to the installation location:
sudo mv ga_server_<version number> /opt/

4. Change the permissions: 
sudo chown -R www-data:www-data /opt/ga_server_<version number>/

5. Change the directory: cd /opt/ga_server_<version number>

6. Edit the settings: sudo vi ga/settings.py, and then in the DATABASES section, configure 
the mysql user and password that you created during the mysql-server setup.

To create and migrate the initial database contents
1. Create the initial database contents: python manage.pyc syncdb, and then configure the 

administrator username, password, and email address for Geneticist Assistant.

2. Migrate the database: python manage.pyc migrate

To configure Apache2
1. To set up the Install/Create keys:

sudo openssl req -x509 -nodes -days 3650 -newkey rsa:2048 -keyout /etc/apache2/
server.key -out /etc/apache2/server.crt

2. Configure Apache2:

• sudo cp softgenetics.conf /etc/apache2/site-available/

• sudo a2ensite softgenetics.conf 

• sudo a2enmod ssl

• sudo service apache2 restart

To test the installation
Test the connection to the database server from a client with the following credentials:

• Server: https://<hostname>

• Username: <created during install>

• Password: <created during install>

Contact SoftGenetics for the most recent version.
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Starting and Logging in to Geneticist Assistant
After you install Geneticist Assistant, a shortcut icon for the application is placed on the 
desktop. An option for the application is also available from the Start menu. After Geneticist 
Assistant is installed and you open Geneticist Assistant for the first time, you must specify 
the URL for the database server.

Figure 1-4:  Geneticist Assistant desktop icon

1. Double-click the desktop icon to launch the application, or select the option from the 
Start menu (Start > All Programs > SoftGenetics > Geneticist Assistant).

The Geneticist Assistant Login dialog box and a Geneticist Assistant Debug window 
open.

Figure 1-5:  Geneticist Assistant Login dialog box and Debug window

     

Before you log in to Geneticist Assistant, you can click Proxy Settings to open the 
Proxy Settings tab on the Settings dialog box. If your organization uses a proxy 
server for external connections, then to view data from the external databases 
OMIM or LOVD in Geneticist Assistant, you must configure the settings for the 
proxy server on this tab. See “To configure proxy server settings” on page 66.
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2. If this is the first time that you are logging in to Geneticist Assistant, then do the 
following; otherwise, go directly to Step 4.

• In the Server field, enter the URL for the Geneticist Assistant database server:

• In the Username field, enter your username, and then in the Password field, enter 
your password, and then click OK.

3. Continue to one of the following:

• If you are running a trial version of Geneticist Assistant, continue to “To run a trial 
version of Geneticist Assistant” on page 23.

• If you are running a purchased version of Geneticist Assistant, continue to “To run a 
purchased version of Geneticist Assistant” on page 24.

4. If needed, in the Username field, enter your username, and then in the Password field, 
enter your password, and then click OK. One of the following happens:

• If your login is successful, then the Geneticist Assistant Login dialog box closes, 
“Success” is displayed in the Debug window, and the Geneticist Assistant main 
window opens. The Debug window remains open.

• If your login is not successful, then the reason for the failure is displayed in the 
Debug window. If you are unable to resolve the login issues based on the messages 
in the Debug window, contact SoftGenetics for assistance. 

     

Installation Type Description

Local The database server is installed on the local computer. The URL for this is 
https://localhost.

Intranet The database server is installed on a different computer that is on your 
network. The URL must include the computer name or IP address.

Internet The database server is installed on a computer that has Internet access. 
The computer can be outside your local network. The URL must include 
the computer name or IP address.

Note: Geneticist Assistant uses SSL encryption to ensure the security of 
the data over the Internet.

For subsequent Geneticist Assistant sessions, the Username field is automatically 
populated with the username for the user who last logged in, and the Server field 
is automatically populated with the URL for the database server.

The Debug window displays the results after each step that you carry out in 
Geneticist Assistant. You must leave this window open for the duration of your 
session. If you close it, then you also close Geneticist Assistant.
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5. Continue to one of the following:

• If you are running a trial version of Geneticist Assistant, continue to “To run a trial 
version of Geneticist Assistant” below.

• If you are running a purchased version of Geneticist Assistant, continue to “To run a 
purchased version of Geneticist Assistant” on page 24.

To run a trial version of Geneticist Assistant
After you log into Geneticist Assistant, if you are running a trial version of Geneticist 
Assistant, then a Configure License message always opens.

Figure 1-6:  Configure License message

1. Click Run Trial.

The Configure License message closes. Two results are possible.

• If this is the first time that you are running the trial version, then a Reference 
Directory Not Found message opens. You must configure your reference directory 
before you can use the software. Continue to Step 2.

Figure 1-7:  Reference Directory Not Found message

• If this is not the first time that you are running the trial version, and the reference 
directory has already been configured, then the Geneticist Assistant main window 
opens. Continue to “The Geneticist Assistant Main Window” on page 28.

2. Do one of the following:

• To configure the reference directory now, click Configure Now to open the Settings 
dialog box, and then continue to “To configure the reference directory” on page 26.

• To configure the reference directory at a later date, click Skip Now.

The Reference Directory Not Found message closes and the Geneticist Assistant 
main window opens. Continue to “The Geneticist Assistant Main Window” on page 
28.

For detailed information about configuring the required reference directory at a 
later date, see “Specifying your Geneticist Assistant Settings” on page 53.
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To run a purchased version of Geneticist Assistant
If you are running a purchased version of Geneticist Assistant, then the first time that you run 
the application, a Configure License message opens. You must configure Geneticist 
Assistant to connect to the SoftGenetics license server. After you configure the license 
server, this message does not open again.

Figure 1-8:  Configure License message

1. Click Configure Now.

The Settings dialog box opens. The License Settings tab is the only tab on the dialog 
box.

Figure 1-9:  Settings dialog box

2. In the server name, enter the fully qualified domain name (FQDN) for the server (where 
the license server manager is installed), or its IP address.

3. Leave the Port value set to the default value of 50000.

     

If the SoftGenetics license server is running on the same computer on which 
Geneticist Assistant is running, then you must enter 127.0.0.1. 
24 Geneticist Assistant User’s Manual



Chapter 1
Getting Started with Geneticist Assistant
4. Click OK.

The Settings dialog box closes, and a Reference Directory Not Found message opens. 
You must configure your reference directory before you can use the software. 

Figure 1-10:  Reference Directory Not Found message

5. Do one of the following:

• To configure the reference directory now, click Configure Now to open the Settings 
dialog box, and then continue to “To configure the reference directory” on page 26.

Figure 1-11:  Settings dialog box, Directories tab

• To configure the reference directory at a later date, click Skip Now.

The Reference Directory Not Found message closes and the Geneticist Assistant 
main window opens. Continue to “The Geneticist Assistant Main Window” on page 
28.

     

For detailed information about configuring the required reference directory at a 
later date, see “Specifying your Geneticist Assistant Settings” on page 53.
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To configure the reference directory

Before you run Geneticist Assistant for the first time, you must configure the reference 
directory. The reference directory contains the information for the reference that was used 
for aligning the data and/or detecting variants. References files are stored in their own 
folders in this directory. For example, if you are studying variants that are associated with the 
human genome, then you might create a Human folder in the Reference directory, such as 
C:\References\Human 37. 

1. Create your reference directory in a location that meets your business needs.

2. Click the Browse button  next to the Reference Directory field, and then browse to 

and select the Reference directory.

3. Click OK to close the Settings dialog box and return to the Geneticist Assistant main 
window.

4. Continue to “The Geneticist Assistant Main Window” on page 28.

To log out of Geneticist Assistant
To log out of Geneticist Assistant, on the main menu, click File > Exit.

After you specify the location for the reference directory, and submit data to the 
Geneticist Assistant database, you cannot change its location.

Although not required, SoftGenetics recommends that you create this directory on 
the same computer and drive on which you installed the Geneticist Assistant 
client.

The Debug window displays the results after each step that you carry out in 
Geneticist Assistant. You must leave this window open for the duration of your 
session. If you close it, then you also close Geneticist Assistant.
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Upgrading Geneticist Assistant
If you are upgrading to a newer version of Geneticist Assistant, then you do not need to 
uninstall the current version. After you have completed the upgrade, and then log in to 
Geneticist Assistant for the first time, an Uncompressed References Detected message 
opens, indicating that Geneticist Assistant first needs to compress all the associated reference 
files before you can work in Geneticist Assistant.

Figure 1-12:  Uncompressed References Detected message dialog box

1. Click Compress.

A dialog box opens, indicating the progress in compressing the reference files.

Figure 1-13:  Compressing reference files progress dialog box

2. After the Compression Progress dialog box indicates that the compression is 100% 
complete, click OK.

The Compression dialog box closes, and Geneticist Assistant is now ready for use.

This process can take anywhere from one to four hours based on your system’s 
available resources, and Geneticist Assistant is unavailable during this time. 
Geneticist Assistant User’s Manual 27



Chapter 1
Getting Started with Geneticist Assistant
The Geneticist Assistant Main Window
The Geneticist Assistant main window opens automatically after you successfully log in to 
the Geneticist Assistant application. 

Figure 1-14:  Geneticist Assistant main window

The Geneticist Assistant main window is your starting point for the Geneticist Assistant 
application. The window provides quick access to all of the Geneticist Assistant functions. 
From top to bottom, the Geneticist Assistant main window has five major components—the 
title bar, the main menu, the toolbar, the tabs display area, and the status bar.

Title bar
The name “Geneticist Assistant” is displayed in the title bar at the top of the Geneticist 
Assistant main window.

Figure 1-15:  Geneticist Assistant title bar

Main menu
The main menu is set up in a standard Windows menu format with menu commands grouped 
into menus (File, Panels, References, Views, Reports, Filters, Tools, Backup, and Help) 
across the menu bar. 

Figure 1-16:  Geneticist Assistant main menu
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Toolbar
The Geneticist Assistant main window toolbar is located below the main menu. It always 
contains a Refresh option and a Search feature. If the Runs tab or the Patients tab is open, it 
also contains options for limiting the display on the tab.

• You use the Refresh option to manually refresh a tab display after the tab opens in the 
main window and data is loaded, or after adding, modifying, and/or deleting data on a tab. 
See “Main window tabs” below.

• You use the Search feature to search for samples, runs, panels, panel groups, sample 
groups, genes, or variants in your Geneticist Assistant database. See “Searching the 
Geneticist Assistant Database” on page 44.

Figure 1-17:  Geneticist Assistant main window toolbar

Main window tabs
When the Geneticist Assistant main window first opens, two tabs— Runs and Current 
Jobs—are displayed in the window. The Runs tab is the open tab. A run refers to loading a 
BAM file and a VCF file or just a VCF file into Geneticist Assistant for the purposes of 
importing a list of variants into the Geneticist Assistant database and/or reviewing a list of 
variants. The Runs tab has a single pane—the Runs pane. 

Figure 1-18:  Geneticist Assistant main window, Runs tab with Runs pane

• If you are an Administrator user, then the Runs pane can display all the runs submitted by 
all users to your Geneticist Assistant database. By default, when the tab first opens, only 
the 30 most recently submitted runs are displayed and the runs are sorted based on the Run 
ID. You can limit the runs that are displayed by number and/or by a time and date range 
and you can also change the sort order of the data. 
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• If you are a standard user, then the Runs pane can display all the runs that you have 
submitted to your Geneticist Assistant database as well as all the runs that have been 
submitted by other users and for which you have been granted at least the Can Read 
permission. By default, when the tab first opens, only the 30 most recently added runs that 
fit one of these two criteria are displayed and the runs are sorted based on the Run ID. You 
can limit the runs that are displayed by number and/or by a time and date range and you 
can also change the sort order of the data. 

The Current Jobs tab displays the progress of a run, or any other process that is currently 
being carried out in Geneticist Assistant. The tab opens automatically after a run is started. 
After the run is successfully completed (a BAM and a VCF file are loaded and read, or a 
VCF file is loaded and read), the Current Jobs tab is cleared and remains blank. Other tabs 
are available in the display area of the Geneticist Assistant main window depending on the 
actions that you carry out.

With the exception of the Current Jobs tab, every tab in Geneticist Assistant has at least one 
pane. The different panes display different information. Data is displayed in columns in the 
tab panes. A variety of options are available for setting preferences for the tab display and 
the data column display. See “Setting Display Preferences in the Geneticist Assistant Main 
Window.”

Status bar
The Status bar is displayed at the bottom of the Geneticist Assistant main window. Summary 
information that is tab-specific is displayed in the left corner of the status bar. Release 
information (Version, Release Build, Revision, and Build Date) is displayed in the right 
corner of the status bar. This release information is identical to the release information that is 
displayed from the Help > About menu option.

Figure 1-19:  Geneticist Assistant main window, Status bar

If you close the Runs tab, you can open it again from the Geneticist Assistant main 
menu: File > Runs.
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Setting Display Preferences in the Geneticist 
Assistant Main Window

With the exception of the Current Jobs tab, every tab in Geneticist Assistant has at least one 
pane. The different panes display different information. Data is displayed in columns in the 
tab panes. A variety of options are available for setting preferences for the tab and tab pane 
displays and the data column display. You can:

• Navigate multiple open tabs/minimized window. See “To navigate multiple open tabs/
Navigate tabs with a minimized main window” on page 32.

• Close multiple tabs in a single step. See “To close multiple tabs in a single step” on page 
32.

• Show/hide the toolbar for a tab. See “To show/hide the toolbar for a tab” on page 32.

• Show/hide a tab pane. See “To show/hide a tab pane” on page 32.

• Filter the data that is displayed in a pane. See “To filter the data that is displayed in a tab 
pane” on page 32.

• Show/hide data columns in a tab pane. See “To show/hide columns in a tab pane” on page 
37.

• Manage tab pane configurations. See “To manage tab pane configurations” on page 39.

• Change the widths of a data columns. See “To change the widths of data columns” on 
page 42.

• Rearrange the order of data columns. See “To rearrange the order of data columns” on 
page 42.

• Change the sort order of data. See “To change the sort order of data” on page 42.

• Rename column headers. See “To rename column headers” on page 43.

• Select the data that is to be included in a custom report. See “To select data to be included 
in a custom report” on page 43.

Any preferences that you set for a tab display remain in effect regardless if you log out of and 
then log back into Geneticist Assistant. You can set the preferences for any Variants pane or 
tab, for example, the Sample Variant Data sub-tab on the Sample tab, and then apply these 
same settings to all the other Variants panes and tabs in the application. You can also return 
the tab displays to their default displays (all tab panes shown, all data columns shown, and so 
on) in a single step. See “To apply shared preferences or to clear all tab preferences” on page 
58.
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To navigate multiple open tabs/Navigate tabs with a minimized 
main window

If you open multiple tabs, or if you have reduced the size of the main window, then you 
might not be able to see all the tabs at the top of the main window. The display options at the 
top of the Runs tab or the Patients tab might also be hidden. You can use the Back and Next 
arrows  that are displayed in the top right corner of the main window to move through 
all open tabs and change the display focus, and/or view the hidden display options. 

To close multiple tabs in a single step
If you have opened multiple tabs, then you close each tab individually, or you can close all 
tabs in a single step, or you can close all tabs other than a selected tab in a single step. To 
close all tabs in a single step, right-click the title bar for any of the opened tabs, and on the 
context menu that opens, click Close All. To close all tabs other than a selected tab, 
right-click the title bar of the tab that is to remain open, and on the context menu that opens, 
click Close All Except This.

To show/hide the toolbar for a tab
The Views menu contains an option to show or hide the toolbar for a tab. By default, when a 
tab first opens, the toolbar is displayed for a tab. To hide the toolbar for the tab, clear the 
check that is displayed next to Tool Bar option. To show the toolbar for a tab, select Tool Bar 
again.

To show/hide a tab pane
On the Views menu, you can clear the check that is displayed next to a pane name to hide the 
entire pane from view on a tab. To show the pane, select the pane name again. An option to 
Show All Views is available on the Views menu for some tabs. If any of the panes on a tab 
are hidden, then you can select this option to show all panes again in a single step.

To filter the data that is displayed in a tab pane
By default, when a tab first opens, all data in all available panes is displayed. You can open a 
Filters table to display all the data (fields) for a selected tab on a pane. You specify filters in 
a Filters table to limit the display in a tab pane to only the data (fields) that meet specific 
criteria. You can specify the filters for the data that is displayed in a tab pane on a one time 
only basis, or you can save the filters to a template, and then load the template to filter the 
data that is displayed in the tab pane anytime as needed. 

1. Open the appropriate tab.
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2. On the Geneticist Assistant main menu, click Filters > <Tab Pane>. For example, if you 
clicked Filters pane with the Sample tab open, then the menu options would be Filters > 
Sample’s Variants, Filters > Sample’s Status Changes, and so on. 

The Filters table opens to the right of the tab. The table lists all the fields for the selected 
tab pane. 

3. Repeat Step 2 as many times as needed to open multiple Filters tables for a tab pane.

Figure 1-20:  Filters tables opened for a tab

4. Click and drag the field by which to filter the data from the list of available fields to the 
blank pane that is to the right of the list. 

An Edit Filter dialog box opens. The name of the selected field is displayed in the 
Column Name field on the dialog box.

Figure 1-21:  Edit Filter dialog box

The remainder of this procedure describes how to set up new filters for filtering 
data. Optionally, you can click Load Filters to open the Load Filter Template 
dialog box and select from a list of saved filter templates. You can also delete 
saved filter templates. See “To delete a saved filter template” on page 37.
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5. On the Operator dropdown list, select the operator for the filter.

6. Enter the filter value.

     

The Column Name is a dropdown list that contains all the available fields for the 
opened tab. You can always select a different field on this list before continuing to 
Step 5.

If you are filtering data based on a date/time field, then for additional information, 
see “To filter data based on a date/time field” on page 36.

The operators that are available on the Operator dropdown list are specific to the 
type of field that is selected - text, numeric, and so on. Not all operators are 
available for all field types. 

Filter Operator Description

= Equals. Must be an exact match to return data. 

≠ Does not equal. Only data that does not match the value specified is returned.

> Greater than. Only data that exceeds the value specified is returned.

< Less than. Only data that is less than the value specified is returned.

>= Greater than or equal to. Only data that is an exact match for or exceeds the 
value specified is returned.

<= Less than or equals to. Only data that is an exact match for or is less than the 
value specified is returned.

contains Returns data that not only contains the value specified, but also might contain 
other information. The search string is not case-sensitive.

does not contain Returns only the data that does not contain the value specified. The search 
string is not case-sensitive.

On Only data with a date stamp that is the same as the specified date is returned. 
Identical to the = operator, but used specifically for dates.

Earlier than Only data with a date stamp that falls before the specified date is returned. 
Identical to the < operator, but used specifically for dates.

Earlier than or on Only data with a date stamp that is the same as the specified date or that falls 
before the specified date is returned. Identical to the <= operator, but used 
specifically for dates.

Later than Only data with a date stamp that falls after the specified date is returned. 
Identical to the > operator, but used specifically for dates.

Later than or on Only data with a date stamp that is the same as the specified date or that falls 
after the specified date is returned. Identical to the >= operator, but used 
specifically for dates.
34 Geneticist Assistant User’s Manual



Chapter 1
Getting Started with Geneticist Assistant
7. Click OK.

The Edit Filter dialog box closes. The selected field, its operator, and its value are 
displayed in the panel that is next to the list of available filter fields.

8. Repeat Step 4 through Step 7 for each field by which the data is to be filtered. When you 
filter the data by multiple fields, two options are possible:

• You can drag additional fields for filtering on top of an existing filter field to apply 
the filters on an “and” basis. For example, for the Sample's Variants sub-tab on the 
Sample tab, you can add the filter for Coverage >= 300 and then drag the filter for 
Gene = MSH6 onto the Coverage filter. The results are filtered to show only those 
variants that have a coverage greater than or equal to 300 and that are found in the 
MSH6 gene. 

• You can drag separate additional fields for filtering into the blank pane to apply 
filters on an “or” basis. For example, for the Sample's Variants sub-tab on the 
Sample tab, you can add filters for Coverage >= 300 and a filter for Gene = MSH6. 
The results are filtered to show those variants that have a coverage greater than or 
equal to 300 or variants that are found in the MSH6 gene.

Figure 1-22:  And and Or filters

9. Do any of the following as needed:

• To highlight the results that pass the filtering criteria instead of removing data that 
fails the filtering criteria, select Highlight.

• Click Apply Filters to immediately apply the filters and view the results onscreen. 
(“*Filters Applied” is displayed in the title of the affected tab panes.)

• Click Clear Filters to remove the filters that have been applied for the display for all 
panes on a tab in a single step. The filters remain displayed in the Filter table.

If the results are not as expected, this allows you to make the necessary 
adjustments to the filter before saving it.

And filter

Or filter
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• Right-click any filter in the filter pane, and on the context menu that opens, click 
Edit to open the Edit Filter dialog box. Edit the filter (Column, Operator, and/or 
Value) as needed, and then click OK to close the dialog box and save the edited 
filters. You can then click Apply Filters to immediately apply the edited filters and 
view the updated results onscreen. 

• Right-click the filter in the filter pane, and on the context menu that opens, click 
Remove to delete the filter. You can then click Apply Filters to immediately remove 
the filters from the display and view the updated results onscreen.

• Click Save Filters to open the Save Filter Template dialog box and save your filter 
settings. You can use this saved Filter Settings template to filter the data on this 
specific tab pane for another project based on the settings in the template. 

• Click Delete Filters to remove all filters that have been added for each tab in a single 
step and delete all the filters from the Filter table.

10. After you are done filtering the data, you can click Close (x) in the upper right corner of 
a Filter table to close it.

To filter data based on a date/time field

If you are filtering data based on a date/time field, then an additional option, Relative, is 
displayed on the Edit Filter dialog box. You select this option to display data from a specified 
time period that is relative to the current date and time. For example, to display data that has 
been generated within the last 30 days of the current date and time, select the < operator, 
select Relative and then in the Relative field, enter -30 days. (You must enter the minus sign.)

Figure 1-23:  Edit Filter dialog box for a date/time field

     

You can delete saved filter templates. See “To delete a saved filter template” 
below.
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To delete a saved filter template
You can delete filter templates that have been saved by any user for any tab pane.

1. Open the appropriate tab.

2. On the Geneticist Assistant main menu, click Filters > <Tab Pane>. For example, if you 
clicked Filters pane with the Sample tab open, then the menu options would be Filters > 
Sample’s Variants, Filters > Sample’s Status Changes, and so on. 

The Filters table opens to the right of the tab. The table lists all the fields for the selected 
tab pane. See Figure 1-20 on page 33.

3. Click Load Filters.

The Load Filter Template dialog box opens. The dialog box displays all the filter 
templates that have been saved by all users for the selected tab pane. 

Figure 1-24:  Load Filter Template dialog box

4. Select the filter template that you are deleting, and then click Delete.

The filter is deleted immediately. The Load Filter Template dialog box remains open.

To show/hide columns in a tab pane
You can specify which columns to show in a tab pane and which data columns to hide in the 
Select Columns dialog box. By default, when the dialog box first opens for a tab pane, the 
columns that are currently displayed are selected, and Select/deselect/restore all is either 
selected or completely filled. The Select/deselect/restore all option on the Select Columns 
dialog box is a tri-state checkbox. When the dialog box is opened for the first time for a tab 
pane, all the columns are selected for display, and the Select/deselect/restore option is also 
selected. After you have made your column selections, then each subsequent time that the 
dialog box opens, the columns that have been selected for display are selected, those that 
have been hidden are deselected, and the Select/deselect/restore option is completely filled. 
If you click this option once, then all columns are added for the view in the tab pane in a 
single step and the select/deselect/restore option is selected. If you click the Select/deselect/
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restore option a second time, then all data columns are hidden from view in the pane in a 
single step, and the option is cleared. If you click the Select/deselect/restore option a third 
time, then the last specified settings (that is, which columns were shown and which columns 
were hidden) are restored, and a completely filled checkbox is displayed for the Select/
deselect/restore option.

1. Right-click the tab pane anywhere, and on the context menu that opens, click Load 
Columns.

A sub-menu opens that displays up to three options: Manually, Compact, and all the 
available configurations for the pane. The name of the user who created each 
configuration displayed next to the configuration.

2. Click Manually.

The Select Columns dialog box opens. 

Figure 1-25:  Select Columns dialog box

3. Clear the options for the columns that are to be hidden from view in the pane, and leave 
the options for the columns that are to be shown selected.

4. Optionally, to rearrange the column display, click the column number for a column, and 
then drag it to a new location in the list of columns.

5. Click Apply to update the column display.

Compact displays the data columns in the pane in a more condensed view. To 
toggle the display, click Compact as needed.

This is identical to rearranging the data columns directly in a tab pane. See “To 
rearrange the order of data columns” on page 42.
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6. Click OK to close the dialog box.

The column preferences remain in effect even if you log out of and then log back into 
Geneticist Assistant. To restore the last specified settings, or display all columns in a 
single step, click the Select/deselect/restore all option as needed.

To manage tab pane configurations
Instead of selecting individual columns to show or hide, you can use pane configurations to 
manage your data column displays. You can load an existing pane configuration, you can 
create your own pane configurations, and you can delete pane configurations. See:

• “To load a pane configuration” below.

• “To create/modify a pane configuration” below.

• “To delete a pane configuration” on page 41.

To load a pane configuration

1. Right-click the tab pane anywhere, including the column headers, and on the context 
menu that opens, click Load Columns. 

A sub-menu opens that displays up to three options: Manually, Compact, and all the 
available configurations for the pane. The name of the user who created each 
configuration displayed next to the configuration.

2. Select the configuration that you are loading.

The context menu closes. The pane display is updated dynamically after the 
configuration is loaded.

To create/modify a pane configuration

When you create and save a configuration for a tab pane, the configuration is available and 
applicable only for this specific tab pane. You can modify only the configurations that you 
have created.

1. Right-click the tab pane anywhere, including the column headers, and on the context 
menu that opens, click Load Columns. 

A sub-menu opens that displays up to three options: Manually, Compact, and all the 
available configurations for the pane. The name of the user who created each 
configuration displayed next to the configuration.

Compact displays the data columns in the pane in a more condensed view. To 
toggle the display, click Compact as needed.

Compact displays the data columns in the pane in a more condensed view. To 
toggle the display, click Compact as needed.
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2. Do one of the following:

3. Clear the options for the columns that are to be hidden from view in the pane, and select 
the options for the columns that are to be displayed. 

4. Click Apply to update the column display.

     

Option Description

To create an entirely new 
pane configuration

1. Click Manually.

The Select Columns dialog box opens. By default, when the 
dialog box first opens for a tab pane, the columns that are 
currently displayed are selected, and Select/deselect/restore is 
either selected or completely filled. See Figure 1-25 on page 38.

2. Continue to Step 3.

To create a new pane 
configuration by modifying an 
existing configuration

1. Click Manually.

The Select Columns dialog box opens. See Figure 1-25 on 
page 38.

2. Click Load Configuration.

The Load Configuration dialog box opens. The dialog box 
displays all your private and public configurations as well as all 
the configurations that other users have made public.

Figure 1-26:  Load Configuration dialog box

3. Select the configuration that is to be modified.

The pane display is dynamically updated according to the 
loaded configuration

4. Right-click the tab pane anywhere, and on the context menu 
that opens, click Load Columns > Manually.

The Select Columns dialog box opens again. The settings on 
the dialog box reflect the loaded configuration. 

5. Continue to Step 3.
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5. Click Save Configuration. 

The Save Configuration dialog box opens.

Figure 1-27:  Save Configuration dialog box

6. Enter a name for the configuration.

7. If this configuration is to be available to all other users of this Geneticist Assistant 
instance (a public configuration), then select Make configuration available to all users; 
otherwise, to make the configuration available only to you (a private configuration), 
leave this option blank.

8. Click Save.

The Save Configuration dialog box closes. The Select Columns dialog box remains 
open.

9. Click OK to close the Select Columns dialog box.

To delete a pane configuration

You can delete only those pane configurations that you have created.

1. Right-click the tab pane anywhere, including the column headers, and on the context 
menu that opens, click Load Columns. 

A sub-menu opens that displays up to three options: Manually, Compact, and all the 
available configurations for the pane. The name of the user who created each 
configuration displayed next to the configuration.

2. Click Manually.

The Select Columns dialog box opens.See Figure 1-25 on page 38.

3. Click Load Configuration.

The Load Configuration dialog box. The dialog box displays all your private and public 
configurations as well as all the configurations that other users have made public. See 
Figure 1-28 on page 42.

If you are modifying a configuration, then you must save it with exactly the same 
name as the original configuration. 
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Figure 1-28:  Load Configuration dialog box

4. Right-click the configuration that you are deleting, and on the context menu that opens, 
click Delete Column Configuration.

The Column Configuration is deleted.

5. Click Close (x) to close the Load Configuration dialog box.

6. Click OK to close the Select Columns dialog box.

To change the widths of data columns
To change the width of a data column, rest the mouse pointer on the right side of a column 
heading until the pointer changes to a double-headed arrow, and then drag the boundary until 
the column is the width that you want.

To rearrange the order of data columns
You can rearrange the order of the data columns in a tab pane by clicking and holding the 
mouse pointer on a column header, and then dragging the column to a new location.

To change the sort order of data
When a tab first opens, data is sorted in ascending order based on the IDs of the data. To 
change the sort order of the data in a column, click a column header to sort the display based 
on the descending order of data in the column. A Sort Order icon is displayed in the column 
header. You can click this Sort Order icon to toggle between an ascending sort and a 
descending sort of the data based on the column heading.

If you select a configuration that you did not create, then the Delete Column 
Configuration option is not available on the context menu.

You can also rearrange the order of data columns in a tab pane using the function 
that is available in the Select Columns dialog box. See “To show/hide columns in a 
tab pane” on page 37.
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To rename column headers
Every data column is titled with a default column header. To rename a column header to 
better suit your working needs, right-click the column header, and on the context menu that 
opens, click Rename Header. The column header is selected, and you can then modify the 
column header as needed.

To select data to be included in a custom report
You can include just specific data in a custom report, or you can include all data in a pane in 
a custom report.

• To include just specific data, right-click the data (CTRL-click to select multiple rows of 
data), and on the context menu that opens, select Add Selected to Custom Report. All data 
in all columns that are currently shown in the selected rows is included in the custom 
report. Data in hidden columns is not included in the report.

• To include all data that is currently shown in a tab pane in a custom report, right-click 
anywhere in the pane and on the context menu that opens, click Add All to Custom 
Report. All data in all columns that are currently shown in the tab pane is included in the 
custom report. Data in hidden columns is not included in the report.

For detailed information about generating a custom report after you have selected 
the necessary data, see “Generating a Custom Report” on page 273.
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Searching the Geneticist Assistant Database
You use the Search feature that is available on the Geneticist Assistant main window toolbar 
to search for samples, runs, panels, panel groups, sample groups, genes, and variants in your 
Geneticist Assistant database. 

Figure 1-29:  Geneticist Assistant main window toolbar

Important points to note about a search are the following:

• As you enter a search string, the list of search results that match the string is dynamically 
updated, and the type of search result that matches the string is indicated in bold above 
the list (Run, Variant, and so on). 

• The search for any item is not case-sensitive, and the search string can be found anywhere 
in the search results. For example, if you enter “Mayo” as the search string, then the 
search results can include a run named “Mayo Clinic” or a run named “Clinic Run:Mayo.”

• If you search for a variant, the search is not carried out relative to any sample, and 
multiple search options are available. 

• You can use the variant description in the format of chrom:start position:ref:alt. You 
must separate multiple variant search strings with a comma (,) or a semi-colon (;). 

• You can search for a single position on a single chromosome (for example, 1:123) or 
for a range of positions on a single chromosome (for example, 1:1-1000).

• You can search by the partial or complete gene name; for example, MSH or MSH2, 
respectively. 

Search results for any entity in your Geneticist Assistant database are displayed on a Search 
Results tab. 

Figure 1-30:  Search feature and results example
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You can double-click any search result on a Search Results tab to “drill down” into the 
search result, and review the associated data. For example, you can:

• Double-click a Run search result to open the associated Run tab.

• Double-click a Gene search result to open the list of variants for the gene, and then 
double-click a variant in this list to open the associated Variant tab. 

You can also right-click any search result to open a context menu that has options that are 
specific for the search result.
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Maintenance

Before you use Geneticist Assistant for the first time, you must add and/or modify the 
necessary objects and specify the settings for your installation. For data protection, you can 
manually back up the Geneticist Assistant database at any time of your choosing.

This chapter covers the following topics:

• “Managing Objects” on page 49.

• “Specifying your Geneticist Assistant Settings” on page 53.

• “Backing up the Geneticist Assistant Database” on page 68.
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Managing Objects
An object in Geneticist Assistant holds a value or variable that can be applied for carrying 
out a run in Geneticist Assistant, or for processing and interpreting the resulting run data. 
Managing objects in Geneticist Assistant consists of adding and editing the values for these 
objects as well as deleting values that are no longer valid or required. Eleven objects are 
available in Geneticist Assistant—Chemistry, Instrument, Pathogenicity, Pathogenicity 
Status, Sample Status, Panel Group, Coverage Region Status, Sample Status, Run Status, 
Artifact Type, and Phenotype. Geneticist Assistant is installed with default values for 
Pathogenicity, Pathogenicity Status, Sample Status, Coverage Region Status, Run Status, and 
Artifact Type. You have the option of adding custom values for these objects, and then 
selecting a custom value in lieu of a default value. You must manually add values for all 
other objects.

     

Object Description

Chemistry Refers to the chemistry that was used to prepare the samples for 
sequencing. 

Instrument Refers to the instrument that was used to sequence the samples.

Pathogenicity The pathogenicity for a selected variant. Default values are Deleterious, 
Likely Deleterious, Unknown, Likely Benign, and Benign.

Pathogenicity Status Indicates the status for changing the pathogenicity for a selected 
variant. Default values are Pending and Confirmed.

Sample Status The status for a sample. Default values are New, QC Passed, 
Reviewed, and Complete.

Panel Group Separately tracks the pathogenicities of variants that might be found in 
multiple panels. For example, the pathogenicity of a selected variant is 
set to Deleterious for multiple cancer panels; however, the pathogenicity 
can be set to Benign for a cardiac panel. You can create a group for 
each panel, and then assign the appropriate panels to each group.

Coverage Region 
Status

The Coverage Regions tab (via the Run tab) lists the coverage 
information for every region in your panel as well as a status for each 
region. Default values are Passed or Failed to indicate whether a region 
passed or failed the coverage settings that were set for the run. 

Note: See “Coverage Regions tab” on page 192.

Sample Group Used for a group of samples that are to be processed repeatedly over a 
period of time, for example, a group of control samples for which the 
coverage or variant frequency is to be tracked. 

Run Status The status for a run. Default values are New, QC Passed, Reviewed, 
and Complete.

Artifact Type The artifact type for the sample variant, for example, a Sequencing 
artifact. A single default value, None, is supplied for artifact type. 

Phenotype The phenotype for a patient.
Geneticist Assistant User’s Manual 49



Chapter 2
Geneticist Assistant Setup and Maintenance
To add a value for an object
1. On the Geneticist Assistant main menu, click File > Add/Edit Objects.

The Add/Edit Objects dialog box opens. 

Figure 2-1:  Add/Edit Objects dialog box

2. On the Object dropdown list, select the object for which you are adding a value.

If values have already been added for the selected object, or the selected object has 
default values, then these values are displayed in the Current Values pane.

3. In the Value field, enter the value for the object, and then click Add.

The newly added value is displayed in the Current Values pane.

4. If you added a new pathogenicity value, then to reorder the lists of displayed values, 
select a value in the Current Values pane, and then click Move Up or Move Down as 
needed. 

The value can have a maximum of 255 characters. Spaces and special characters 
are allowed.

This is a required step to correctly order the pathogenicity values from least severe 
to most severe.

If you add a value for pathogenicity, you can also specify a highlighting color for 
variants of this type in all the variant panes and sub-tabs. See “To specify the 
highlighting colors for variants of a pathogenicity” on page 56.
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5. Click OK.

The message “Saving new objects” is displayed on the Add/Edit Objects dialog box. The 
dialog box closes after the value is added successfully.

To edit an object
When you edit an object, you edit the object value. Any previous runs that use the edited 
object value are not affected. The “old” (previous) value remains displayed in Geneticist 
Assistant on the Runs tab. Going forward, only the “new” value is available for selection for 
new runs. 

1. On the Geneticist Assistant main menu, click File > Add/Edit Objects.

The Add/Edit Objects dialog box opens. See Figure 2-1 on page 50.

2. On the Object dropdown list, select the object for which you are editing a value.

The currently available values for the selected object are displayed in the Current Values 
pane.

3. In the Current Values pane, double-click the object value that you are editing.

The value is highlighted in a blue rectangle.

4. Edit the value as needed.

5. Click OK.

The message “Saving new objects” is displayed on the Add/Edit Objects dialog box. The 
dialog box closes after the value is edited successfully.

To delete a value from an object

1. On the Geneticist Assistant main menu, click File > Add/Edit Objects.

The Add/Edit Objects dialog box opens. See Figure 2-1 on page 50.

2. On the Object dropdown list, select the object from which you are deleting values.

The currently available values for the selected object are displayed in the Current Values 
pane.

     

The value can have a maximum of 255 characters. Spaces and special characters 
are allowed.

If you delete a value for an object that has been previously used in a run, then the 
run is also deleted in its entirety from the Geneticist Assistant database. Be very 
sure that you want to delete a value from an object before doing so.
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3. In the Current Objects pane, click the object value that you are deleting, and then click 
Remove Selected.

The value is deleted immediately. The Add/Edit Objects dialog box remains open.

4. Click OK.

The Add/Edit Objects dialog box closes.
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Specifying your Geneticist Assistant Settings
Before you run Geneticist Assistant for the first time, you must create your reference 
directory. The reference directory contains the information for the reference that was used 
for aligning the data and/or detecting variants. References files are stored in their own 
folders in this directory. For example, if you are studying variants that are associated with the 
human genome, then you might create a Human folder in the Reference directory, such as 
C:\References\Human 37. When specifying the settings for your Geneticist Assistant 
installation, at a minimum, you must:

• Create your reference directory and specify its location. See “To configure the reference 
directory” on page 54.

• Specify the global Quality Control (coverage) settings for your data. See “To specify the 
global Quality Control settings” on page 55.

Optionally, you can also:

• Specify the colors for highlighting variants of a specific pathogenicity in all the variant 
panes and variant sub-tabs. See “To specify the highlighting colors for variants of a 
pathogenicity” on page 56.

• Specify the same column display preferences for variants in all the variant panes and 
variant sub-tabs (with the exception of the Sample Group columns on the Sample Variant 
Data sub-tab for the Sample tab and the Variant pane on the Variant tab), and/or clear the 
preferred settings for all the data tabs. See “To apply shared preferences or to clear all tab 
preferences” on page 58.

• Specify the preferred settings for variants, which determines how the information is 
displayed for variants in all the variant panes and variant sub-tabs, and/or clear the 
preferred settings for all the data tabs. See “To specify variant preferences” on page 60.

• Specify your Alamut settings. See “To specify Alamut settings” on page 61.

• Specify your HGMD settings. See “To specify HGMD settings” on page 62.

• Specify the requirements for all user passwords for Geneticist Assistant. See “To specify 
the Geneticist Assistant password requirements” on page 63.

• Specify your OMIM settings. See “To specify the OMIM settings” on page 65.

• Configure your proxy server settings. See “To configure proxy server settings” on page 
66.

• Modify the SoftGenetics license server settings. See “To modify the SoftGenetics license 
server settings” on page 66.
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To configure the reference directory
You carry out the following procedure if you did not configure the reference directory the 
first time that you logged into Geneticist Assistant, or if you want to change its location.

1. Create your reference directory in a location that meets your business needs.

2. On the Geneticist Assistant main menu, click File > Settings.

The Settings dialog box opens. By default, the Directories tab is the open tab. 

Figure 2-2:  Settings dialog box, Directories tab

3. Click the Browse button  next to the Reference Directory field, and then browse to 

and select the Reference directory.

4. If you are done specifying your settings, then click OK to close the Settings dialog box 
and return to the Geneticist Assistant main window; otherwise, continue to add and/or 
modify the information on any of the other tabs as needed. 

     

If you have previously specified the location for the reference directory and 
submitted data to the Geneticist Assistant database, you cannot change its 
location.

Although not required, SoftGenetics recommends that you create the reference 
directory on the same computer and drive on which you installed the Geneticist 
Assistant client.
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To specify the global Quality Control settings
The settings on the Quality Control tab are the minimum required coverage values (coverage 
threshold values) that a panel region must meet, or it is flagged as failed region for a run. The 
coverage values that you specify here are global settings, which means that, by default, they 
are automatically applied to all panel regions in all runs.

1. If you have not already done so, on the Geneticist Assistant main menu, click File > 
Settings to open the Settings dialog box.

2. Open the Quality Control tab.

Figure 2-3:  Settings dialog box, Quality Control tab

3. Specify the value for the Quality Control settings.

• Minimum Coverage—The minimum number of reads that are required for a panel 
region.

• Average Coverage—The average number of reads that are required for a panel 
region.

• Percent Covered (%)—The minimum percentage of the panel region that has reads 
aligned to it.

4. If you are done specifying your settings, then click OK to close the Settings dialog box 
and return to the Geneticist Assistant main window; otherwise, continue to add and/or 
modify the information on any of the other tabs as needed. 
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To specify the highlighting colors for variants of a pathogenicity
By default, variants for any of the five system-supplied pathogenicity values—Deleterious, 
Likely Deleterious, Unknown, Likely Benign, and Benign—are highlighted in a specific 
color on the variant sub-tabs and panes. You can use these default colors, or you can specify 
other colors on the Pathogenicity Colors tab that better meet your business needs.

1. If you have not already done so, on the Geneticist Assistant main menu, click File > 
Settings to open the Settings dialog box.

2. Open the Pathogenicity Colors tab. 

The default highlighting colors for the five system-supplied pathogenicity values are 
displayed on the tab. 

Figure 2-4:  Settings dialog box, Default colors shown on the Pathogenicity Colors tab

3. Select a pathogenicity.

The Select Highlight Color dialog box opens. The pathogenicity that you selected is 
displayed in the title bar of the dialog box. See Figure 2-5 on page 57.

If you have added a custom pathogenicity value (see “Managing Objects” on page 
49), then this value is also displayed, and if applicable, in its selected highlighting 
color.
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Figure 2-5:  Select Highlight Color dialog box

4. Continue to one of the following:

• “To specify a basic highlighting color for a pathogenicity” on page 57.

• “To specify a custom highlighting color for a pathogenicity” on page 58.

To specify a basic highlighting color for a pathogenicity

1. Click a basic color.

2. Click OK.

The Select Highlight Color dialog box closes. The Pathogenicity Colors tab on the 
Settings dialog box remains open. The selected pathogenicity is highlighted in the basic 
color.

3. Continue selecting pathogenicities and specifying basic colors as needed.

4. If you are done specifying your settings, then click OK to close the Settings dialog box 
and return to the Geneticist Assistant main window; otherwise, continue to add and/or 
modify the information on any of the other tabs as needed. 

     

Multiple ways are available for selecting a highlighting color for a pathogenicity. 
The following are for example purposes only. You can select whichever method or 
combination of methods best suits your working needs.

Color Spectrum

Gradient Bar
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To specify a custom highlighting color for a pathogenicity

1. Click in a blank custom color box.

2. Click the color in the Color Spectrum to select an approximate color.

A set of crosshairs is displayed where you clicked and the corresponding color is 
displayed below the spectrum. The HSV and RGB values are also displayed for the 
color. 

3. Do one of the following:

• Manually set the HSV or RGB values for the color.

• Drag and drop the crosshairs to a new location in the Color Spectrum.

• Point and hold your cursor on the Gradient arrow to the right of the Color Spectrum 
and move the arrow up and down until the appropriate color is displayed.

4. Click Add to Custom Colors.

5. Click OK.

The Select Highlight Color dialog box closes. The Pathogenicity Colors tab on the 
Settings dialog box remains open. The selected pathogenicity is highlighted in the 
custom color.

6. Continue selecting pathogenicities and specifying custom colors as needed.

7. If you are done specifying your settings, then click OK to close the Settings dialog box 
and return to the Geneticist Assistant main window; otherwise, continue to add and/or 
modify the information on any of the other tabs as needed. 

To apply shared preferences or to clear all tab preferences
Remember, a variety of options are available for settings preferences for a tab display, 
including showing and hiding tab panes, resizing data columns, and so on. (See “Setting 
Display Preferences in the Geneticist Assistant Main Window” on page 31.) Any preferences 
that you set for a tab display remain in effect regardless if you log out of and then log back 
into Geneticist Assistant. You can use an option on the Tab Preferences tab to apply the same 
column display preferences for variants in all the variant sub-tabs and panes (with the 
exception of the Sample Group columns on the Sample Variant Data sub-tab on the Sample 
tab and the Variant pane on the Variant tab) in a single step. You can also use an option on 
the Tab Preferences tab to clear all the preferred settings for all the data tabs in a single step.

1. If you have not already done so, on the Geneticist Assistant main menu, click File > 
Settings to open the Settings dialog box.

2. Open the Tab Preferences tab. See Figure 2-6 on page 59.
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Figure 2-6:  Settings dialog box, Tab Preferences tab

3. Do one of the following:

• After you set the column display preferences, select Apply Shared Preferences to 
Variant Panel Views. 

The same preferences are applied to the appropriate sub-tab or pane on the other tab.

• To return the tab displays to their default displays (all tab panes shown, all data 
columns shown, and so on) in a single step, click Clear All Preferences.

Any customizations that you have made to any and all tabs (hiding tab panes, hiding 
data columns on tabs, resizing data columns, and so on) are cleared and all tab 
displays are reset to their default values.

4. If you are done specifying your settings, then click OK to close the Settings dialog box 
and return to the Geneticist Assistant main window; otherwise, continue to add and/or 
modify the information on any of the other tabs as needed. 
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To specify variant preferences
Variant preferences determine how the information about variants is displayed on all the 
variant tabs, sub-tabs, and panes in Geneticist Assistant.

1. If you have not already done so, on the Geneticist Assistant main menu, click File > 
Settings to open the Settings dialog box.

2. Open the Variant Preferences tab. 

Figure 2-7:  Settings dialog box, Variant Preferences tab

3. Set the variant preferences.

Option Description

Zygosity

Heterozygosity Upper Bound (%) Default value is 80. The maximum variant frequency for a 
variant to be considered heterozygous.

Heterozygosity Lower Bound (%) Default value is 20. The minimum variant frequency for a 
variant to be considered heterozygous.

Note: To report low frequency variants, reduce this value.

Variant Annotation

• Use GFF3 file • The default value. Use the annotation information in the 
reference files that SoftGenetics provides.

• Use GTF file • Use the annotation information in the reference files that 
ENSEMBL provides.

Note: If you select this option, then you must download the 
correct references files from ENSEMBL and place them 
in the Reference directory that is defined for your 
Geneticist Assistant installation. See “To configure the 
reference directory” on page 54.
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4. If you are done specifying your settings, then click OK to close the Settings dialog box 
and return to the Geneticist Assistant main window; otherwise, continue to add and/or 
modify the information on any of the other tabs as needed. 

To specify Alamut settings
To view variants that were imported into Geneticist Assistant in Alamut:

• HTTP-based access must be enabled in Alamut. To enable this in Alamut, select Tools > 
Options > Api, select Enable HTTP-based access, and then set the port to 10000.

• Geneticist Assistant must be able to connect to Alamut and Alamut must be installed on 
the same computer as the Geneticist Assistant client. 

• Alamut must be open to jump to the variant position from Geneticist Assistant. 

You specify the Alamut connection settings for Geneticist Assistant on the Alamut Settings 
tab.

1. If you have not already done so, on the Geneticist Assistant main menu, click File > 
Settings to open the Settings dialog box.

     

Variant Submission

Submit Hotspots Deselected by default. Any variants that are included in a VCF 
file that have an allele frequency value = 0 in the file are 
submitted to the Geneticist Assistant database.

HGVS Nomenclature - Determines which transcript is used for the HGVS nomenclature columns if a 
gene has multiple transcripts.

• Preferred Selected by default. Show only a single transcript, either the 
transcript that is selected by default as the preferred transcript 
or the transcript that is defined as the preferred transcript in a 
preferred transcript list. See “To set or delete a preferred 
transcript list for a panel” on page 90.

• Unique Translation Show multiple transcripts if the translation varies among the 
transcripts.

• Unique Exon region Show multiple transcripts if the exon regions vary among the 
transcripts. 

• All Shows the HGVS nomenclature based on all the transcripts 
that are included for the gene.

HIde predicted if known 
transcripts exist

Selected by default. If known transcripts exist for the gene, 
then do not include any predicted transcripts in the HGVS 
columns. 

Option Description
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2. Open the Alamut Settings tab. 

Figure 2-8:  Settings dialog box, Alamut Settings tab

3. Click the Browse button  to open the Select Executable dialog box, and then browse 

to and select the Alamut executable.

4. Enter the information for the Alamut server. (The default value is http://localhost).

5. Leave the Port value set to 10000.

6. If you are done specifying your settings, then click OK to close the Settings dialog box 
and return to the Geneticist Assistant main window; otherwise, continue to add and/or 
modify the information on any of the other tabs as needed. 

To specify HGMD settings
To view variants that were detected in Geneticist Assistant in HGMD, Geneticist Assistant 
must be able to connect to HGMD and log you in automatically. You specify your HGMD 
login settings on the HGMD Settings tab.

1. If you have not already done so, on the Geneticist Assistant main menu, click File > 
Settings to open the Settings dialog box.

     

Remember, Alamut must be installed on the same computer as the Geneticist 
Assistant client.

For more information about this value, or to change the value, contact 
SoftGenetics (tech_support@softgenetics.com).
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2. Open the HGMD Settings tab. 

Figure 2-9:  Settings dialog box, HGMD Settings tab

3. Enter your HGMD username and password.

4. Optionally, to show only the HGMD ID when the HGMD entry matches not only for the 
chromosome position, but also for the reference and alternate alleles, select Match 
Allele.

5. If you are done specifying your settings, then click OK to close the Settings dialog box 
and return to the Geneticist Assistant main window; otherwise, continue to add and/or 
modify the information on any of the other tabs as needed. 

To specify the Geneticist Assistant password requirements
When Geneticist Assistant is first installed, by default, the Username is set to Administrator, 
and you must specify an administrator password. By default, the only requirement is that the 
password cannot contain any spaces. You can, however, specify additional requirements that 
are applicable for all user passwords, including the Administrator password. You can specify 
the following requirements for your user passwords:

• Minimum length.

• Minimum number of upper case characters.

• Minimum number of lower case characters.

• Minimum number of numeric characters.

• Minimum number of special characters.

1. If you have not already done so, on the Geneticist Assistant main menu, click File > 
Settings to open the Settings dialog box.
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2. Open the Password Settings tab. 

A default value is provided for each password setting.

Figure 2-10:  Settings dialog box, Password Settings tab

3. Specify the requirements for all user passwords for your Geneticist Assistant installation.

4. If you are done specifying your settings, then click OK to close the Settings dialog box 
and return to the Geneticist Assistant main window; otherwise, continue to add and/or 
modify the information on any of the other tabs as needed. 

     

You can click Reset Defaults at any time to reset all password settings to their 
default values in a single step.
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To specify the OMIM settings
To view variants in Geneticist Assistant in OMIM, Geneticist Assistant must be able to 
connect to OMIM and use an OMIM API key to log you in automatically. You request an 
OMIM API key and specify the OMIM settings for your Geneticist Assistant installation on 
the OMIM tab of the Settings dialog box.

1. If you have not already done so, on the Geneticist Assistant main menu, click File > 
Settings to open the Settings dialog box.

2. Open the OMIM tab. 

Figure 2-11:  Settings dialog box, OMIM tab

3. Click Request an OMIM API key.

You are directed to the API Access to OMIM webpage.

4. Complete the necessary information to obtain an OMIM API Access key.

5. Upon receipt of the key, enter the value in the API field.

6. Indicate the connectivity for the API Host (Europe or United States).

7. If you are done specifying your settings, then click OK to close the Settings dialog box 
and return to the Geneticist Assistant main window; otherwise, continue to add and/or 
modify the information on any of the other tabs as needed. 
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To configure proxy server settings
If your organization uses a proxy server for external connections, then to view data from 
external databases such as OMIM or LOVD in Geneticist Assistant, you must configure the 
settings for the proxy server.

1. If you have not already done so, on the Geneticist Assistant main menu, click File > 
Settings to open the Settings dialog box.

2. Open the Proxy Settings tab.

Figure 2-12:  Settings dialog box, Proxy Settings tab

3. Configure your proxy server settings. If you select DefaultProxy for Type, then the 
proxy settings for Internet Explorer are used for the connection and you can leave all 
other proxy settings blank.

4. If you are done specifying your settings, then click OK to close the Settings dialog box 
and return to the Geneticist Assistant main window; otherwise, continue to add and/or 
modify the information on any of the other tabs as needed. 

To modify the SoftGenetics license server settings
If you are running a purchased version of Geneticist Assistant, the first time that you run the 
program, you must configure Geneticist Assistant to connect to the SoftGenetics license 
server. (See “To run a purchased version of Geneticist Assistant” on page 24.) If you change 
the location of this license server, then you must modify the license server settings so that 
Geneticist Assistant can still connect to the server.

1. If you have not already done so, on the Geneticist Assistant main menu, click File > 
Settings to open the Settings dialog box.
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2. Open the License Settings tab. 

The current information (name or IP address) for the SoftGenetics license server is 
displayed in the Server field. 

Figure 2-13:  Settings dialog box, License Settings tab

3. In the server name, enter the fully qualified domain name (FQDN) for the server, or its 
IP address.

4. Leave the Port value set to the default value of 50000.

5. If you are done specifying your settings, then click OK to close the Settings dialog box 
and return to the Geneticist Assistant main window; otherwise, continue to add and/or 
modify the information on any of the other tabs as needed. 

If the License Server is running on the same computer on which Geneticist 
Assistant is running, then you must enter 127.0.0.1. 
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Backing up the Geneticist Assistant Database
For data protection, you can manually back up the Geneticist Assistant database at any time 
of your choosing.

To back up the Geneticist Assistant database
1. On the Geneticist Assistant main menu, click Backup > Run Backup.

The Backup dialog box opens.

Figure 2-14:  Backup dialog box

2. Click the Browse button  next to the MySQLDump path field to open the Select 

mysqldump.exe dialog box, and then browse to and select the mysqldump.exe file.

3. Enter your Geneticist Assistant Username and password.

4. Click the Browse button  next to the Backup File field to open the Select backup file 

dialog box, and specify a name and location for the database backup file.

5. Click OK.

After the Geneticist Assistant database is successfully backed up, a message opens 
indicating that the backup is finished.

6. Click OK to close the message. 

The Geneticist Assistant main window remains open.

If you installed MySQL in is default directory, then the mysqldump.exe file is found 
in C:\Program Files (x86)\MySQL\MySQL Server 5.1\bin.

The default location is C:\Program Files\Softgenetics\Geneticist Assistant\ga_exe, 
but you can select a different location. The file type is Sql files (*.sql) and you 
cannot change this.
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In addition to specifying some of the basic settings for your Geneticist Assistant application, 
such as the Reference directories, or the global Quality Control settings, you must configure 
the users, and optionally, the groups, who are to have access to the application.

This chapter covers the following topics:

• “Managing Users” on page 71.

• “Managing Groups” on page 77.
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Managing Users
Users are the people who log into Geneticist Assistant, whether they are adding and 
reviewing content, or just using the application in a read-only capacity. Remember, when 
Geneticist Assistant is first installed, it is installed with a default Administrator user. As the 
Geneticist Assistant administrator, you must manage all the necessary users for your 
Geneticist Assistant application, which includes adding new users, deleting users, and 
modifying user permissions. 

To add a new user
A user in Geneticist Assistant is one of three types:

• Administrator user - All available permission types (User, Chemistry, Instrument, and so 
on) are automatically assigned to an Administrator user. An Administrator user can view 
all the runs that have been submitted to the Geneticist Assistant database by any user and 
all the patients that have been added to the Geneticist Assistant database by any user.

• Staff user - A Staff user can log into the django web administrator site. The actions that a 
staff user can carry out on this site are determined by the permission types that are 
assigned to the user. 

• Standard user - For a “standard” user, you do not select either the Administrator Privileges 
option or the Staff option. Standard users can view all the runs that they have submitted 
to the Geneticist Assistant database as well as any runs that have been submitted by other 
users and for which they have been granted at least the Can Read permission. Standard 
users can also view all the patients that they have added to the Geneticist Assistantant 
database as well as any patients that have been added by others users and for which they 
have been granted at least the Can Read permission.

.

1. On the Geneticist Assistant main menu, click File > User Management.

The User Management dialog box opens. By default, the User tab is the open tab. The 
tab displays all the users who are currently configured for your Geneticist Assistant 
application, their status, and if applicable, their permissions level (Staff or 
Administrator). See Figure 3-1 on page 72.

Instead of assigning permissions to each user on an individual basis, optionally, 
you can assign users to a group and apply the same permissions to all the users in 
the group in a single step. See “Managing Groups” on page 77.

For a detailed description of the permission types that you can assign to a user, 
contact SoftGenetics.
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Figure 3-1:  User Management dialog box, User tab

2. Click Add New User.

The Add New User dialog box opens.

Figure 3-2:  Add New User dialog box
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3. Add the information for the new user.

4. In the Permissions pane, add or delete the permissions for the user as needed. You can 
add or delete permissions individually, or you can add or delete all permissions of a 
specific type in a single step.

• To add all permissions of a specific type (for example, View), select the check box 
next to the type.

• To clear all permissions of a specific type, clear the check box for the type.

5. Click OK.

The User Management dialog box closes. You return to the Geneticist Assistant main 
window.

     

Field Description

Username Required. The login name for the user. Uppercase and lowercase are 
allowed. No special characters are allowed.

Password Required. The login password for the user. The password cannot contain 
any spaces. If additional password requirements have been set, then the 
password must also adhere to these requirements. See “To specify the 
Geneticist Assistant password requirements” on page 63.

Confirm Password Required. Re-enter the password exactly as you entered it in the Password 
field.

First Name (optional) The first name for the user. Displayed only here in the application.

Last Name (optional) The last name for the user. Displayed only here in the application.

Email Required. The email address for the user.

• Administrator 
Privileges

• Staff 

You can assign both Administrator Privileges and Staff status to the same 
user. Do not assign either option for a standard user.

Active Selected by default and you cannot change this. The user is added as an 
Active user. The user can log into Geneticist Assistant and carry out all the 
activities available to him/her based on the assigned permissions. You can 
inactivate a user when you edit a user. See “To edit a user” on page 75.

Be aware of the dependencies for these permissions. For example, if a user is to be 
able to add chemistries, then the user must also be able to view chemistries.
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To delete a user
1. On the Geneticist Assistant main menu, click File > User Management.

The User Management dialog box opens. By default, the User tab is the open tab. The 
tab displays all the users who are currently configured for your Geneticist Assistant 
application, their status, and if applicable, their permissions level (Staff or 
Administrator).

Figure 3-3:  User Management dialog box, User tab

2. Right-click the user that you are deleting, and on the context menu that opens, click 
Remove User.

The user is deleted.

3. Click OK.

The User Management dialog box closes. You return to the Geneticist Assistant main 
window.

     

No confirmation message opens asking you if you are sure that you want to delete 
a selected user. Instead, the user is deleted immediately, so be very sure that you 
want to delete a user before doing so.
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To edit a user
When you edit a user, you can modify the user password, the user first and last names, the 
user email address, the user status, the user level (Administrator and/or Staff) and the user 
permissions. You cannot edit a user name. To modify a user name, you must delete the 
existing user (see “To delete a user” on page 74), and then add the user with a new user 
name.

1. On the Geneticist Assistant main menu, click File > User Management.

The User Management dialog box opens. By default, the User tab is the open tab. The 
tab displays all the users who are currently configured for your Geneticist Assistant 
application, their status, and if applicable, their permissions level (Staff or 
Administrator).

Figure 3-4:  User Management dialog box, User tab

2. Do one of the following:

• Double-click the user that you are deleting.

• Right-click the user that you are editing, and on the context menu that opens, click 
Edit User.

The Edit User dialog box opens. The dialog displays all the current information for the 
user, including the currently assigned permissions. See Figure 3-5 on page 76.
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Figure 3-5:  Edit User dialog box

3. Edit any or all of the following information as needed—the user password, the user first 
and last names, the user email address, the user status (Active), or the user level (Staff or 
Administrator).

4. In the Permissions pane, add or delete the permissions for the user as needed. You can 
add or delete permissions individually, or you can add or delete all permissions of a 
specific type in a single step.

• To add all permissions of a specific type (for example, View), select the check box 
next to the type.

• To clear all permissions of a specific type, clear the check box for the type.

5. Click OK.

The Edit Permissions dialog box closes. You return to the User tab of the User 
Management dialog box.

6. Click OK.

The User Management dialog box closes. You return to the Geneticist Assistant main 
window.

If you modify the user level, do not forget to manually edit the permissions as 
needed. See Step 4 below.

Be aware of the dependencies for these permissions. For example, if a user is to be 
able to add chemistries, then the user must also be able to view chemistries.
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Managing Groups
Instead of assigning permissions to each user on an individual basis, optionally, you can 
assign users to a group and apply the same permissions to all the users in the group in a 
single step. As the Geneticist Assistant administrator, you must manage all the necessary 
groups for your Geneticist Assistant application, which includes adding new groups, deleting 
users, and modifying group permissions. 

To add a new group
When you add a group, you must name the group, add to users to the group, and assign 
permissions to the group. If a user has different privileges assigned than the group 
permissions, then the complete set of user permissions is the user permissions plus the group 
permissions. If a user is assigned to multiple groups, then the user’s permissions are a sum of 
all the groups’ permissions.

1. On the Geneticist Assistant main menu, click File > User Management.

The User Management dialog box opens. By default, the User tab is the open tab. 

2. Click the Group tab to open it.

The tab displays all the groups by name that are currently configured for your Geneticist 
Assistant application.

Figure 3-6:  User Management dialog box, Group tab
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3. Click Add New Group.

The Add New Group dialog box opens. All users who can be added to a group are 
displayed in the All Users pane. 

Figure 3-7:  Add New Group dialog box

4. Enter the name for the new group.

5. In the All Users pane, select the users whom you are adding to the group (CTRL-click to 
select multiple users in a single step), and then click Add. 

6. In the Permissions pane, add or delete the permissions for the group as needed. You can 
add or delete permissions individually, or you can add or delete all permissions of a 
specific type in a single step.

• To add all permissions of a specific type (for example, View), select the check box 
next to the type.

• To clear all permissions of a specific type, clear the check box for the type.

Uppercase and lowercase and spaces are allowed. No special characters are 
allowed. 

If you add a user in error, you can remove them. Select the user in the Current 
Users pane (CTRL-click to select multiple users in a single step), and then click 
Remove. 

Be aware of the dependencies for these permissions. For example, if a group is to 
be able to add chemistries, then the group must also be able to view chemistries.
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7. Click OK.

The Add New Group dialog box closes. The User Management dialog box remains 
opens.

8. Click OK. 

The User Management dialog box closes. The Geneticist Assistant main window 
remains opens.

To delete a group
When you delete a group, only the group is deleted. All the users remain configured (with 
their user permissions, if applicable), in Geneticist Assistant.

1. On the Geneticist Assistant main menu, click File > User Management.

The User Management dialog box opens. By default, the User tab is the open tab. 

2. Click the Group tab to open it.

The tab displays all the groups by name that are currently configured for your Geneticist 
Assistant application.

Figure 3-8:  User Management dialog box, Group tab

3. Right-click the group that you are deleting, and on context menu that opens, click 
Remove Group.

The group is deleted.

     

No confirmation message opens asking you if you are sure that you want to delete 
a selected group. Instead, the group is deleted immediately, so be very sure that 
you want to delete a group before doing so.
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4. Click OK.

The User Management dialog box closes. You return to the Geneticist Assistant main 
window.

To edit a group
When you edit a group, you can edit the users who belong to the group and the group 
permissions. You cannot edit the group name. To edit a group name, you must delete the 
existing group (see “To delete a group” on page 79), and then add the group with a new 
group name.

1. On the Geneticist Assistant main menu, click File > User Management.

The User Management dialog box opens. By default, the User tab is the open tab.

2. Click the Group tab to open it.

The tab displays all the groups by name that are currently configured for your Geneticist 
Assistant application.

Figure 3-9:  User Management dialog box, Group tab

3. Do one of the following:

• Double-click the group that you are editing.

• Right-click the group that you are editing, and on the context menu that opens, click 
Edit Group.

The Edit Group dialog box opens. The dialog displays all the current information for the 
group—the group name, the users who are currently assigned to the group, and the 
permissions for the group. See Figure 3-10 on page 81.
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Figure 3-10:  Edit Group dialog box

4. To edit the users who belong to the group, do one or both of the following as needed:

• To add users to the group—In the All Users pane, select the users whom you are 
adding to the group (CTRL-click to select multiple users in a single step), and then 
click Add. 

• To remove users from a group—In the Current Users pane, select the users whom 
you are removing from the group, (CTRL-click to select multiple users in a single 
step), and then click Remove. 

5. In the Permissions pane, add or delete the permissions for the group as needed. You can 
add or delete permissions individually, or you can add or delete all permissions of a 
specific type in a single step.

• To add all permissions of a specific type (for example, View), select the check box 
next to the type.

• To clear all permissions of a specific type, clear the check box for the type.

6. Click OK.

The Edit Group dialog box closes. You return to the Group tab of the User Management 
dialog box.

     

Be aware of the dependencies for these permissions. For example, if a group is to 
be able to add chemistries, then the group must also be able to view chemistries.
Geneticist Assistant User’s Manual 81



Chapter 3
Geneticist Assistant User Management
7. Click OK.

The User Management dialog box closes. You return to the Geneticist Assistant main 
window.
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A panel is a collection of genomic regions that are targeted for a specific genomic test or 
study. Panels are added to Geneticist Assistant by providing a BED file that defines the 
targeted regions, known as panel regions. Each sample that is submitted in Geneticist 
Assistant is assigned to a specific panel. Managing panels consists of importing, modifying, 
and deleting panels, and reviewing panel statistics. A subpanel contains a fixed number of 
regions that are contained within a selected panel. To verify coverage for a smaller number 
of regions that are within the panel that has been selected for a run, you can use a subpanel. 
Managing subpanels consists of adding, modifying, and deleting subpanels.

This chapter covers the following topics:

• “Importing a Panel” on page 85.

• “Modifying a Panel” on page 95.

• “Deleting a Panel” on page 97.

• “Reviewing Panel Statistics” on page 98.

• “Adding a Subpanel” on page 99.

• “Deleting a Subpanel” on page 102.
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Importing a Panel
A panel is a collection of genomic regions that are targeted for a specific genomic test or 
study. Panels are added to Geneticist Assistant by importing a BED file that defines the 
targeted regions, known as panel regions.

To import a panel
1. On the Geneticist Assistant main menu, click Panels > Manage Panels.

The Manage Panels dialog box opens. The number of panels that have already been 
imported into your Geneticist Assistant instance is displayed at the bottom of the dialog 
box. By default, Import from Panel File is selected.

Figure 4-1:  Manage Panels dialog box

2. Next to Import from Panel File, click the Browse button , and then browse to and 

select the appropriate BED file.

Geneticist Assistant creates a panel name that is the same as the selected BED file.

     

If the correct BED file is not available for a panel, then you can create a new BED 
file for it, either from a BED file that was loaded for another panel (see “To create 
a new BED file for a panel by adding or deleting regions” on page 93), or by 
clicking Bed File Builder to open the BED File Builder tool and create a BED file 
that is based on the information that you specify. See “Building a BED File with 
the BED File Builder Tool” on page 279.
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3. Optionally, in the Panel Name field, change the name of the panel.

4. If the correct panel group is not selected, then click Change Associated Panel Group to 
open the Panel Group Association dialog box, and then select a new panel group or click 
Add New Panel Group to open the Add New Panel Group dialog box and create it.

5. Click Import Panel.

The Manage Panels dialog box display is updated to show all the panel regions by name 
for the panel. By default, the coverage thresholds that are initially displayed are the 
global values that are defined on the Quality Control tab on the Settings tab. See “To 
specify the global Quality Control settings” on page 55.

6. Do one of the following:

• If you are done with the configuration of the newly added panel, then click OK to 
close the Manage Panels dialog box and return to the Current Jobs tab of the 
Geneticist Assistant main window. The tab shows the progress of importing the new 
panel. After the panel is successfully imported, the tab is blank. 

• If you are not done with the configuration of the newly added panel, then continue to 
any of the following as needed:

• “To manually set new coverage thresholds for panel regions” on page 87.

• “To create a QC Threshold file for panel regions” on page 88.

• “To set new coverage thresholds for panel regions with a QC Threshold file” on 
page 89.

You can always click Default Name to change the name of the panel back to its 
default name.

 For information about panel groups, see “Managing Objects” on page 49.

To track variant pathogenicities together for all panels, instead of creating custom 
panel groups, create a single panel group that is to be used for all panels, for 
example, a Global panel group.

The time that it can take to import a BED file depends on the size of the BED file. 
Be patient as some BED files can take over an hour to be imported.

To confirm that the panel has been successfully imported, you can open the 
Manage Panels dialog box again, choose Select Existing Panel, and make sure 
that an entry for the imported panel is displayed on the dropdown list of existing 
panels.
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• “To set or delete a preferred transcript list for a panel” on page 90.

• “To set or delete a preferred gene for a panel” on page 92.

• “To create a new BED file for a panel by adding or deleting regions” on page 93.

To manually set new coverage thresholds for panel regions

After you have imported a new panel, the coverage values that are initially displayed for 
each panel region are the global values that are defined on the Quality Control tab of the 
Settings dialog box. If needed, you can edit these values and save the values for the panel. 
You can edit the values for all the regions in a single step, or you can set different coverage 
thresholds on a per region basis.

1. If you have just imported a new panel, then the Manage Panels dialog box is already 
open and the panel regions are displayed; otherwise, do the following:

a. On the Geneticist Assistant main menu, click Panels > Manage Panels to open the 
Manage Panels dialog box.

b. On the Select Existing Panel dropdown list, select the appropriate panel.

c. Click Download and Edit Panel Regions to display the panel regions in the bottom 
pane of the Manage Panels dialog box.

2. Do one of the following:

Action Steps

To edit the values for all 
regions in a single step

1. Click Update QC Threshold.

The Update QC Threshold for All Regions dialog box opens.

Figure 4-2:  Update QC Threshold for All Regions dialog box

2. For each coverage value that is to be edited, double-click it to select 
it, and then manually enter a new value, or click the Up/Down arrows 
to change the value accordingly.

3. Click OK.

To edit the values on a 
per region basis

1. Double-click in the appropriate coverage field for a region.

The coverage value is selected, and Up/Down arrows are displayed.

2. Manually enter a new value, or click the Up/Down arrows to change 
the value accordingly.
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3. If you are done with the configuration of the newly added panel, then click OK to close 
the Manage Panels dialog box and return to the Geneticist Assistant main window. (The 
edited coverage values are now saved for the panel in the Geneticist Assistant database.) 
Otherwise, continue any of the following as needed:

• “To create a QC Threshold file for panel regions” below.

• “To set or delete a preferred transcript list for a panel” on page 90.

• “To set or delete a preferred gene for a panel” on page 92.

• “To create a new BED file for a panel by adding or deleting regions” on page 93.

To create a QC Threshold file for panel regions

After you edit the coverage values for the regions of one panel, you can save these edited 
values to a QC Threshold text file. You can save this file as record of the QC thresholds that 
were used for the panel and you can also load this text file to apply these coverage thresholds 
to a different panel.

1. If you have just imported a new panel, then the Manage Panels dialog box is already 
open and the panel regions are displayed; otherwise, do the following:

a. On the Geneticist Assistant main menu, click Panels > Manage Panels to open the 
Manage Panels dialog box.

b. On the Select Panel dropdown list, select the appropriate panel.

c. Click Download and Edit Panel Regions to display the panel regions on the Manage 
Panels dialog box.

2. Do one of the following:

Action Steps

To edit the values for all 
regions in a single step

1. Click Update QC Threshold.

The Update QC Threshold for All Regions dialog box opens.

Figure 4-3:  Update QC Threshold for All Regions dialog box

2. For each coverage value that is to be edited, double-click it to select 
it, and then manually enter a new value, or click the Up/Down arrows 
to change the value accordingly.

3. Click OK.
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3. Click Save QC Threshold File.

The Save File dialog box opens. By default, the QC Threshold file is named as <Panel 
Name>_qc_threshold, and it is saved in the same directory as the BED file for the panel. 
You can change one or both of these values. The file type is a text file, and you cannot 
change this.

4. Optionally, change the name for the QC Threshold file, and/or the directory in which to 
save the file, and then click Save. 

The Save File dialog box closes. The Manage Panels dialog box remains open. You can 
now load this text file to apply these coverage values to a different panel. See “To set 
new coverage thresholds for panel regions with a QC Threshold file” below.

5. If you are done with the configuration of the newly added or edited panel, then click OK 
to close the Manage Panels dialog box and return to the Geneticist Assistant main 
window. (The edited coverage values are now saved for the panel in the Geneticist 
Assistant database.) Otherwise, continue to one or both of the following as needed:

• “To set or delete a preferred transcript list for a panel” on page 90.

• “To set or delete a preferred gene for a panel” on page 92.

• “To create a new BED file for a panel by adding or deleting regions” on page 93.

To set new coverage thresholds for panel regions with a QC 
Threshold file

After you edit the coverage values for the regions of one panel, you can save these edited 
values to a QC Threshold text file, and then load this text file to apply these coverage values 
to a different panel.

1. If you have just imported a new panel, then the Manage Panels dialog box is already 
open and the panel regions are displayed; otherwise, do the following:

a. On the Geneticist Assistant main menu, click Panels > Manage Panels to open the 
Manage Panels dialog box.

b. On the Select Panel dropdown list, select the appropriate panel.

c. Click Download and Edit Panel Regions to display the panel regions on the Manage 
Panels dialog box.

     

To edit the values on a 
per region basis

1. Double-click in the appropriate coverage field for a region.

The coverage value is selected, and Up/Down arrows are also 
displayed.

2. Manually enter a new value, or click the Up/Down arrows to change 
the value accordingly.

Action Steps
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2. Click Load QC Threshold from File.

The Select a file to set QC threshold dialog box opens.

3. Browse to and select the appropriate QC Threshold file, and then click Open.

The Select a file to set QC threshold dialog box closes, and a QC Threshold Updated 
message opens. The message indicates the number of regions for which the QC 
threshold values were successfully updated. 

4. Click OK.

The message closes. The Manage Panels dialog box remains open.

5. If you are done with the configuration of the newly added or edited panel, then click OK 
to close the Manage Panels dialog box and return to the Geneticist Assistant main 
window. (The edited coverage values are now saved for the panel in the Geneticist 
Assistant database.) Otherwise, continue to one or both of the following as needed:

• “To set or delete a preferred transcript list for a panel” on page 90.

• “To set or delete a preferred gene for a panel” on page 92.

• “To create a new BED file for a panel by adding or deleting regions” on page 93.

To set or delete a preferred transcript list for a panel

A preferred transcript list is a tab-delimited text file that defines the specific transcript or 
isoform that is to be used for a gene. You can use different transcripts for different panels. 
The preferred transcript list contains two fields. The first column contains the gene name. 
The second column specifies the transcript by its nm_accession number. There are no 
restrictions for the file name, but you must save the file as a tab-delimited text file.

1. If you have just created a new panel, then the Manage Panels dialog box is already open 
and the panel regions are displayed; otherwise, do the following:

a. On the Geneticist Assistant main menu, click Panels > Manage Panels to open the 
Manage Panels dialog box.

b. On the Select Existing Panel dropdown list, select the appropriate panel.

2. Optionally, do any or all of the following as needed:

• To view the transcript list that is currently set as the preferred transcript list for the 
panel, click View Existing.

The Preferred Transcript for <Panel Name> dialog box opens. The dialog box 
displays the transcript list that is currently set as the preferred list for the panel. See 
Figure 4-4 on page 91.

If the correct QC Threshold file is not available, then you can create it. See “To 
create a QC Threshold file for panel regions” on page 88.
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Figure 4-4:  Preferred Transcript dialog box

• To save the preferred transcript list as a text (.txt) file, click Save As in the Preferred 
Transcript dialog box; otherwise, click Close to close the dialog box.

The Manage Panels dialog box remain open.

• To set a preferred transcript list for the panel, then next to the Set Preferred 

Transcript from File field, click the Browse button  and in the Open File dialog 

box, browse to and select the appropriate transcript list, and then click Open.

The Open File dialog box closes. The full path to the selected transcript list is 
displayed in the Set Preferred Transcript from File field. 

• To delete the preferred transcript list for the panel, click Delete Existing, and then 
click Yes in the Delete Existing Preference message. 

The Manage Panels dialog box remain open.

3. If you are done with the configuration of the newly added or edited panel, then click OK 
to close the Manage Panels dialog box and return to the Geneticist Assistant main 
window. Otherwise, continue to any of the following as needed:

• “To manually set new coverage thresholds for panel regions” on page 87.

• “To create a QC Threshold file for panel regions” on page 88.

• “To set new coverage thresholds for panel regions with a QC Threshold file” on page 
89.

• “To set or delete a preferred gene for a panel” on page 92.

• “To create a new BED file for a panel by adding or deleting regions” on page 93.

The Save As option provides a quick way of copying the preferred transcript list so 
that you can make any needed changes to it, and then use it with this panel or 
another panel.
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To set or delete a preferred gene for a panel

If a variant is found at a position where there are overlapping genes, then you can specify the 
gene that is to be used for the panel. The file that specifies the preferred gene is a text file that 
contains the complete gene name on a single line.

1. If you have just created a new panel, then the Manage Panels dialog box is already open 
and the panel regions are displayed; otherwise, do the following:

a. On the Geneticist Assistant main menu, click Panels > Manage Panels to open the 
Manage Panels dialog box.

b. On the Select Existing Panel dropdown list, select the appropriate panel.

2. Optionally, do any or all of the following as needed:

• To view the genes that are currently set as the preferred genes for the panel, click 
View Existing.

The Preferred Gene for <Panel Name> dialog box opens. The dialog box displays 
the genes that are currently set as the preferred genes for the panel. 

Figure 4-5:  Preferred Gene dialog box

• To save the preferred gene file as a text (.txt) file, click Save As in the Preferred 
Gene dialog box; otherwise, click Close to close the dialog box.

The Manage Panels dialog box remains open.

     

The Save As option provides a quick way of copying the preferred gene list so that 
you can make any needed changes to it, and then use it with this panel or another 
panel.
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• To set preferred genes for the panel, then next to the Set Preferred Gene from File 

field, click the Browse button  and in the Open File dialog box, browse to and 

select the appropriate preferred gene file, and then click Open.

The Open File dialog box closes. The full path to the selected preferred gene file is 
displayed in the Set Preferred Gene from File field. 

• To delete the preferred genes for the panel, click Delete Existing, and then click Yes 
in the Delete Existing Preference message. 

The Manage Panels dialog box remain open.

3. If you are done with the configuration of the newly added or edited panel, then click OK 
to close the Manage Panels dialog box and return to the Geneticist Assistant main 
window. Otherwise, continue to any of the following as needed:

• “To manually set new coverage thresholds for panel regions” on page 87.

• “To create a QC Threshold file for panel regions” on page 88.

• “To set new coverage thresholds for panel regions with a QC Threshold file” on page 
89.

• “To set or delete a preferred transcript list for a panel” on page 90.

• “To create a new BED file for a panel by adding or deleting regions” on page 93.

To create a new BED file for a panel by adding or deleting regions

Sometimes, you might need to use a panel that is a combination of two or more BED files. 
After you load a BED file for a panel, you can add regions from an existing BED file to it 
and then save the combined regions as either a new BED file or a panel. You can also delete 
regions from the loaded BED file and save the modified regions as a new BED file or panel.

1. If you have just imported a new panel, then the Manage Panels dialog box is already 
open and the panel regions are displayed; otherwise, do the following:

a. On the Geneticist Assistant main menu, click Panels > Manage Panels to open the 
Manage Panels dialog box.

b. On the Select Panel dropdown list, select the appropriate panel.

c. Click Download and Edit Panel Regions to display the panel regions on the Manage 
Panels dialog box.

     

When you add regions from an existing BED file to another BED file, all the 
regions are added from the existing BED file. You cannot select specific regions to 
add; however, after all the regions are added, you can delete one or more regions.
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2. Do one or both of the following as needed:

3. On the Manage Panels dialog box, click Save Panel Regions to file.

The Save File dialog box opens. By default, the new BED file is named the same as the 
loaded BED file, and it is saved in the same directory as the loaded BED file. You can 
change one or both of these values.

4. Optionally, change the name for the new BED file, and/or the directory in which to save 
the file, and then click Save. 

The Save File dialog box closes. The Manage Panels dialog box remains open. 

5. If you are done with the configuration of the newly added or edited panel, then click OK 
to close the Manage Panels dialog box and return to the Geneticist Assistant main 
window. Otherwise, continue to any of the following as needed:

• “To manually set new coverage thresholds for panel regions” on page 87.

• “To create a QC Threshold file for panel regions” on page 88.

• “To set new coverage thresholds for panel regions with a QC Threshold file” on page 
89.

• “To set or delete a preferred transcript list for a panel” on page 90.

• “To set or delete a preferred gene for a panel” on page 92.

Action Steps

To add regions from an existing 
BED file

1. Click Add Regions from File.

The Select a file to add to the panel dialog box opens.

2. Browse to and select the appropriate BED file, and then 
click Open to close the dialog box and return to the 
Manage Panels dialog box.

To delete regions from the loaded 
BED file

1. Click the region that is to be deleted. (CTRL-click to 
select multiple regions.)

2. Right-click the selected regions, and on the context 
menu that opens, click Remove Selected Regions.

Note: Deleting regions from a panel does not delete the 
panel. To delete the panel itself, see “Deleting a 
Panel” on page 97.
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Modifying a Panel
Managing panels includes modifying panels that will be used for studying your data in 
Geneticist Assistant.

To modify a panel
1. On the Geneticist Assistant main menu, click Panels > Manage Panels.

The Manage Panels dialog box opens.

Figure 4-6:  Manage Panels dialog box

2. On the Select Existing Panel dropdown list, select the panel that is to be modified.

3. Click Download and Edit Panel Regions.

The panel regions are displayed on the Manage Panels dialog box.

4. Do any or all of the following as needed:

• To change the associated panel group, click Change Associated Panel Group, and in 
the Panel Group Association dialog box, make the necessary change.

• To manually set new coverage thresholds for the panel regions, see “To manually set 
new coverage thresholds for panel regions” on page 87.

• To set new coverage thresholds for the panel regions with a QC Threshold file, see 
“To set new coverage thresholds for panel regions with a QC Threshold file” on page 
89.
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• To set a preferred transcript list for the panel, or delete a preferred transcript list, see 
“To set or delete a preferred transcript list for a panel” on page 90.

• To set a preferred gene for the panel, see “To set or delete a preferred gene for a 
panel” on page 92.

• To create a new BED file for the panel, see “To create a new BED file for a panel by 
adding or deleting regions” on page 93.
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Deleting a Panel
Managing panels includes deleting panels that are no longer needed in Geneticist Assistant.

To delete a panel
1. On the Geneticist Assistant main menu, click Panels > Manage Panels.

The Manage Panels dialog box opens.

Figure 4-7:  Manage Panels dialog box

2. On the Select Existing Panel dropdown list, select the panel that is to be deleted.

3. Click Delete.

A message opens asking you if you are sure that you want to delete the selected panel.

4. Click Yes.

The message closes. The entire panel is deleted, and a second message opens indicating 
that the panel was successfully deleted.

5. Click OK.

The message closes. The Manage Panels dialog box remains open.

When you delete a panel, you delete the entire panel. To simply delete regions from 
a panel, not the entire panel, see “To create a new BED file for a panel by adding 
or deleting regions” on page 93.
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Reviewing Panel Statistics
The Panel Statistics tab has options for reviewing specific information for a selected panel/
panel group. By default, all samples for the panel are included. You can modify the options 
for displaying panel statistics such as setting specific date range, or selecting specific 
samples or runs.

To review panel statistics
1. On the Geneticist Assistant main menu, click Panels > Panel Statistics.

The Panel Statistics tab opens.

2. Select the panel for which the statistics are to be viewed.

3. Change any of the display options for the Panel Statistics tab, and then click OK to laod 
the panel statistics based on the specified options.

The Panel Statistics tab that opens from the Panels menu is identical to the Panel 
Statistics tab that opens from the context menu of the Runs tab or the Run tab. For 
a complete description of this tab, see “To calculate panel statistics (Runs tab)” 
on page 163 or “To calculate panel statistics (Run tab)” on page 197.
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Adding a Subpanel
A subpanel contains a fixed number of regions that are contained within a selected panel. To 
verify coverage for a smaller number of regions that are within the panel that has been 
selected for a run, you can use a subpanel. Managing panels includes adding the new 
subpanels that are to be used for targeting a specific genomic test or study.

To add a subpanel
1. On the Geneticist Assistant main menu, click Panels > Manage Panels.

The Manage Panels dialog box opens. See Figure 4-1 on page 85.

2. Click Manage Subpanels.

The Manage Subpanels dialog box opens. The first time that the dialog box opens, all 
fields are blank; otherwise, it displays the information for the subpanel that was last 
viewed and/or modified. 

Figure 4-8:  Manage Subpanels dialog box

3. Select the panel for which you are adding the subpanel.

4. Click New Subpanel.

The Add New Subpanel dialog box opens.

Figure 4-9:  Add Subpanel dialog box
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5. Click the Browse button  that is next to the Subpanel File (.bed) field, and then 

browse to and select the BED file for the subpanel that you are adding.

The Subpanel file field is populated with the full directory path to the selected BED file, 
and by default, the subpanel name is set to the name of the selected BED file.

6. Optionally, edit the name for the subpanel.

7. Click OK.

The Add Subpanel dialog box closes. The Manage Subpanels dialog box remains open. 
The information for all the regions (Region Name, Chromosome Number, Region Start, 
and Region End) is displayed in the lower pane of the dialog box.

8. If you are done with the configuration of the newly added subpanel, then click OK to 
close the Manage Subpanels dialog box and return to the Manage Panels dialog box; 
otherwise, continue to “To create a new BED file for a subpanel by adding or deleting 
regions” below.

To create a new BED file for a subpanel by adding or deleting 
regions

Sometimes, you might need to use a subpanel that is a combination of two or more BED 
files. After you load a BED file for a subpanel, you can add regions from an existing BED 
file to it and then save the modified regions as a new BED file or subpanel. You can also 
delete regions from the loaded BED file and save the modified regions as a new BED file or 
subpanel.

1. If you have just created a new subpanel, then the Manage subpanels dialog box is 
already open and all the panel regions for the subpanel are displayed; otherwise, do the 
following:

a. On the Geneticist Assistant main menu, click Panels > Manage Panels to open the 
Manage Panels dialog box.

b. Choose Select existing panel, and then on the Panel dropdown list, select the 
appropriate panel.

If the correct BED file is not available for a subpanel, then you can use the BED 
File Builder tool to create one based on the information that you specify. See 
“Building a BED File with the BED File Builder Tool” on page 279.

You can click Default Name to reset the BED file name to the default value.

When you add regions from an existing BED file to another BED file, all the 
regions are added from the existing BED file. You cannot select specific regions to 
add; however, after all the regions are added, you can delete one or more regions.
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c. Click Manage Subpanels.

d. On the Manage Subpanels dialog box, select the appropriate subpanel.

e. Click View subpanel regions.

2. Do one or both of the following as needed:

3. On the Manage Subpanels dialog box, click Save Panel Regions to a BED file.

The Save File dialog box opens. By default, the new BED file is named the same in the 
following format: <subpanel>_<Panel> and it is saved in the same directory as the 
loaded BED file. You can change one or both of these values.

4. Click OK.

The regions are saved as a subpanel.

Action Steps

To add regions from an existing 
BED file

1. Click the Browse button  that is next to the Add 

Regions from BED File field.

The Select a file to add to the panel dialog box opens.

2. Browse to and select the appropriate BED file, and then 
click Open to close the dialog box and return to the 
Manage Panels dialog box.

3. Click Add Regions.

To delete regions from the loaded 
BED file

1. Click the region that is to be deleted. (CTRL-click to 
select multiple regions.)

2. Right-click the selected regions, and on the context 
menu that opens, click Remove Selected Regions.

Note: Deleting regions from a BED file does not delete the 
subpanel. To delete the subpanel itself, see “Deleting 
a Subpanel” on page 102.
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Deleting a Subpanel
Managing subpanels includes deleting subpanels that are no longer needed in Geneticist 
Assistant.

To delete a subpanel
1. On the Geneticist Assistant main menu, click Panels > Manage Panels.

The Manage Panels dialog box opens. See Figure 4-1 on page 85.

2. Choose Select existing panel, and then on the Panel dropdown list, select the appropriate 
panel.

3. Click Manage Subpanels.

The Manage Subpanels dialog box opens. 

Figure 4-10:  Manage Subpanels dialog box

4. Select the subpanel that is to be deleted. 

     

When you delete a subpanel, you delete the entire subpanel. To simply delete 
regions from a BED file, not the entire subpanel, see “To create a new BED file for 
a subpanel by adding or deleting regions” on page 100.
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5. Click Delete.

A Delete Subpanel message opens, asking you if you are sure that you want to delete the 
selected subpanel from the database.

Figure 4-11:  Delete Subpanel message

6. Click Yes.

The Delete Subpanel message closes, and a Subpanel Deleted message opens, indicating 
that the selected subpanel was successfully deleted.

Figure 4-12:  Subpanel Deleted message

7. Click OK.

The Subpanel Deleted message closes. The Manage Subpanels dialog box remains open. 
The subpanel and its regions are no longer displayed in the dialog box.
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A patient refers to an individual from whom a sample was taken. A run refers to loading a 
BAM file and a VCF file or just a VCF file into Geneticist Assistant for the purposes of 
importing a list of variants into the Geneticist Assistant database and/or reviewing a list of 
variants in a sample. This chapter details how to manage patient settings for your runs and 
how to add a new run in Geneticist Assistant.

This chapter covers the following topics:

• “Adding Patients” on page 107.

• “Accessing and Reviewing Patient Records” on page 112.

• “Adding a Run” on page 149.

     

For information about managing your run settings (chemistries, instruments, and 
so on), see “Managing Objects” on page 49.
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Adding Patients
In addition to managing settings (chemistries, instruments, and so on) for your runs, you can 
manage the patients for your runs. A patient refers to an individual from whom a sample was 
taken. Managing patients for your runs consists of adding new patients to the Geneticist 
Assistant database. When you add new patients, you can manually add patients one at a time, 
or you can use the a batch import process to add multiple patients in a single step. Moreover, 
if your VCF or BAM sample file names begin or end with the patient ID, then Geneticist 
Assistant can automatically associate the appropriate sample with the patient. If you are 
loading a standalone VCF file, then just the VCF file name must begin or end with the 
patient ID. If you are loading both a VCF file and a BAM file, then the names for both files 
must begin and/or end with the patient ID.

To add new patients one at a time
When you add a patient one at a time, you can specify the name, birthdate, and gender for the 
patient as well as a unique ID for the patient. You can also add relationships to the patient, 
and you can specify one or more phenotypes for the patient.

1. On the Geneticist Assistant main menu, click File > Add Patient.

The Add New Patient dialog box opens. The Add Patient tab is the opened tab. 

Figure 5-1:  Add New Patient dialog box, Add Patient tab
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2. Enter the information for the new patient.

3. If applicable, to specify relationships for the new patient, select Is Related to Existing 
Patient and then do the following in the order indicated:

• Select the relationship type (Sibling (the default value), Child, or Parent).

• Select the existing patient for this relationship. (Select the patient on the select 
existing patient list, or double-click the patient entry in the All Patients pane.)

• Click Add.

The Relationships About to Be Added list display the relationship that you have 
specified for the new patient.

Figure 5-2:  Add New Patient dialog box, Relationship options

Option Description

External ID A unique ID for the patient. 

First Name The first name for the patient.

Last Name The last name for the patient.

Birthday The patient’s birthday. You must select each value individually, and then you 
can manually enter a new value, or you can use the Up/Down arrows.

Gender Male or Female.
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4. Repeat Step 3 to add as many relationships for a patient as needed.

5. If applicable, to add a phenotype for the patient, select the phenotype on the Add 
Phenotype dropdown list, and then click Add. You can repeat this step as many times as 
needed to add multiple phenotypes for the patient.

The added phenotype is displayed in the Phenotype pane.
If

6. Optionally, to add a comment for the phenotype, do one of the following; otherwise, go 
to Step 7.

• Single click twice in the Comment field, enter the comment, and then click 
anywhere outside the field.

• Right-click the phenotype and on the context menu that opens, click Add Patient 
Phenotype Comment.

7. Click OK.

The Add New Patient dialog box closes.

To add new patients with the batch import process
You use a batch import process to add multiple patients in a single step to the Geneticist 
Assistant database. The batch import file must be either a comma-separated values (.csv) 
file, a tab-delimited text (.txt) file, or a tab-separated values (.tsv) file. The file must contain 
the following columns of information—the patient ID, the patient last name, the patient first 
name, the patient date of birth, the patient gender, the patient race, the patient phenotypes, 
and the patient relationships. Patient relationships must in the format 
patient ID-Relationship, for example, ABS17-Father. Multiple phenotypes and multiple 
relationships must be separated by semi-colons. Figure 5-3 below shows the standard 
column order and the standard column names. If your import file does not follow either the 
standard column order or the standard column names, then you must manually indicate the 
order of the columns in your file. 

Figure 5-3:  Standard column order and names

If you add a relationship in error, right-click the relationship, and then select 
Remove Selected Rows. CTRL-click to select multiple relationships for deletion.

If the appropriate phenotype is not available, then you can click New Phenotype 
and add it. You can also add phenotypes using the Manage Objects function. See 
“Managing Objects” on page 49.
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1. On the Geneticist Assistant main menu, click File > Add Patient.

The Add New Patient dialog box opens. The Add Patient tab is the opened tab. See 
Figure 5-1 on page 107.

2. Click the Batch Import tab to open it.

Figure 5-4:  Add New Patient dialog box, Batch Import tab

3. Next to the Patient File field, click the Browse button , and then browse to and select 

your patient file.

4. Specify the properties of your patient file.

Property Description

Add New Phenotype Terms in 
File Automatically

Selected by default. If the patient file contains phenotypes that 
have not already been added to the Geneticist Assistant 
database either through the Manage Objects function (see 
“Managing Objects” on page 49), or the Add Phenotype option 
on the Add Patient tab (see “Patient tab, Patient sub-tab, 
Phenotype pane” on page 120), then leave this option selected 
to automatically add these phenotypes to the database. 
Otherwise, clear this option. 

Data Delimiter Indicate the delimiter used (Comma or Tab).

Date of Birth Format Select the format used for the patients’ birthdays.
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5. If your file follows the standard column order or the standard column names, go to Step 
8; otherwise, if your file does not follow either of these standards, go to Step 6.

6. In the Result pane, rearrange the column headers so that they are in the same order as the 
column headers in your patient file.

7. Click Check With File.

• The file is loaded and the patient information is displayed in the Result pane. If your 
file format is correct, go to Step 8.

• If your file format is incorrect then, you must click Incorrect, Redo, and then make 
the necessary changes to the column headers. Click Check With File again to verify 
that your file has the correct format. Only after you verify that your file has the 
correct format can you continue to Step 8.

8. Click OK.

The Add New Patient dialog box closes. The patients, and if applicable, any new 
phenotypes, are imported into your Geneticist Assistant database.

File Column Format Select one of the following to indicate the file format. 

• File follows standard column order.

• File follows standard column names.

• File does not follow above standards. I want to specify.

For information about rearranging columns, see “To rearrange the order of data 
columns” on page 42.

Property Description
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Accessing and Reviewing Patient Records
In addition to managing settings (chemistries, instruments, and so on) for your runs, you can 
manage the patients for your runs. A patient refers to an individual from whom a sample was 
taken. Managing patients for your runs consists of a variety of different activities, including 
reviewing and modifying information (such as adding comments and adding relationships) 
for existing patients and related patients, and generating, and optionally, saving Patient 
reports to the Geneticist Assistant database.

To review existing patient information
The Patients tab has a single pane, the Patients pane, for displaying information for existing 
patients. When you review the information for an existing patient, a variety of options are 
available for working with the patient, such as modifying the identifying information for a 
patient, and adding relationships and comments for the patient. 

1. On the Geneticist Assistant main menu, click File > Patients.

The Patients tab opens.

• If you are an Administrator user, then the tab can display all the patients that have 
been added by all users to your Geneticist Assistant database. By default, when the 
tab first opens, only up to the 30 most recently added patients are displayed and the 
patients are sorted based on Patient ID. 

• If you are a standard user, then the tab can display all the patients that you have 
added to the Geneticist Assistant database as well as all the patients that others users 
have added to the database and for which you have been granted at least the Can 
Read permission. By default, when the tab first opens, only up to the 30 most 
recently added patients that fit one of these two criteria are displayed and the 
patients are sorted based on Patient ID.

Figure 5-5:  Patients tab
112 Geneticist Assistant User’s Manual



Chapter 5
Managing Patients and Runs
2. Optionally, do any or all of the following as needed:

• Change the number of patients by which to limit the display.

• If you are an Administrator user, clear the Limit Patients by Number option to 
display all the patients that have been added to your Geneticist Assistant database.

• If you are a standard user, clear the Limit Patients by Number option to display all 
the patients you have added to the Geneticist Assistant database as well as all the 
patients that have been added by other users and for which you have been granted at 
least the Can Read permission.

• Right-click a patient on the tab to open a context menu with the following options:

Table 5-1: Patients tab context menu

Option Description

Patient Detail Opens the Patient tab. See Step 3 below.

Note: You can also double-click a patient to open the Patient tab.

Add New Relationships Opens the Add New Patient dialog box so that you can add a relationship to the 
selected patient. By default, the Is Related to Existing Patient option is selected and 
unavailable. Repeat Step 3 of “To add new patients one at a time” on page 107 as 
many times as needed to add all the necessary patient relationships to the patient.

Remove Patient’s 
Relationships

Removes all the relationships that have been added for the patient.

Add All to Custom 
Report

Selects all the data that is displayed for the patients for inclusion in a custom report. 
See Chapter 10, “Geneticist Assistant Reports,” on page 267.

Delete Patient Deletes the selected patient from the Geneticist Assistant database. 

Add Comment Opens the Add Patient Comment dialog box. You add a comment for the selected 
patient in the Add Comment field. The comment is displayed in the Last Comment field 
and in the Comments pane on the Patient sub-tab on the Patient tab. See “Patient tab, 
Patient sub-tab, Comments pane” on page 124.

Figure 5-6:  Add Patient Comment dialog box

Note: If multiple comments have been added for a patient, then the comment that was 
added last is displayed in the Last Comment field. 
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3. Do one of the following to open the Patient tab:

• Right-click the patient record that you are reviewing, and on the context menu that 
opens, click Patient Detail.

• Double-click the patient record that you are reviewing.

The Patient tab has three sub-tabs—Patient, Samples, and Variants. Each sub-tab has 
different panes for displaying and working with patient information. See:

• “Patient tab, Patient sub-tab” on page 116.

• “Patient tab, Samples sub-tab” on page 127.

• “Patient tab, Variants sub-tab” on page 139.

Permissions Opens the Permissions dialog box.You use the options on this dialog box to set or 
modify the permissions (Can Read or Can Read and Can Write) that the specified 
users or groups are to have for the patient record. If you are an Administrator user, then 
you can set or modify the permissions for a patient record that any user has added. If 
you are a standard user, then you can set or modify the permissions for only those 
patient records that you have added to the Geneticist Assistant database, or for those 
patient records that other users have added and to which you have been granted Can 
Read and Can Write permissions. See “To set or modify the Read/Write permissions for 
patient records” on page 115.

Load Columns

Manually Opens the Select Columns dialog box in which you can select columns that are to be 
shown and clear the columns that are to be hidden dynamically, or select a 
configuration from the list of available column configurations. This option is also 
available on the column header context menu for the sub-tab.

Note: For information about showing and hiding columns dynamically, see “To show/
hide columns in a tab pane” on page 37.

Note: If you set column display preferences here, then you can display preferences for 
variants in all the variant sub-tabs and panes (with the exception of the Sample 
Group columns on the Sample Variant Data sub-tab on the Sample tab and the 
Variant pane on the Variant tab) in a single step. See “To apply shared 
preferences or to clear all tab preferences” on page 58.

Compact Displays the data columns on the sub-tab in a more condensed view. To toggle the 
display, click Compact as needed.

<Saved Pane 
Configuration Name> - 
Saved by <User Name>

Publicly available pane configurations. The name of the user who created a pane 
configuration is displayed next to the configuration name.

Load Filters

Manually Opens the Filters table for the Patients pane. See “To filter the data that is displayed in 
a tab pane” on page 32.

<Filter Template Name> 
- Saved by <User 
Name>

Opens the saved Filter template for the Patients pane. Limits the display in the pane to 
only the data (fields) that are defined by the template. See “To filter the data that is 
displayed in a tab pane” on page 32.

Table 5-1: Patients tab context menu (Continued)

Option Description
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To set or modify the Read/Write permissions for patient records

1. If you have not already done so, open the Patients tab.

2. Select the patient or CTRL-click to select the multiple patients for which the permissions 
are being set.

3. Right-click any selected patient, and on the context menu that opens, click Permissions.

The Permissions dialog box opens.

• The first time that the dialog box opens, if any patient was added using a Geneticist 
Assistant version with a build date of 4/8/15 or later, then the names of the users who 
added the patients are displayed in the lower pane of the dialog box and both the Can 
Read and Can Write permissions are selected. If a standard user added any patient, 
then the Administrator user name is also displayed. 

• For patients who were added using earlier versions of Geneticist Assistant, the pane 
is blank. For subsequent openings, the dialog box displays the names of all the users 
and/or groups and their assigned permissions for the patient records.

Figure 5-7:  Permissions dialog box (Patient tab)

4. Modify the permissions for any user or group as needed and then click OK; otherwise, to 
add permissions for a new user or group, go to Step 5.

     

You can add or remove the Can Write permission for a user or group, or you can 
remove both the Can Read and Can Write permissions. Removing the Can Read 
permission but leaving the Can Write permission selected for a user or group has 
no effect.
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5. Enter a user name (the login name for the user), or to assign the same permissions to 
multiple users in a single step, enter a group name.

As you enter a user name or a group name, a dropdown list opens. The list is 
dynamically updated with user names or group names that are in your Geneticist 
Assistant database and that match the search string that you are entering.

6. Select the appropriate user name or group name from the list, and then click Add.

The user name or group name is displayed in the lower pane of the dialog box. The Can 
Read permission is already assigned for the selected user or group. If just this permission 
is selected, then the user or group can simply view the patient records. They cannot 
modify them.

7. Optionally, if the user or group must be able to modify the patient records as well, then 
select the Can Write permission.

8. Click OK.

A Permission Updated message opens. 

9. Click OK. 

Both the message and the Permissions dialog box close. The specified permissions are 
set for the patient records.

Patient tab, Patient sub-tab

When a Patient tab first opens, the Patient sub-tab is the active tab. 

Figure 5-8:  Patient tab, Patient sub-tab

The search string is not case-sensitive, but the string must begin with the user or 
group name. For example, a search string of “Ja” or “ja” returns a user with the 
name of Jane Doe, but a search string of “Doe” does not.
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The Patient sub-tab has five panes for displaying and working with patient information. 

Patient tab, Patient sub-tab, Patient pane

The Patient pane on the Patient sub-tab shows the identifying information for the patient (ID, 
name, and so on). You can double-click in any of the following fields to modify the 
information as needed (External ID, First Name, Last Name, and/or Date of Birth) and you 
can select a different value for the Gender. 

You can right-click in the pane to open a context menu with the following options:

Pane Available Options

Patient • Modifying the identifying information for a patient.

• Adding relationships to the patient.

• Adding comments for the patient.

• Removing relationships for a patient.

See “Patient tab, Patient sub-tab, Patient pane” on page 117.

Phenotypes Adding phenotypes for the patient. See “Patient tab, Patient sub-tab, 
Phenotype pane” on page 120.

Related Patients • Adding relationships to a related patient.

• Removing relationships for a related patient.

See “Patient tab, Patient sub-tab, Related Patients pane” on page 122.

Comments • Adding comments for a patient.

• Deleting comments for a patient.

See “Patient tab, Patient sub-tab, Comments pane” on page 124.

Reports • Viewing a Patient report that was saved to the Geneticist Assistant 
database.

• Deleting a Patient report that was saved to the Geneticist Assistant 
database.

See “Patient tab, Patient sub-tab, Reports pane” on page 126.

If you are changing the Date of Birth for the patient, then you must select one 
value (month, day, or year) at a time, and then you can manually enter a a new 
value, or you can use the Up/Down arrows to change the value.

Table 5-2: Patient tab, Patient sub-tab, Patient pane context menu

Option Description

Add New 
Relationships

Opens the Add New Patient dialog box so that you can add a relationship to the selected 
patient. By default, the Is Related to Existing Patient option is selected and unavailable. 
Repeat Step 3 of “To add new patients one at a time” on page 107 as many times as 
needed to add all the necessary patient relationships to the patient.

Remove Patient’s 
Relationships

Removes all the relationships that have been added for the patient.

Add All to Custom 
Report

Selects all the data that is displayed for the patient for inclusion in a custom report. See 
Chapter 10, “Geneticist Assistant Reports,” on page 267.
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Add Comment Opens the Add Comment dialog box. You add a comment for the selected patient in the 
Add Comment field. The comment is displayed in the Last Comment field in the pane and 
in the Comments pane. See “Patient tab, Patient sub-tab, Comments pane” on page 124.

Figure 5-9:  Add Patient Comment dialog box

Note: If multiple comments have been added for a patient, then the comments are 
displayed in reverse chronological order in the Comments pane. Only the last 
comment added is displayed in the Last Comment field. 

Permissions Opens the Permissions dialog box.You use the options on this dialog box to set or modify 
the permissions (Can Read or Can Read and Can Write) that the specified users or groups 
are to have for the patient record. If you are an Administrator user, then you can set or 
modify the permissions for a patient record that any user has added. If you are a standard 
user, then you can set or modify the permissions for only those patient records that you 
have added to the Geneticist Assistant database, or for those patient records that other 
users have added and to which you have been granted Can Read and Can Write 
permissions. See “To set or modify the Read/Write permissions for a patient record” below.

Load Columns

Manually Opens the Select Columns dialog box in which you can select columns that are to be 
shown and clear the columns that are to be hidden dynamically, or select a configuration 
from the list of available column configurations. This option is also available on the column 
header context menu for the sub-tab.

Note: For information about showing and hiding columns dynamically, see “To show/hide 
columns in a tab pane” on page 37.

Note: If you set column display preferences here, then you can display preferences for 
variants in all the variant sub-tabs and panes (with the exception of the Sample 
Group columns on the Sample Variant Data sub-tab on the Sample tab and the 
Variant pane on the Variant tab) in a single step. See “To apply shared preferences 
or to clear all tab preferences” on page 58.

Compact Displays the data columns on the sub-tab in a more condensed view. To toggle the display, 
click Compact as needed.

Table 5-2: Patient tab, Patient sub-tab, Patient pane context menu (Continued)

Option Description
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To set or modify the Read/Write permissions for a patient record

1. If you have not already done so, open the Patient sub-tab on the Patient tab.

2. Right-click the patient record, and on the context menu that opens, click Permissions.

The Permissions dialog box opens. 

• The first time that the dialog box opens, if the patient was added using a Geneticist 
Assistant version with a build date of 4/8/15 or later, then the name of the user who 
added the patient is displayed in the lower pane of the dialog box and both the Can 
Read and Can Write permissions are selected. If a standard user added the patient, 
then the Administrator user name is also displayed. 

• For a patient who was added using earlier versions of Geneticist Assistant, the pane 
is blank. For subsequent openings, the dialog box displays the name of all the users 
and/or groups and their assigned permissions for the patient record.

Figure 5-10:  Permissions dialog box (Patient tab)

     

<Saved Pane 
Configuration Name> 
- Saved by <User 
Name>

Publicly available pane configurations. The name of the user who created a pane 
configuration is displayed next to the configuration name.

Load Filters

Manually Opens the Filters table for the Patient pane. See “To filter the data that is displayed in a tab 
pane” on page 32.

<Filter Template 
Name> - Saved by 
<User Name>

Opens the saved Filter template for the Patient pane. Limits the display in the pane to only 
the data (fields) that are defined by the template. See “To filter the data that is displayed in 
a tab pane” on page 32.

Table 5-2: Patient tab, Patient sub-tab, Patient pane context menu (Continued)

Option Description
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3. Modify the permissions for any user or group as needed and then click OK; otherwise, to 
add permissions for a new user or group, go to Step 4.

4. Enter a user name (the login name for the user), or to assign the same permissions to 
multiple users in a single step, enter a group name.

As you enter a user name or a group name, a dropdown list opens. The list is 
dynamically updated with user names or group names that are in your Geneticist 
Assistant database and that match the search string that you are entering.

5. Select the appropriate user name or group name from the list, and then click Add.

The user name or group name is displayed in the lower pane of the dialog box. The Can 
Read permission is already assigned for the selected user or group. If just this permission 
is selected, then the user or group can simply view the patient record. They cannot 
modify it.

6. Optionally, if the user or group must be able to modify the patient record as well, then 
select the Can Write permission.

7. Click OK.

A Permission Updated message opens. 

8. Click OK. 

Both the message and the Permissions dialog box close. The specified permissions are 
set for the patient record.

Patient tab, Patient sub-tab, Phenotype pane

The Phenotype pane on the Patient sub-tab shows all the phenotypes that have been added 
for the patient, and if applicable, the associated comments that have been added for each 
phenotype. You can right-click in the pane to open a context menu with the following 
options:

You can add or remove the Can Write permission for a user or group, or you can 
remove both the Can Read and Can Write permissions. Removing the Can Read 
permission but leaving the Can Write permission selected for a user or group has 
no effect.

The search string is not case-sensitive, but the string must begin with the user or 
group name. For example, a search string of “Ja” or “ja” returns a user with the 
name of Jane Doe, but a search string of “Doe” does not.

Table 5-3: Patient tab, Patient sub-tab, Phenotypes pane context menu

Option Description

Add All to Custom 
Report

Selects all the data that is displayed in the Phenotype pane for inclusion in a custom 
report. See Chapter 10, “Geneticist Assistant Reports,” on page 267.

Delete Phenotype Deletes the selected phenotype for the patient.
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You can single click twice in the Comment field in the Phenotypes pane to select the current 
comment in the field and edit it, or if the field is blank, enter a new comment. After you add 
or edit a comment, and then click out of the field, the Update Phenotype Comment dialog 
box opens. The dialog box displays the phenotype for which you are adding or editing the 
comment, the current (old) comment, and the new comment. You can make additional edits 

Add Phenotype Opens the Add Phenotype dialog box. The Phenotypes dropdown list contains all the 
phenotypes that are currently available in the Geneticist Assistant database that you can 
add for the patient. You can add multiple phenotypes for the patient. You can also add a 
comment for each phenotype that you add for the patient.

Figure 5-11:  Add Phenotype dialog box

Note: If the appropriate phenotype is not available, then you can click New to add it to the 
Geneticist Assistant database. You can also use the Manage Objects function to 
add a phenotype to the Geneticist Assistant database. See “Managing Objects” on 
page 49.

Load Columns

Manually Opens the Select Columns dialog box in which you can select columns that are to be 
shown and clear the columns that are to be hidden dynamically, or select a configuration 
from the list of available column configurations. This option is also available on the column 
header context menu for the sub-tab.

Note: For information about showing and hiding columns dynamically, see “To show/hide 
columns in a tab pane” on page 37.

Note: If you set column display preferences here, then you can display preferences for 
variants in all the variant sub-tabs and panes (with the exception of the Sample 
Group columns on the Sample Variant Data sub-tab on the Sample tab and the 
Variant pane on the Variant tab) in a single step. See “To apply shared preferences 
or to clear all tab preferences” on page 58.

Compact Displays the data columns on the sub-tab in a more condensed view. To toggle the display, 
click Compact as needed.

<Saved Pane 
Configuration Name> 
- Saved by <User 
Name>

Publicly available pane configurations. The name of the user who created a pane 
configuration is displayed next to the configuration name.

Load Filters

Manually Opens the Filters table for the Phenotypes pan. See “To filter the data that is displayed in a 
tab pane” on page 32.

<Filter Template 
Name> - Saved by 
<User Name>

Opens the saved Filter template for the Phenotypes pane. Limits the display in the pane to 
only the data (fields) that are defined by the template. See “To filter the data that is 
displayed in a tab pane” on page 32.

Table 5-3: Patient tab, Patient sub-tab, Phenotypes pane context menu (Continued)

Option Description
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to the new comment as needed, and then click OK to close the dialog box and save the new 
or modified comment for the phenotype. 

Figure 5-12:  Update Phenotype Comment dialog box

Patient tab, Patient sub-tab, Related Patients pane

The Related Patients pane on the Patient sub-tab shows all the current relationships for the 
patient, and the last comment that was added for each related patient. You can 
double-click a patient on the Related Patients tab to display the information for the related 
patient in a new Patient tab. The currently opened Patient tab remains open, but the focus is 
changed to the new Patient tab. You can right-click in the pane to open a context menu with 
the following options:

Table 5-4: Patient tab, Patient sub-tab, Related Patients pane context menu

Option Description

Reload in Current 
Tab

Displays the information for the selected related patient in the currently opened Patient 
tab. 

Open in New Tab Displays the information for the selected related patient in a new Patient tab. The currently 
opened Patient tab remains open, but the focus is changed to a new Patient tab that 
displays the information for the related patient.

Add New 
Relationships

Opens the Add New Patient dialog box so that you can add a relationship to the selected 
related patient. By default, the Is Related to Existing Patient option is selected and 
unavailable. Repeat Step 3 of “To add new patients one at a time” on page 107 as many 
times as needed to add all the necessary patient relationships to the related patient.

Remove Patient’s 
Relationships

Removes all the relationships that have been added for the patient.

Add All to Custom 
Report

Selects all the data that is displayed for all the related patients for inclusion in a custom 
report. See Chapter 10, “Geneticist Assistant Reports,” on page 267.
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Add Comment Opens the Add Comment dialog box. You add a comment for the selected related patient 
in the Add Comment field. The comment is displayed in the Last Comment field in the 
pane. 

Figure 5-13:  Add Comment dialog box

Note: If multiple comments have been added for a related patient, then only the last 
comment added is displayed in the Last Comment field. To see all the comments 
that have been added for a related patient, you must open the related patient in a 
new Patient tab.

Permissions Opens the Permissions dialog box.You use the options on this dialog box to set or modify 
the permissions (Can Read or Can Read and Can Write) that the specified users or groups 
are to have for the patient record. If you are an Administrator user, then you can set or 
modify the permissions for a patient record that any user has added. If you are a standard 
user, then you can set or modify the permissions for only those patient records that you 
have added to the Geneticist Assistant database, or for those patient records that other 
users have added and to which you have been granted Can Read and Can Write 
permissions. See “To set or modify the Read/Write permissions for patient records” on 
page 115.

Load Columns

Manually Opens the Select Columns dialog box in which you can select columns that are to be 
shown and clear the columns that are to be hidden dynamically, or select a configuration 
from the list of available column configurations. This option is also available on the column 
header context menu for the sub-tab.

Note: For information about showing and hiding columns dynamically, see “To show/hide 
columns in a tab pane” on page 37.

Note: If you set column display preferences here, then you can display preferences for 
variants in all the variant sub-tabs and panes (with the exception of the Sample 
Group columns on the Sample Variant Data sub-tab on the Sample tab and the 
Variant pane on the Variant tab) in a single step. See “To apply shared preferences 
or to clear all tab preferences” on page 58.

Compact Displays the data columns on the sub-tab in a more condensed view. To toggle the display, 
click Compact as needed.

Table 5-4: Patient tab, Patient sub-tab, Related Patients pane context menu (Continued)

Option Description
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Patient tab, Patient sub-tab, Comments pane

The Comments pane on the Patient sub-tab shows all the comments that have been added for 
the patient in reverse chronological order. You can right-click in the pane to open a context 
menu with the following options:

<Saved Pane 
Configuration Name> 
- Saved by <User 
Name>

Publicly available pane configurations. The name of the user who created a pane 
configuration is displayed next to the configuration name.

Load Filters

Manually Opens the Filters table for the Related Patients pane. See “To filter the data that is 
displayed in a tab pane” on page 32.

<Filter Template 
Name> - Saved by 
<User Name>

Opens the saved Filter template for the Related Patients pane. Limits the display in the 
pane to only the data (fields) that are defined by the template. See “To filter the data that is 
displayed in a tab pane” on page 32.

Table 5-4: Patient tab, Patient sub-tab, Related Patients pane context menu (Continued)

Option Description

Table 5-5: Patient tab, Patient sub-tab, Comments pane context menu

Option Description

Add Comment Opens the Add Comment dialog box. You add a comment for the selected patient in the 
Add Comment field. The Comments are displayed in reverse chronological order in the 
pane.

Figure 5-14:  Add Comment dialog box
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Delete Comment Opens the Delete Comment dialog box. Click OK to delete the comment for the patient and 
close the dialog box.

Figure 5-15:  Delete Comment dialog box

Load Columns

Manually Opens the Select Columns dialog box in which you can select columns that are to be 
shown and clear the columns that are to be hidden dynamically, or select a configuration 
from the list of available column configurations. This option is also available on the column 
header context menu for the sub-tab.

Note: For information about showing and hiding columns dynamically, see “To show/hide 
columns in a tab pane” on page 37.

Note: If you set column display preferences here, then you can display preferences for 
variants in all the variant sub-tabs and panes (with the exception of the Sample 
Group columns on the Sample Variant Data sub-tab on the Sample tab and the 
Variant pane on the Variant tab) in a single step. See “To apply shared preferences 
or to clear all tab preferences” on page 58.

Compact Displays the data columns on the sub-tab in a more condensed view. To toggle the display, 
click Compact as needed.

<Saved Pane 
Configuration Name> 
- Saved by <User 
Name>

Publicly available pane configurations. The name of the user who created a pane 
configuration is displayed next to the configuration name.

Load Filters

Manually Opens the Filters table for the Comments pan. See “To filter the data that is displayed in a 
tab pane” on page 32.

<Filter Template 
Name> - Saved by 
<User Name>

Opens the saved Filter template for the Comments pane. Limits the display in the pane to 
only the data (fields) that are defined by the template. See “To filter the data that is 
displayed in a tab pane” on page 32.

Table 5-5: Patient tab, Patient sub-tab, Comments pane context menu (Continued)

Option Description
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Patient tab, Patient sub-tab, Reports pane

The Reports pane on the Patient sub-tab lists all the reports that have been generated for the 
selected patient and saved to the Geneticist Assistant database. 

You can right-click a report entry to open a context menu with the following options:

You can also select Reports > Saved Reports on the Geneticist Assistant main 
menu to open a (Patient) Reports tab that includes these same reports.

Table 5-6: Patient tab, Patient sub-tab, Reports pane context menu

Option Description

View Report Opens the Report Browser dialog box, which displays the report in plain text.

Note: You can also double-click the report entry to open the Report Browser dialog box.

Figure 5-16:  Report Browser dialog box

The following options are available for the report:

• View XML - Toggles the onscreen display of the report between XML and plain text.

• Save As - Saves the report as a .csv file. By default, the report is named as <External 
ID>.csv but you can always change the name and you can also select the location in 
which to save the report.

• Print—Prints the onscreen report to a printer of your choice.

Delete Report Deletes the selected report from the Geneticist Assistant database.

Load Columns

Manually Opens the Select Columns dialog box in which you can select columns that are to be 
shown and clear the columns that are to be hidden dynamically, or select a configuration 
from the list of available column configurations. This option is also available on the column 
header context menu for the sub-tab.

Note: For information about showing and hiding columns dynamically, see “To show/hide 
columns in a tab pane” on page 37.

Note: If you set column display preferences here, then you can display preferences for 
variants in all the variant sub-tabs and panes (with the exception of the Sample 
Group columns on the Sample Variant Data sub-tab on the Sample tab and the 
Variant pane on the Variant tab) in a single step. See “To apply shared preferences 
or to clear all tab preferences” on page 58.
126 Geneticist Assistant User’s Manual



Chapter 5
Managing Patients and Runs
Patient tab, Samples sub-tab

The Samples sub-tab on the Patient tab has a single pane, the Samples pane, that displays all 
the samples that are associated with the patient as well as information about the samples. 

Figure 5-17:  Patient tab, Samples sub-tab

You can do the following on the Samples sub-tab:

• View the information for an individual sample.

• View the coverage information for all regions in a sample panel.

• Delete the association between a selected sample and the patient and delete the sample 
from the Geneticist Assistant database.

• Generate a Batch Variants report for the selected sample.

Compact Displays the data columns on the sub-tab in a more condensed view. To toggle the display, 
click Compact as needed.

<Saved Pane 
Configuration Name> 
- Saved by <User 
Name>

Publicly available pane configurations. The name of the user who created a pane 
configuration is displayed next to the configuration name.

Load Filters

Manually Opens the Filters table for the Reports pane. See “To filter the data that is displayed in a 
tab pane” on page 32.

<Filter Template 
Name> - Saved by 
<User Name>

Opens the saved Filter template for the Reports pane. Limits the display in the pane to only 
the data (fields) that are defined by the template. See “To filter the data that is displayed in 
a tab pane” on page 32.

Table 5-6: Patient tab, Patient sub-tab, Reports pane context menu (Continued)

Option Description

For detailed information about generating and saving both standard and custom 
Patient reports, see Chapter 10, “Geneticist Assistant Reports,” on page 267.
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• Generate a Batch Coverage report for the selected sample.

• Add or edit a comment for a sample.

• Set sample permissions.

You can right-click a sample in the Samples pane to open a context menu with the following 
options for working with the sample:

Table 5-7: Patient tab, Samples sub-tab, Samples pane context menu

Option Description

Sample Details Opens the Sample tab, which contains detailed information about the associated sample, 
including the variant list. See Chapter 8, “Geneticist Assistant Data Review - Sample Tab,” 
on page 215.

Note: You can also double-click the sample to open the Sample tab.

Coverage Regions Opens the Coverage Regions tab, which lists the coverage information for every region in 
the panel for the associated sample. See “Coverage Regions tab” on page 192.

Delete Sample Deletes the association between the sample and the patient and removes the sample 
entry from the Samples pane.

Add All to Custom 
Report

Selects all the data that is displayed for all the associated samples in the run for inclusion 
in a custom report. See Chapter 10, “Geneticist Assistant Reports,” on page 267.

Create Batch 
Variants Report

Generates the Batch Variants report for the selected associated sample or samples. 
(Press and hold the CTRL to select multiple samples.) See “To manage a Batch Variants 
report (Samples sub-tab on the Patient tab)” on page 130.

Create Batch 
Coverage Report

Generates the Batch Coverage report for the selected associated sample or samples. 
(Press and hold the CTRL to select multiple samples.) See “To generate a Batch Coverage 
report (Samples sub-tab on the Patient tab)” on page 136.
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Add Comment Opens the Add Sample Comment dialog box. You add a comment for the associated 
sample in the Add Comment field. The comment is displayed in the Comments field in the 
Samples pane.

Figure 5-18:  Add Sample Comment dialog box

Note: If multiple comments have been added for a sample, then these comments are 
displayed in reverse chronological order in the Comments pane on the Sample Data 
sub-tab for the Sample tab. Only the last added comment is displayed in the 
Comments field in the Samples pane on the Samples data sub-tab on the Patient 
tab and in the Samples pane on the Run tab. 

Permissions Opens the Permissions dialog box. You use the options on this dialog box to set or modify 
the permissions (Can Read or Can Read and Can Write) that the specified users or groups 
are to have for the patient sample. If you are an Administrator user, then you can set or 
modify the permissions for a sample in a patient record that any user has added. If you are 
a standard user, then you can set or modify the permissions for samples in only those 
patient records that you have added to the Geneticist Assistant database, or for those 
patient records that other users have added and to which you have been granted Can 
Read and Can Write permissions. See “To set or modify the Read/Write permissions for a 
sample that is associated with a patient” on page 135.

Load Columns

Manually Opens the Select Columns dialog box in which you can select columns that are to be 
shown and clear the columns that are to be hidden dynamically, or select a configuration 
from the list of available column configurations. This option is also available on the column 
header context menu for the sub-tab.

Note: For information about showing and hiding columns dynamically, see “To show/hide 
columns in a tab pane” on page 37.

Note: If you set column display preferences here, then you can display preferences for 
variants in all the variant sub-tabs and panes (with the exception of the Sample 
Group columns on the Sample Variant Data sub-tab on the Sample tab and the 
Variant pane on the Variant tab) in a single step. See “To apply shared preferences 
or to clear all tab preferences” on page 58.

Compact Displays the data columns on the sub-tab in a more condensed view. To toggle the display, 
click Compact as needed.

Table 5-7: Patient tab, Samples sub-tab, Samples pane context menu (Continued)

Option Description
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To manage a Batch Variants report (Samples sub-tab on the Patient tab)

A Batch Variants report is a report that includes information for variants in a selected 
sample, and allows you to save reports for multiple samples in a single step. A Batch 
Variants report configuration determines the data that is to be included in the report. You can 
choose if the configuration is to be available only to the user who created it, or to all users. 
The configuration does not include the report format (PDF, HTML and so on), or the location 
in which the report is to be saved. Instead, you must specify the format and location in which 
to save the report every time you generate a report for a new or saved configuration.

Figure 5-19:  Batch Variants Report dialog box

You can generate a Batch Variants report according to a new or saved configuration, modify 
a Batch Variants report configuration, or delete a Batch Variants report configuration. See:

• “To generate a Batch Variants report based on a new configuration” on page 131.

• “To generate a Batch Variants report based on a saved configuration” on page 132.

• “To modify a Batch Variants report configuration” on page 133.

<Saved Pane 
Configuration Name> 
- Saved by <User 
Name>

Publicly available pane configurations. The name of the user who created a pane 
configuration is displayed next to the configuration name.

Load Filters

Manually Opens the Filters table for the Samples pane. See “To filter the data that is displayed in a 
tab pane” on page 32.

<Filter Template 
Name> - Saved by 
<User Name>

Opens the saved Filter template for the Samples pane. Limits the display in the pane to 
only the data (fields) that are defined by the template. See “To filter the data that is 
displayed in a tab pane” on page 32.

Table 5-7: Patient tab, Samples sub-tab, Samples pane context menu (Continued)

Option Description
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• “To delete a Batch Variants Report configuration” on page 134.

To generate a Batch Variants report based on a new configuration

The name for a Batch Variants report is automatically assigned based on the sample ID 
number and sample name for which you are generating the report (for example, 
76_800458.variants.filter) and you cannot change this. You must select a location in which to 
save the report.

1. If you have not already done so, open the Patient tab.

2. On the Samples sub-tab, select the sample or CTRL-click to select the multiple samples 
for which the Batch Variant report is to be generated.

3. Right-click any selected sample, and on the context menu that opens, click Export > 
Create Batch Variants report.

4. On the Batch Variants Report dialog box, on the Report Type dropdown list, select the 
report type. (The default value is PDF.)

5. If a Batch Variants report has previously been generated and saved, then the location in 
which the report was saved is displayed in the Save To field when the Batch Variants 
Report dialog box opens; otherwise, this field is blank. Do one of the following:

• Leave this location as-is, and then go to Step 6.

• To change this location, then next to the Save To field, click the Browse button , 

and then browse to and select the location in which the report is to be saved.

6. Optionally, to filter the data that is to be displayed in the report, click Filter, and then 
from the Filter dropdown list, select the appropriate pre-configured filter.

7. Optionally, to set the display preferences for the report, do any of the following as 
needed:

• Rearrange the data columns.

• Rename a column header.

• Show/hide columns (manually or by loading a configuration).

8. Optionally, to view an onscreen preview of the report before it is generated and saved, 
click Preview.

     

For detailed information about filtering the data that is displayed in a report, see 
“To filter the data that is displayed in a tab pane” on page 32.

For detailed information about working with data columns, including moving and 
renaming columns, or showing/hiding columns, see “Setting Display Preferences 
in the Geneticist Assistant Main Window” on page 31.
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9. Click OK.

The Batch Variants report is generated for all selected samples. After the report is 
successfully generated, a Batch Variants Report Finished dialog box with a message that 
indicates that the report was generated and where the report was saved.

10. Click OK.

The dialog box closes. You return to a blank Current Jobs tab on the Geneticist Assistant 
main window.

To generate a Batch Variants report based on a saved configuration

1. If you have not already done so, open the Patient tab.

2. On the Samples sub-tab, select the sample or CTRL-click to select the multiple samples 
for which the Batch Variant report is to be generated.

3. Right-click any selected sample, and on the context menu that opens, click Export > 
Create Batch Variants report.

4. On the Batch Variants Report dialog box, select the output format for the report.

5. If a Batch Variants report has previously been generated and saved, then the location in 
which the report was saved is displayed in the Save To field when the Batch Variants 
Report dialog box opens; otherwise, this field is blank. Do one of the following:

• Leave the location as-is, and then go to Step 6.

• To change this location, then next to the Save To field, click the Browse button , 

and then browse to and select the location in which the report is to be saved.

6. Right-click on any heading in the Input Format pane, and then choose Select Columns.

The Select Columns dialog box opens. 

7. Click Load Configuration.

The Load Configuration dialog box opens. The dialog box displays all your private and 
public configurations as well as all the configurations that other users have made public.

Figure 5-20:  Load Configuration dialog box
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8. Select a configuration, and then click Load.

The Load Configuration dialog box closes. The Select Columns dialog box remains 
open. The dialog box now reflects the columns that are to be included in the report based 
on the selected configuration.

9. Click Close (x) to close the Select Columns dialog box.

10. Optionally, to preview an onscreen preview of the report before it is generated and 
saved, click Preview.

11. Click OK.

The Batch Variants report is generated for all selected samples. After the report is 
successfully generated, a Batch Variants Report Finished dialog box with a message that 
indicates that the report was generated and where the report was saved.

12. Click OK.

The dialog box closes. You return to a blank Current Jobs tab on the Geneticist Assistant 
main window.

To modify a Batch Variants report configuration

When you modify a Batch Variants report configuration, any reports that were generated 
according to the “old” (previous) configuration are not affected. Going forward, the report is 
generated based on the “new” configuration. 

1. If you have not already done so, open the Patient tab.

2. On the Samples sub-tab, select the sample or CTRL-click to select the multiple samples 
for which the Batch Variant report is to be generated.

3. Right-click any selected sample, and on the context menu that opens, click Export > 
Create Batch Variants report.

If a Batch Variants report has previously been generated and saved, then the location in 
which the report was saved is displayed in the Save To field when the Batch Variants 
Report dialog box opens; otherwise, this field is blank. 

4. Do one of the following:

• Leave this location as-is, and then go to Step 5.

• To change this location, then next to the Save To field, click the Browse button , 

and then browse to and select the location in which the report is to be saved.

5. Right-click on any heading in the Input Format pane, and then choose Select Columns.

The Select Columns dialog box opens. 

6. To modify the report configuration, see “To create/modify a pane configuration” on page 
39.
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7. Optionally, to preview an onscreen preview of the report before it is generated and 
saved, click Preview.

8. Click OK.

The Batch Variants report is generated for all selected samples. After the report is 
successfully generated, a Batch Variants Report Finished dialog box opens, with a 
message that indicates where the report was saved.

9. Click OK.

The dialog box closes. You return to a blank Current Jobs tab on the Geneticist Assistant 
main window.

To delete a Batch Variants Report configuration

You can delete a Batch Variants report configuration only if you created the report 
configuration. When you delete a Batch Variants report configuration, any reports that were 
generated according to the “old” (previous) configuration are not affected. Going forward, 
the “old” configuration is simply not available for selection.

1. If you have not already done so, open the Patient tab.

2. On the Samples sub-tab, select the sample or CTRL-click to select the multiple samples 
for which the Batch Variant report is to be generated.

3. Right-click any selected sample, and on the context menu that opens, click Export > 
Create Batch Variants report.

4. On the Batch Variants Report dialog box, right-click on any heading in the Input Format 
pane, and then choose Select Columns.

The Select Columns dialog box opens. 

5. See “To delete a pane configuration” on page 41.

6. Click Close (x) to close the Batch Variants Report dialog box.

     

You are not prompted about confirming the deletion of a Batch Variants report 
configuration, so be very sure that the deletion must be deleted before doing so.
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To set or modify the Read/Write permissions for a sample that is associated 
with a patient

1. If you have not already done so, open the Patient tab.

2. On the Samples sub-tab, select the sample or CTRL-click to select the multiple samples 
for which the permissions are being set.

3. Right-click any selected sample, and on the context menu that opens, click Permissions.

The Permissions dialog box opens. 

• The first time that the dialog box opens, if the sample was submitted within a run 
using a Geneticist Assistant version with a build date of 4/8/15 or later, then the 
name of the user who added the sample is displayed in the lower pane of the dialog 
box and both the Can Read and Can Write permissions are selected. If a standard 
user submitted the run, then the Administrator user name is also displayed. 

• For samples that were submitted within a run using earlier versions of Geneticist 
Assistant, the pane is blank. For subsequent openings, the dialog box displays the 
names of all the users and/or groups and their assigned permissions for the sample.

Figure 5-21:  Permissions dialog box (Samples sub-tab on the Patient tab)

4. Modify the permissions for any user or group as needed and then click OK; otherwise, to 
add permissions for a new user or group, go to Step 5.

     

You can add or remove the Can Write permission for a user or group, or you can 
remove both the Can Read and Can Write permissions. Removing the Can Read 
permission but leaving the Can Write permission selected for a user or group has 
no effect.
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5. Enter a user name (the login name for the user), or to assign the same permissions to 
multiple users in a single step, enter a group name.

As you enter a user name or a group name, a dropdown list opens. The list is 
dynamically updated with user names or group names that are in your Geneticist 
Assistant database and that match the search string that you are entering.

6. Select the appropriate user name or group name from the list, and then click Add.

The user name or group name is displayed in the lower pane of the dialog box. The Can 
Read permission is already assigned for the selected user or group. If just this permission 
is selected, then the user or group can view the sample record. They cannot modify it.

7. Optionally, if the user or group must be able to modify the sample record as well, then 
select the Can Write permission.

8. Click OK.

A Permission Updated message opens. 

9. Click OK. 

Both the message and the Permissions dialog box close. The specified permissions are 
set for the sample record.

To generate a Batch Coverage report (Samples sub-tab on the Patient tab)

The Batch Coverage report generates a coverage report for each of the selected samples for 
the patient in a specific panel or panels and panel group. The report also includes coverage 
statistics for the panel that are calculated based on one of the following options: 

• All panel samples.

• Samples that have been added to the panel within the last 30 days of the current day’s date, 
or a custom date range.

• Selected runs for the panel.

• Selected panel samples.

1. If you have not already done so, the Patient tab.

2. On the Samples sub-tab, select the sample or CTRL-click to select the multiple samples 
for which the Batch Coverage report is to be generated.

     

The search string is not case-sensitive, but the string must begin with the user or 
group name. For example, a search string of “Ja” or “ja” returns a user with the 
name of Jane Doe, but a search string of “Doe” does not.
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3. Right-click on any selected sample, and on the context menu that opens, click Export > 
Create Batch Coverage report.

The Batch Coverage Report dialog box opens. All the selected samples for the run are 
displayed in the bottom pane of the dialog box. If multiple samples are selected with 
different panels, then a separate tab is displayed for each panel. 

Figure 5-22:  Batch Coverage Report dialog box (Runs tab)

4. Leave the report type set to the default value of HTML, or select a different report type.

5. Next to the Save To field, click the Browse button  to open the Save To dialog box, 
and then browse to and select the location in which to save the report.

6. To calculate the panel coverage statistics for the report based on all panel samples, click 
OK; otherwise, specify the different options (listed in the table below) by which to 
calculate the panel coverage statistics, and then click OK. 

Option Description

All panel samples 
added between

To specify a custom date range for calculating the panel coverage statistics, 
select added between, and then change one or both dates as needed. To 
change the dates, you can do either of the following:

• You can select any part of the date that you want to change, or the entire 
date, and then manually enter the new value. (The default date range is 
the last 30 days).

• You can select any part of the date that you want to change, and then use 
the Up/Down arrows to change the date accordingly.
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Selected runs To select specific runs for calculating the panel coverage statistics, choose 

Selected runs, and then click the Browse button  that is next to Selected 

runs to open the Select Runs dialog box. By default, all the runs for the panel 
are displayed in the dialog box. Select the appropriate run, or CTRL-click to 
select multiple runs, and then click OK.

Figure 5-23:  Select Runs dialog box

Selected samples To select only specific samples for calculating the panel coverage statistics, 

choose Selected samples and then click the Browse button  that is next 

to Selected samples to open the Select Samples dialog box. By default, all 
the samples for the panel are displayed in the dialog box. Select the 
appropriate sample, or CTRL-click to select multiple samples, and then click 
OK.

Figure 5-24:  Select Samples dialog box

Option Description
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After you click OK to generate the report, the Current Jobs tab opens. The tab displays 
the progress of calculating the coverage information for every sample that was selected 
for the report. A report file is saved in the specified format and the specified location. 

Patient tab, Variants sub-tab

The Variants sub-tab on the Patient tab has a single pane, the Variants pane, that displays all 
the variants in all the samples that are associated with the patient. With the exception of a 
few omitted columns, the information that is available in the Variants pane is identical to the 
information that is available for a variant on the Sample Variant Data sub-tab. (See “Sample 
Variant Data sub-tab” on page 218.) 

Figure 5-25:  Patient tab, Variants sub-tab

You can specify how the information about the variants is to displayed on the Variants sub-
tab. See “To specify variant preferences” on page 60. You can also do the following for an 
individual variant that is displayed on the Variants sub-tab:

• Select a different gene for a variant: If the variant is located where there are overlapping 
genes, then you can select a different gene for the variant on the Gene dropdown list. If 
you select a different gene, then the gene that is used on the current tab for the current 
Geneticist Assistant session is temporarily changed. After you close and then re-open 
Geneticist Assistant, the selected gene is reset to the preferred gene. To permanently 
change the gene that is used for variant, you can add a preferred gene for the panel. See 
“To set or delete a preferred gene for a panel” on page 92.

• Select a different transcript for a variant: You can select a different transcript for the 
variant on the Transcript dropdown list. If you select a different transcript, then the 
transcript that is used on the current tab for the current Geneticist Assistant session is 
temporarily changed. After you close and then re-open Geneticist Assistant, the selected 
transcript is reset to the preferred transcript. 

If the report is to be generated based on only a small number of samples, such as 
two to four, then, before the statistics are calculated, a Very few samples message 
dialog box opens, warning you of this and asking you if you want to continue. You 
can click Yes, or you can click Cancel to return to the Runs tab.
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• Add or edit a comment for a variant: You can single click twice in the Variant Comment 
field to select the current comment in the field and edit it, or if the field is blank, enter a 
new comment. After you add or edit a comment, and then click out of the field, the Update 
Variant Comment dialog box opens. 

Figure 5-26:  Update Variant Comment dialog box

The dialog box displays the variant for which you are adding or editing the comment, the 
current (old) comment, and the new comment. You can make additional edits to the new 
comment needed, and then click OK to close the dialog box and save the new or 
modified comment for the variant.

     

To permanently change the transcript that is used for a gene or genes, you can do 
one of two things: You can right-click the variant, and on the context menu that 
opens, click Edit Variant > Update Preferred Transcript, or you can add a 
preferred transcript list for the panel. See “To set or delete a preferred transcript 
list for a panel” on page 90.

You can also use the Add Variant Comment option that is available on the context 
menu for the variant to add a new variant comment. 
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• Edit the type field, zygosity field, and/or the HGVS information (Genomic, Coding, and/
or Protein) for a variant: You can click once in the Type field, the Zygosity field, the 
HGVS Genomic field, the HGVS Coding field, the HGVS Protein field, and the Read 
Balance field to select the current value in the field and edit it, or if the field is blank, enter 
a new value.

You can right-click a variant on the Variants sub-tab to open a context menu with the 
following options: 

If you make a change to any of these values for the variant, then these changes are 
recorded for the variant on the Variant Changes pane on the Variant tab. See 
“Variant Changes pane” on page 253. These changes are also reflected in the 
appropriate fields on all the variant tabs, sub-tabs, and panes in the Geneticist 
Assistant application.

Table 5-8: Patient tab, Variants sub-tab context menu

Option Description

Variant Details Opens the Variant tab for the selected variant. See “Overview of the Variant Tab” on 
page 247.

Note: You can also double-click the variant to open the Variant tab. 

Show Variants Filtered 
by Panel

Displays all the variants in all the associated samples for the selected patient filtered by 
a selected panel. If you select this option, then the Select Panel to Filter Variants dialog 
box opens. You must select a panel in this dialog box by which to filter the variants for 
the selected patient. 

Figure 5-27:  Select Panel to Filter Variants dialog box

Show Samples with 
Selected Variants

Opens the Samples with variants pane, which displays a list of all the samples in your 
Geneticist Assistant database that contain the selected variant. You can right-click a 
sample in the list to open a context menu with sample-specific options. See “The 
Samples Pane (Run tab) Context Menu” on page 184.
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Edit Variant - Contains all the sub-menu options for editing and deleting a variant.

Add Variant Comment Opens the Add Variant Comment dialog box. You can add a comment for a selected 
variant in the Add Comment field, and then click OK. You can also CTRL-click to select 
multiple variants and add the same comment to all the selected variants in a single 
step. The comment is displayed in the Variant Comment field in the Variants pane on 
the Search Results tab, the Variant Comment field on the Variants sub-tab on the 
Patient tab, the Sample Variant Data sub-tab on the Sample tab, the Variant Comment 
field in the Variant pane on the Variant tab, and the Variant Comments pane on the 
Variant tab.

Figure 5-28:  Add Variant Comment dialog box

Note: If multiple comments have been added for a variant, then with the exception of 
the Variant Comments pane on the Variant tab, only the last added comment is 
displayed in all the locations that are detailed above. All the comments that have 
been added for a variant, including the last added, are displayed in reverse 
chronological order in the Variant Comments pane on the Variant tab.

Table 5-8: Patient tab, Variants sub-tab context menu (Continued)

Option Description
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Update Pathogenicity Opens the Submit Pathogenicity dialog box. You can update the pathogenicity and/or 
pathogenicity status for the selected variant in this dialog box. You can also add a 
comment for the variant. By default, the pathogenicity is always set to an initial value of 
Unassigned. You must review the information for the variant and then decide what the 
pathogenicity should be. After you set the pathogenicity for a variant, the next time that 
the variant is detected in another sample, this is the pathogenicity that is displayed for 
the variant. 

Figure 5-29:  Submit Pathogenicity dialog box

Note: You can also double-click in the Pathogenicity column to open the Submit 
Pathogenicity dialog box. You also CTRL-click to select multiple variants for 
updating the pathogenicities and the pathogenicity statuses at the same time.

Note: You can also update the Pathogenicity and the Pathogenicity Status for a variant 
on the Sample Variant Data sub-tab on the Sample tab.

The following information is relevant to updating the pathogenicity and/or pathogenicity 
status for a variant:

• By default, only five statuses—Deleterious, Likely Deleterious, Unknown, Likely 
Benign, and Benign—are available. You have the option of adding custom 
pathogenicities. See “Managing Objects” on page 49.

• Optionally, you can add supporting information for this pathogenicity change. See 
“To add supporting information for a variant” on page 257.

• You always have the option of updating just the pathogenicity status for a variant at a 
later date. See “Update Pathogenicity Status” below.

Table 5-8: Patient tab, Variants sub-tab context menu (Continued)

Option Description
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Update Pathogenicity 
Status

Opens the Update Variant Pathogenicity Status dialog box. You can update the 
pathogenicity status for the selected variant in this dialog box. You can also add a 
comment for the variant.

Figure 5-30:  Update Variant Pathogenicity Status dialog box

The following information is relevant to updating the pathogenicity status for a variant:

• You can also double-click in the Pathogenicity Status column to open the Update 
Variant Pathogenicity Status dialog box.

• You can CTRL-click to select multiple variants for updating the pathogenicity 
statuses at the same time.

• You can also update the Pathogenicity Status for a variant on the Sample Variant 
Data sub-tab on the Sample tab.

• By default, only two statuses, Pending or Confirmed, are available. You have the 
option of adding custom pathogenicity statuses. See “Managing Objects” on page 
49.

Table 5-8: Patient tab, Variants sub-tab context menu (Continued)

Option Description
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Update Artifact Type Opens the Update Artifact Type dialog box. You specify the artifact type (for example, 
Sequencing) for the variant in this dialog box. If the appropriate artifact type is not 
available, then an option is provided to create a new type.

Figure 5-31:  Update Variant Artifact Type dialog box

When you specify the artifact type, you can set the artifact type as the following:

• Set globally—Selected by default. Set this artifact type for the variant, regardless of 
the sample in which the variant is detected.

• Set for Sample—Set this artifact type for this variant only for the indicated sample.

You also have the option of adding comments for the variant artifact type.

The following information is relevant to updating the artifact type for a variant:

• You can CTRL-click to select multiple variants for updating the artifact type at the 
same time.

• You can also define artifact types and set the artifact type for a variant in the Variants 
pane, on the Variants sub-tab on the Panel Statistics tab from the Runs tab or the 
Run tab, or on the Sample Variant Data sub-tab on the Sample tab.

• By default, only a single artifact type, None, is available. You have the option of 
adding custom artifact types. See “Managing Objects” on page 49.

Table 5-8: Patient tab, Variants sub-tab context menu (Continued)

Option Description
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Update Preferred 
Transcript

Opens the Update Preferred Transcript dialog box. You can select a different preferred 
transcript for the variant on the Change Transcript To dropdown list. 

Figure 5-32:  Update Preferred Transcript dialog box

Note: When you select a different transcript here, then the preferred transcript that is 
used for a gene or genes is permanently changed for the panel. You can also 
permanently change the preferred transcript by adding a preferred transcript list 
for the panel. See “To set or delete a preferred transcript list for a panel” on page 
90. To temporarily change the preferred transcript for a gene or genes, you 
simply select the transcript on the Transcript dropdown list on a tab or sub-tab.

External - Contains all the sub-menu options for viewing the variant in third-party tools.

View in Alamut Opens the variant for viewing in Alamut.

Note: To view a variant in Alamut, your Alamut settings must be specified. See “To 
specify Alamut settings” on page 61.

View in UCSC Opens the variant for viewing in the UCSC Variant Genome Browser. 

Table 5-8: Patient tab, Variants sub-tab context menu (Continued)

Option Description
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View PubMed Abstract Searches PubMed for the variant and displays the appropriate abstract in the PubMed 
window. 

Figure 5-33:  PubMed window

You can do the following for the abstract:

• In the Link field, enter a different PubMed URL, and then click the Go To icon  to 

navigate to abstract.

• Click Save As to save the abstract as a PDF with a name and in a location of your 
choosing.

• Click Print to print the abstract.

Reports - Contains all the sub-menu options for generating a report that includes the variant.

Add Selected Variants to 
Custom Report

Selects all the data that is displayed for the selected variant for inclusion in a custom 
report. CTRL-click to select multiple variants. See Chapter 10, “Geneticist Assistant 
Reports,” on page 267.

Add All Variants to 
Custom Report

Selects all data that is displayed for all the variants for inclusion in a custom report. See 
Chapter 10, “Geneticist Assistant Reports,” on page 267.

Export - Contains all the sub-menu options for exporting a variant.

Export Selected Variants 
to VCF

Exports the selected variants to a VCF file. CTRL-click to select multiple variants. You 
must specify both the file name and the location in which to save the file.

Export All Variants to 
VCF

Exports all the variants to a VCF file. You must specify both the file name and the 
location in which to save the file.

Load Columns

Manually Opens the Select Columns dialog box in which you can select columns that are to be 
shown and clear the columns that are to be hidden dynamically, or select a 
configuration from the list of available column configurations. This option is also 
available on the column header context menu for the sub-tab.

Note: For information about showing and hiding columns dynamically, see “To show/
hide columns in a tab pane” on page 37.

Note: If you set column display preferences here, then you can display preferences for 
variants in all the variant sub-tabs and panes (with the exception of the Sample 
Group columns on the Sample Variant Data sub-tab on the Sample tab and the 
Variant pane on the Variant tab) in a single step. See “To apply shared 
preferences or to clear all tab preferences” on page 58.

Table 5-8: Patient tab, Variants sub-tab context menu (Continued)

Option Description
Geneticist Assistant User’s Manual 147



Chapter 5
Managing Patients and Runs
Compact Displays the data columns on the sub-tab in a more condensed view. To toggle the 
display, click Compact as needed.

<Saved Pane 
Configuration Name> - 
Saved by <User Name>

Publicly available pane configurations. The name of the user who created a pane 
configuration is displayed next to the configuration name.

Load Filters

Manually Opens the Filters table for the Variants pane. See “To filter the data that is displayed in 
a tab pane” on page 32.

<Filter Template Name> 
- Saved by <User 
Name>

Opens the saved Filter template for the Variants pane. Limits the display in the pane to 
only the data (fields) that are defined by the template. See “To filter the data that is 
displayed in a tab pane” on page 32.

Table 5-8: Patient tab, Variants sub-tab context menu (Continued)

Option Description
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Adding a Run
A run refers to loading a BAM file and a VCF file or just a VCF file into Geneticist 
Assistant. for the purposes of importing a list of variants into the Geneticist Assistant 
database and/or reviewing a list of variants. When you add a run, you must specify the run 
and sample settings, which include the chemistry, the instrument, the reference, the panel, 
and the panel group. You must also select the files that are to be loaded. Optionally, you can 
choose to modify the run date/time and/or assign the run to a sample group. You specify 
these settings on a per run basis, or you specify these settings on a per sample basis. At a 
minimum, you must always load a VCF file. Optionally, you can also load a BAM file to 
include coverage information for the panel regions.

To add a run
1. On the Geneticist Assistant main menu, click File > New Run.

The New Run dialog box opens.

Figure 5-34:  New Run dialog box

2. Enter the name for the new run.

     

The name can have a maximum of 255 characters. Spaces are allowed.
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3. Specify the run settings. 

Setting Description

Required Settings

Chemistry If the correct chemistry is not available, then you can add it. Click New 
to open the Add New Chemistry dialog box and add the new chemistry. 

Instrument If the correct instrument is not available, then you can add it. Click New 
to open the Add New Instrument dialog box and add the new 
instrument. 

Reference Files If the correct reference files are not available, then you might need to 
specify the reference directory and/or add the necessary reference files 
to the directory. See “Specifying your Geneticist Assistant Settings” on 
page 53.

Note: SoftGenetics provides the necessary references files for your 
Geneticist Assistant installation. Contact SoftGenetics about 
downloading these files.

Note: This is a run-specific option. You also have the option of setting 
this option on a per sample basis later in the process.

Panel After you select a panel, the panel group is automatically selected and 
the name is displayed in the Panel Group field.

Note: If the correct panel is not available, then you can add it. Click New 
to open the Manage Panels dialog box and import the needed 
panel. See “Importing a Panel” on page 85. 

Note: This is a run-specific option. You also have the option of setting 
this option on a per sample basis later in the process.

Multiple Samples in 
VCF

Select this option if you are loading a VCF file that contains variants 
from multiple samples. 

Optional Settings

Run Date/Time The default value for the Run Date and Time is the current day’s date 
and time, but you can change one or both values as needed. To change 
the value, select the value that is to be changed, for example, the 
month, and then you can manually enter the new value, or you can use 
the Up/Down field arrows to change the value. 

Note: You must select each value that is to be changed one at a time. If 
you set the Run Date/Time here, then this is a run-specific option. 
You also have the option of setting this option on a per sample 
basis later in the process.

User Group By default, non-administrative users have read/write access to only 
those runs that they submitted. If other non-administrator users are to 
have read/write access to this run, then select the appropriate user 
group.
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4. To load your files, do the following:

• Click Select Variant and/or Coverage Files to open the Select Files dialog box. 

• In the Select Files dialog box, browse to and select the BAM coverage file and/or 
variant (VCF) files that are to be loaded, and then click Open. 

When selecting the files that are to be loaded, note the following:

• You can load a VCF or BAM file for a new run that has been submitted previously 
for another run. You can keep the sample name the same, or you can modify the 
sample name as needed.

• You can use the same run name to load additional sample files (BAM and/or VCF) 
for a previously submitted run. The additional sample files are processed and 
appended to the run. 

• At a minimum, you must always load a VCF file. Optionally, you can also load a 
BAM file to include coverage information for the panel regions.

Sample Group Optional. Used for a group of samples that are to be processed 
repeatedly over a period of time, for example, a group of control 
samples for which the coverage or variant frequency is to be tracked. If 
the correct Sample Group is not available, then you can add it. Click 
New to open the Add New Sample Group dialog box and add the new 
sample group.

Note: This is a run-specific option. You also have the option of setting 
this option on a per sample basis later in the process.

Subpanel To verify coverage for a smaller number of regions that are within the 
panel that has been selected for the run, select the appropriate 
subpanel.

Note: If no subpanels have been created for the selected panel, then no 
options are available on the Subpanel dropdown list. For 
information about creating subpanels, see “Adding a Subpanel” 
on page 99.

Identify Patient ID from 
Sample by Separator

Selected by default. If the file names for the loaded sample files contain 
the Patient ID, then define how the Patient ID is separated from the rest 
of the file name, for example, by an underscore (_), a dot (.), and so on. 
This allows each sample to be linked automatically to the corresponding 
patient. If the file names for the loaded sample files do not contain the 
Patient ID, then clear this option.

Import Pathogenicity 
from VCF

Select this option if you are loading a VCF file that contains 
pathogenicity information and you want to import this information into 
the Geneticist Assistant database.

Note: This is a run-specific option. You also have the option of setting 
this option on a per sample basis later in the process.

Submit Hotspots Select to submit any variants that are included in the loaded VCF files 
that have an allele frequency value = 0 to the Geneticist Assistant 
database.

Accepted VCF filters Applicable after you load sample files. See Step 5.

Setting Description
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• If you have a single sample to load, and the VCF and BAM file names do not contain 
corresponding fields in the file names, then select the VCF or BAM file, and then 
after you click Open, the file is placed in the appropriate field for the sample entry. 

You can then click the Browse button  next to the appropriate file type to load 

the corresponding file for the sample. For example, if you loaded a BAM file, then 

you can click the Browse button  next to the Variant File (*.vcf) field for the 

sample entry to load the needed VCF file for the sample.

• If you have multiple samples to load and the VCF and BAM files do not contain 
corresponding fields in the file names, then CTRL-click as you select only the VCF 
files or the BAM files, and then after you click Open, each file is placed in its own 

sample entry. For each sample entry, you can then click the Browse button  next 

to the appropriate file type to load the corresponding file. For example, if you loaded 

a BAM file, then you can click the Browse button  next to the Variant File 

(*.vcf) field for the sample entry to load the needed VCF file for the sample.

• If you are loading both a VCF file and a BAM file, and the files do contain 
corresponding fields in the file names, then CTRL-click as you select both the VCF 
and BAM files, and then after you click Open, both files are loaded into the 
appropriate fields for the same sample entry in a single step. You can load a single 
VCF/BAM file combination this way, or you can load multiple VCF/BAM file 
combinations. Each correspondingly named VCF/BAM file combination is placed in 
its own sample entry.

• If you have multiple BAM files for a sample, you do not need to submit each file as 
an individual sample, and then assign each file to the same patient. Instead, you can 
use the Merge BAM Files tool to merge all the BAM files into one file and then 
submit the file as a single sample. See “Merging BAM Files with the Merge BAM 
Files Tool” on page 288.

• By default, the sample name is set to the VCF file name. The name is displayed at 
the top of the sample entry. You can modify the sample name.

• If you load a sample file in error, then you can right-click the sample name, and then 
click Remove this sample.

After the files are loaded for a sample, the full directory paths (directory and file name) 
for the loaded files are displayed in the appropriate fields for each sample entry at the 
bottom of the New Run dialog box. See Figure 5-35 on page 153.

After you load sample files from a specific directory, if BAM files are included, 
then the BAM files must remain in this directory. You cannot move these BAM files 
to a different directory after you have successfully submitted the files for a run.
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Figure 5-35:  New Run dialog box with loaded sample files

5. After you load your sample files, you can leave Accepted VCF filters set to the default 
value of All, or optionally, you can click Edit to open the Select Accepted Filters dialog 
box, and specify the filters that are available in the loaded VCF file. Only those variants 
with the selected filter values are imported into Geneticist Assistant.

After you select the filters, and then click OK, the Select Accepted Filters dialog box 
closes. The selected filters replace the default value of All. See Figure 5-37 on page 154.

Figure 5-36:  Selected Accepted Filters dialog box

This is a run-specific option. You also have the option of setting this option on a 
per sample basis later in the process.
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Figure 5-37:  Selected filters specified for a VCF file on the New Run dialog box

6. Optionally, for each sample, do any or all of the following as needed:

• Modify the sample name.

• By default, the Reference, Panel, Run Date/Time, Sample Group, and Import 
Pathogenicity from VCF values that are indicated for a sample are the run-specific 
values that you specified in Step 3. You can modify any or all these values on a per 
sample basis. 

• To associate a patient with a sample, select a patient on the Patients dropdown list.

• By default, if you have specified variant filters, then these filters are applied at the 
run level. To edit the accepted variant filters for a sample, click Edit, and then in the 
Select Accepted Filters dialog box, modify the filter selection.

7. Click OK.

The Current Jobs tab opens and a progress bar that shows the progress of loading the 
files is displayed on the Current Jobs tab. After the files are successfully loaded, the 
progress bar is removed from the Current Jobs tab. You return to the Runs tab. The new 
run is displayed on the Runs tab. You can now review the data for the run. See Chapter 6, 
“Geneticist Assistant Data Review - Runs Tab,” on page 155.

You can click Default at any time to return the sample name to its default value.

If you modify the panel on per sample basis, then the panel group might also be 
modified, but you cannot modify the panel group directly.

If the correct patient is not available, then you can click Add New Patient to add 
the patient. See “Adding Patients” on page 107.
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Many options are available from the Runs tab for reviewing your data in Geneticist 
Assistant.

This chapter covers the following topics:

• “Overview of the Runs Tab” on page 157.

• “The Runs Tab Context Menu” on page 159.
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Overview of the Runs Tab
When the Geneticist Assistant main window first opens, the Runs tab is displayed in the 
Geneticist Assistant main window. The Runs tab has a single pane, the Runs pane, that 
displays information about the runs that have been carried out in your Geneticist Assistant 
installation. 

• If you are an Administrator user, then the Runs pane can display all the runs submitted by 
all users to your Geneticist Assistant database. By default, when the tab first opens, only 
the 30 most recently submitted runs are displayed and the runs are sorted based on the Run 
ID. 

• If you are a standard user, then the Runs pane can display all the runs that you have 
submitted to your Geneticist Assistant database as well as all the runs that have been 
submitted by other users and for which you have been granted at least the Can Read 
permission. By default, when the tab first opens, only the 30 most recently added runs that 
fit one of these two criteria are displayed and the runs are sorted based on the Run ID. 

Figure 6-1:  Runs tab

You can do the following on the Runs tab:

• Change the display of the Runs tab. See “To change the Runs tab display” below.

• Modify certain values that are displayed for a run. See “To modify values for a selected 
run” on page 158.

• Open a context menu with a variety of options for working wit h and displaying run-
specific data. See “The Runs Tab Context Menu” on page 159.

To change the Runs tab display
You can do the following for the display on the Runs tab:

• Limit the runs that are displayed by number. The default value is 30.

• Limit the runs that are displayed by a range for the run date and time. The default value 
is the last 30 days, with the ending date/timestamp set to the current day’s date and time.
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To modify values for a selected run
For any run that is displayed on the Runs tab, you can:

• Click in any of the following fields—Name or Run Date/Time—to select the current 
value, and modify it as necessary, and then click out of the field.

• Select a different Chemistry and/or Instrument for the run. 

After you modify the value for Name or Run Date/Time and click out of the field, or 
select a different chemistry or instrument for the run, an Edit Run dialog box opens. The 
dialog box displays the name of the run for which you are editing a value, the current 
(old) run value, and the new run value. You can make any further changes to the new run 
value as needed, and then click OK to close the dialog box, and save the new value for 
the run.

Figure 6-2:  Edit Run dialog box

• Set the status for the run. When a run is first submitted, the status is set to New. You can 
change the status from New to one of three default values (QC Passed, Reviewed, or 
Complete) for the run, or if custom values have been added for the run, then you can also 
select one of these values. 

For information about adding a custom value, see “Managing Objects” on page 
49.
158 Geneticist Assistant User’s Manual



Chapter 6
Geneticist Assistant Data Review - Runs Tab
The Runs Tab Context Menu
You can right-click any run entry on the Runs tab to open a context menu with the following 
options:

Table 6-1: Runs tab, Runs pane context menu

Option Description

Run Details Opens the Run tab. See Chapter 7, “Geneticist Assistant Data Review - Run Tab,” on page 
179.

Note: You can also double-click a run entry to open the Run tab.

Add All to Custom 
Report

Selects all the data that is displayed for the run for inclusion in a custom report. See 
Chapter 10, “Geneticist Assistant Reports,” on page 267.

Compare Samples Applicable only for runs with two or more samples. Opens the Sample Comparison dialog 
box. You use the options on this dialog box to compare the coverage, frequency, and read 
balance information for each sample that is being compared. See “To compare all the 
samples within a run from the Runs tab” on page 161.

Panel Statistics Opens the Panel Statistics tab. The tab has options for displaying specific information 
based on the panel that was used for the run. See “To calculate panel statistics (Runs tab)” 
on page 163.

Permissions Opens the Permissions dialog box.You use the options on this dialog box to set or modify 
the permissions (Can Read or Can Read and Can Write) that the specified users or groups 
are to have for the run. If you are an Administrator user, then you can set or modify the 
permissions for a run that any user has submitted. If you are a standard user, then you can 
set or modify the permissions for only those runs that you have submitted to the Geneticist 
Assistant database, or for those runs that other users have submitted and to which you 
have been granted Can Read and Can Write permissions. See “To set or modify the Read/
Write permissions for a run” on page 168.

Edit Run

Add Samples to Run Opens the New Run dialog box so that you can add more samples to the selected run. 
See “Adding a Run” on page 149.
Geneticist Assistant User’s Manual 159



Chapter 6
Geneticist Assistant Data Review - Runs Tab
Set Subpanels of 
Selected Runs

Applicable only if you select a run for which a subpanel was not selected during the setup 
of the run. CTRL-click to select multiple runs. If you select multiple runs, then all the runs 
must use the same panel. Opens the Select a Subpanel dialog box. The dialog box 
displays the samples and the panel for the selected runs and a Subpanel dropdown list 
with all the available subpanels. 

Figure 6-3:  Set Sample Subpanel dialog box

Select a different subpanel on the Subpanel dropdown list, and then click OK. The 
subpanel is applied to all the samples in all the selected runs.

Delete Run Delete the selected run from the Geneticist Assistant database.

Exports

Export to VCF Exports all the variants in the selected run to a VCF file. You must specify both the file 
name and the location in which to save the file.

Save Sample 
Reports

Applicable for one or more runs. CTRL-click to select multiple runs. Generates an 
individual sample report for each sample in all the selected runs. You must specify a 
location in which to save the reports. Each report is named the same as the sample and 
the report format is HTML, and you cannot change either of these values. 

Note: For more information about standard reports, see Chapter 10, “Geneticist Assistant 
Reports,” on page 267.

Create Batch 
Variants Report

Opens the Batch Variants Report dialog box for generating the Batch Variants report for all 
the samples in a selected run. See “To manage a Batch Variants report (Runs tab)” on 
page 170.

Create Batch 
Coverage Report

Opens the Batch Coverage Report dialog box for generating the Batch Coverage report for 
all the samples in the selected run or runs. See “To generate a Batch Coverage report 
(Runs tab)” on page 175.

Table 6-1: Runs tab, Runs pane context menu (Continued)

Option Description
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To compare all the samples within a run from the Runs tab

1. Right-click the appropriate run on the Runs tab, and on the context menu that opens, 
click Compare Samples.

The Sample Comparison dialog box opens. All the samples for the run are displayed in 
the dialog box. See Figure 6-4 on page 162.

Load Columns

Manually Opens the Select Columns dialog box in which you can select columns that are to be 
shown and clear the columns that are to be hidden dynamically, or select a configuration 
from the list of available column configurations. This option is also available on the column 
header context menu for the sub-tab.

Note: For information about showing and hiding columns dynamically, see “To show/hide 
columns in a tab pane” on page 37.

Note: If you set column display preferences here, then you can display preferences for 
variants in all the variant sub-tabs and panes (with the exception of the Sample 
Group columns on the Sample Variant Data sub-tab on the Sample tab and the 
Variant pane on the Variant tab) in a single step. See “To apply shared preferences 
or to clear all tab preferences” on page 58.

Compact Displays the data columns on the sub-tab in a more condensed view. To toggle the display, 
click Compact as needed.

<Saved Pane 
Configuration Name> 
- Saved by <User 
Name>

Publicly available pane configurations. The name of the user who created a pane 
configuration is displayed next to the configuration name.

Load Filters

Manually Opens the Filters table for the Runs pane. See “To filter the data that is displayed in a tab 
pane” on page 32.

<Filter Template 
Name> - Saved by 
<User Name>

Opens the saved Filter template for the Run pane. Limits the display in the pane to only the 
data (fields) that are defined by the template. See “To filter the data that is displayed in a 
tab pane” on page 32.

Table 6-1: Runs tab, Runs pane context menu (Continued)

Option Description

To compare only selected samples within a run, see “To compare selected sample 
data for a run from the Run tab” on page 188.
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Figure 6-4:  Sample Comparison dialog box

2. Set the comparison parameters.

     

Option Description

Show columns The data columns that are displayed for each sample on the Sample 
Comparison tab. Allele Frequency (AF) is always displayed and you 
cannot change this option. Coverage (Cov) is displayed by default, but 
you can clear this selection. Read Balance (RB) is not displayed by 
default, but you can select this option.

Filter variants by panel Limits the variants that are displayed on the Sample Comparison tab to 
only those variants that are contained within the selected panel.

Shared by Limits the variants that are displayed on the Sample Comparison tab to 
only those variants that meet the required number of samples as 
specified by the operator that is selected on the dropdown list (>, <. or =) 
and the number of samples. If a variant is found in a number of samples 
that does not meet this criteria, then the variant is not displayed in the 
results.

AF difference Limits the variants that are displayed on the Sample Comparison tab to 
only those variants that have a difference in allele frequency as 
specified by the operator that is selected on the dropdown list (>, <. or =) 
and the number of samples. If a variant is found with an allele frequency 
difference that does not meet this criteria, then the variant is not 
displayed in the results. 

• Exclude missing 
variants 

Selected by default. Regardless of the allele frequency difference, 
always display variants that are not found in one or more samples.

AF between Limits the variants that are displayed on the Sample Comparison tab to 
only those variants with an allele frequency that falls within the indicated 
range in at least one of the compared samples.
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3. Click OK.

The Sample Comparison dialog box closes. The Sample Comparison results are 
displayed on the Sample Comparison tab. A distinct gray vertical line separates the two 
sides of the tab. The left side of the tab shows the sample-specific information for each 
variant, with each sample identified as 1, 2, and so on. If you hover your cursor over the 
column heading, then the full sample name is displayed. The right side of the tab shows 
the variant details. 

Figure 6-5:  Sample Comparison tab

To calculate panel statistics (Runs tab)
The Panel Statistics tab has options for displaying specific information based on a selected 
panel and panel group as well as any or all of the following criteria: 

• All panel samples.

• Samples that have been added to the panel within the last 30 days of the current day’s date, 
or a custom date range.

• Selected runs for the panel.

• Selected panel samples.

To display data on the Panel Statistics tab

1. Select the appropriate run, or CTRL-click to select multiple runs on the Runs tab.

2. Right-click any selected run, and on the context menu that opens, click Panel Statistics. 

If you select multiple runs for different panels, then a Select Panel dialog box 
opens. You must first select the appropriate panel before the statistics can be 
calculated.
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The Panel Statistics tab opens. The Coverage Regions sub-tab is the open tab. The panel 
and panel group that were used for the run are selected. You can select a different panel 
from the Panel dropdown list to view statistics for a different panel. You can also select a 
different panel to change the panel group, but you cannot change the panel group 
directly. By default, the statistics are calculated for all the samples in the selected run 
that have been added to the panel. 

Figure 6-6:  Coverage Regions sub-tab (Panel Statistics tab)

3. Optionally, modify any or all of the calculation criteria as needed, and then click OK to 
recalculate the panel statistics and update the display accordingly. 

If the run contains a small number of samples, such as two to four, then, by 
default, the panel statistics are calculated based only on the samples for the run. 
Before the statistics are calculated, a Very few samples message dialog box opens, 
warning you of this and asking you if you want to continue. You can click Yes, or 
you can click Cancel to return to the Runs tab.

Option Description

All panel samples If you select this option, then all samples that have been added to the panel 
are displayed. To specify a custom date range, select added between, and 
then change one or both dates as needed. To change the dates, you can do 
either of the following:

• You can select any part of the date that you want to change, or the entire 
date, and then manually enter the new value. (The default date range is 
the last 30 days).

• You can select any part of the date that you want to change, and then use 
the Up/Down arrows to change the date accordingly.
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4. Optionally, after calculating the panel statistics, continue to any of the following needed 
to view information on any of the five sub-tabs that are available for the Panel Statistics 
tab:

• Coverage Regions sub-tab. See “Coverage Regions sub-tab (Panel Statistics tab)” on 
page 166.

• Samples sub-tab. See “Samples sub-tab (Panel Statistics tab)” on page 166.

• Variants sub-tab. See “Variants sub-tab (Panel Statistics tab)” on page 167.

Selected runs Selected by default. To select specific runs for the panel, choose Selected 

runs, and then click the Browse button  that is next to Selected runs to 

open the Select Runs dialog box. All the runs for the selected panel are 
displayed in the dialog box. Select the appropriate run, or CTRL-click to select 
multiple runs, and then click OK.

Figure 6-7:  Select Runs dialog box

Selected samples To select only specific samples for the panel, choose Selected samples and 

then click the Browse button  that is next to Selected samples to open 

the Select Samples dialog box. All the samples for the selected panel are 
displayed in the dialog box. Select the appropriate sample, or CTRL-click to 
select multiple samples, and then click OK.

Figure 6-8:  Select Samples dialog box

Option Description
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• Patients sub-tab. See “Patients sub-tab (Panel Statistics tab)” on page 167.

• Reports sub-tab. See “Reports sub-tab (Panel Statistics tab)” on page 168.

Coverage Regions sub-tab (Panel Statistics tab)

The Coverage Regions sub-tab has a single pane, the Coverage Regions pane, that lists by 
default, the coverage information across all the samples for the selected run or runs for every 
region in the selected panel and panel group. See “Coverage Regions tab” on page 192 for a 
detailed discussion of the information that is displayed on this sub-tab.

Figure 6-9:  Coverage Regions sub-tab (Panel Statistics tab)

Samples sub-tab (Panel Statistics tab)

The Samples sub-tab has a single pane, the Samples pane, that lists by default, all the 
samples that were imported in the selected run or runs for the selected panel and panel group. 
You can double-click a sample on this sub-tab to open the Sample tab. (See Chapter 8, 
“Geneticist Assistant Data Review - Sample Tab,” on page 215.) You can also right-click a 
sample on the sub-tab to open a context menu that has options that are identical to options 
that are on the context menu for the Samples pane on the Run tab. See “The Samples Pane 
(Run tab) Context Menu” on page 184.

Figure 6-10:  Panel Statistics tab, Samples sub-tab
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Variants sub-tab (Panel Statistics tab)

The Variants sub-tab has a single pane, the Variants pane, that lists by default, all the variants 
that were detected in all the samples that were imported in the selected run or runs for the 
selected panel and panel group. The information that is displayed on this sub-tab is identical 
to the information that is displayed on the Variants sub-tab on the Patient tab. You can 
double-click a variant on this sub-tab to open the Variant tab. (See Chapter 9, “Geneticist 
Assistant Data Review - Variant Tab,” on page 245.) You can also right-click a variant on 
this sub-tab to open a context menu that has options that are identical to options that are on 
the context menu for the variant on the Sample Variant Data sub-tab. (See “Sample Variant 
Data sub-tab” on page 218.) 

Figure 6-11:  Panel Statistics tab, Variants sub-tab

Patients sub-tab (Panel Statistics tab)

The Patients sub-tab has a single pane, the Patients pane, that lists by default, all the patients 
who were associated with all the samples for the selected run or runs that were imported for 
the selected panel and panel group. You can double-click a patient in the pane to open the 
corresponding Patient tab. You can also right-click a patient on this sub-tab to open a context 
menu with options that are identical to options that are on the context menu for the Patients 
tab. See “Accessing and Reviewing Patient Records” on page 112.

Figure 6-12:  Panel Statistics tab, Patients sub-tab
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Reports sub-tab (Panel Statistics tab)

The Reports sub-tab contains a single pane, the Reports pane, that lists by default, all the 
reports that were generated for the selected run or runs for the selected panel/panel group and 
saved to the Geneticist Assistant database. 

Figure 6-13:  Panel Statistics tab, Reports sub-tab

You can right-click anywhere on this sub-tab to open a context menu with options that are 
identical to the options that are on context menu for the Reports pane on the Patient sub-tab 
on the Patient tab. See “Patient tab, Patient sub-tab, Reports pane” on page 126.

To set or modify the Read/Write permissions for a run 
1. If you have not already done so, open the Runs tab.

2. Select the run, or CTRL-click to select the multiple runs for which the permissions are 
being set.

3. Right-click any selected run, and on the context menu that opens, click Permissions.

The Permissions dialog box opens. See Figure 6-14 on page 169.

     

You can also select Reports > Saved Reports on the Geneticist Assistant main 
menu to open a Reports tab that includes these same reports.

For detailed information about generating and saving Panel Statistics reports, see 
Chapter 10, “Geneticist Assistant Reports,” on page 267.
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• The first time that the dialog box opens, if any run was submitted using a Geneticist 
Assistant version with a build date of 4/8/15 or later, then the names of the users who 
submitted the runs are displayed in the lower pane of the dialog box and both the 
Can Read and Can Write permissions are selected. If a standard user submitted any 
run, then the Administrator user name is also displayed.

• For runs that were submitted using earlier versions of Geneticist Assistant, the pane 
is blank. For subsequent openings, the dialog box displays the names of all the users 
and/or groups and their assigned permissions for the runs.

Figure 6-14:  Permissions dialog box (Runs tab)

4. Modify the Read and Write run permissions for any user or group as needed and then go 
to Step 8; otherwise, to add run permissions for a new user or group, go to Step 5.

5. Enter a user name (the login name for the user), or to assign the same permissions to 
multiple users in a single step, enter a group name.

As you enter a user name or a group name, a dropdown list opens. The list is 
dynamically updated with user names or group names that are in your Geneticist 
Assistant database and that match the search string that you are entering.

     

You can add or remove the Can Write permission for a user or group, or you can 
remove both the Can Read and Can Write permissions. Removing the Can Read 
permission but leaving the Can Write permission selected for a user or group has 
no effect.

The search string is not case-sensitive, but the string must begin with the user or 
group name. For example, a search string of “Ja” or “ja” returns a user with the 
name of Jane Doe, but a search string of “Doe” does not.
Geneticist Assistant User’s Manual 169



Chapter 6
Geneticist Assistant Data Review - Runs Tab
6. Select the appropriate user name or group name from the list, and then click Add.

The user name or group name is displayed in the lower pane of the dialog box. The Read 
permission is already assigned for the selected user or group. If just this permission is 
selected, then the user or group can simply view the run. They cannot modify it.

7. Optionally, if the user or group must be able to modify the run as well, then select the 
Can Write permission.

8. Optionally, if all users and groups are to have their same run permissions applied to all 
the samples in all the selected runs, then select Apply the permission settings to 
Samples; otherwise, leave this option cleared, or clear it if necessary.

9. Click OK.

A Permission Updated message opens. 

10. Click OK. 

Both the message and the Permissions dialog box close. The specified permissions are 
set for the runs.

To manage a Batch Variants report (Runs tab)
A Batch Variants report is a report that includes information for variants in a selected 
sample, and allows you to create multiple reports for multiple samples in a single step. If you 
generate a Batch Variants report from the Runs tab, then a separate report is saved for each 
sample of the selected run. A Batch Variants report configuration determines the data that is 
to be included in the report. You choose if the configuration is to be available only to the user 
who created it, or to all users. The configuration does not include the report format (PDF, 
HTML and so on), or the location in which the report is to be saved. Instead, you must 
specify the format and location in which to save the report every time you generate a report 
for a new or saved configuration. You can generate a Batch Variants report according to a 
new or saved configuration, modify a Batch Variants report configuration, or delete a Batch 
Variants report configuration. See:

• “To generate a Batch Variants report based on a new configuration” on page 171.

• “To generate a Batch Variants report based on a saved configuration” on page 172.

• “To modify a Batch Variants report configuration” on page 174.

• “To delete a Batch Variants Report configuration” on page 175.

You can assign Read and Write permissions for the samples in a run on a per 
sample basis. See “To set or modify the Read/Write permissions for the samples in 
a run on a per sample basis” on page 202.
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Figure 6-15:  Batch Variants Report dialog box

To generate a Batch Variants report based on a new configuration

The name for a Batch Variants report is automatically assigned based on the sample ID 
number and sample name for the first sample in the list of samples for which you are 
generating the report (for example, 76_800458.variants.filter) and you cannot change this. 
You must select a location in which to save the report.

1. If you have not already done so, open the Runs tab.

2. Select the run or CTRL-click to select the multiple runs for which the Batch Variant 
report is to be generated.

3. Right-click any selected run, and on the context menu that opens, click Export > Create 
Batch Variants report.

4. On the Batch Variants Report dialog box, on the Report Type dropdown list, select the 
report type. (The default value is PDF.)

5. If a Batch Variants report has previously been generated and saved, then the location in 
which the report was saved is displayed in the Save To field when the Batch Variants 
Report dialog box opens; otherwise, this field is blank. Do one of the following:

• Leave this location as-is, and then go to Step 6.

• To change this location, then next to the Save To field, click the Browse button , 

and then browse to and select the location in which the report is to be saved.

     

To generate the report for all variants in only selected samples for the run, see “To 
manage a Batch Variants report (Run tab)” on page 204.
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6. Optionally, to filter the data that is to be displayed in the report, click Filter, and then 
from the Filter dropdown list, select the appropriate pre-configured filter.

7. Optionally, to set the display preferences for the report, do any of the following as 
needed:

• Rearrange the data columns.

• Rename a column header.

• Show/hide columns (manually or by loading a configuration).

8. Optionally, to view an onscreen preview of the report before it is generated and saved, 
click Preview.

9. Click OK.

The Batch Variants report is generated for each of the samples in the selected run. After 
the report is successfully generated, a Batch Variants Report Finished dialog box with a 
message that indicates that the report was generated and where the report was saved.

10. Click OK.

The dialog box closes. You return to a blank Current Jobs tab on the Geneticist Assistant 
main window.

To generate a Batch Variants report based on a saved 
configuration

1. If you have not already done so, open the Runs tab.

2. Select the run or CTRL-click to select the multiple runs for which the Batch Variant 
report is to be generated.

3. Right-click any selected run, and on the context menu that opens, click Export > Create 
Batch Variants report.

4. On the Batch Variants Report dialog box, select the output format for the report.

     

For detailed information about filtering the data that is displayed in a report, see 
“To filter the data that is displayed in a tab pane” on page 32.

For detailed information about working with data columns, including moving and 
renaming columns, or showing/hiding columns, see “Setting Display Preferences 
in the Geneticist Assistant Main Window” on page 31.
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5. If a Batch Variants report has previously been generated and saved, then the location in 
which the report was saved is displayed in the Save To field when the Batch Variants 
Report dialog box opens; otherwise, this field is blank. Do one of the following:

• Leave the location as-is, and then go to Step 6.

• To change this location, then next to the Save To field, click the Browse button , 

and then browse to and select the location in which the report is to be saved.

6. Right-click on any heading in the Input Format pane, and then choose Select Columns.

The Select Columns dialog box opens. 

7. Click Load Configuration.

The Load Configuration dialog box opens. The dialog box displays all your private and 
public configurations as well as all the configurations that other users have made public. 

Figure 6-16:  Load Configuration dialog box

8. Select a configuration, and then click Load.

The Load Configuration dialog box closes. The Select Columns dialog box remains 
open. The dialog box now reflects the columns that are to be included in the report based 
on the selected configuration.

9. Click Close (x) to close the Select Columns dialog box.

10. Optionally, to preview an onscreen preview of the report before it is generated and 
saved, click Preview.

11. Click OK.

The Batch Variants report is generated for for each of the samples in the selected run. 
After the report is successfully generated, a Batch Variants Report Finished dialog box 
with a message that indicates that the report was generated and where the report was 
saved.

12. Click OK.

The dialog box closes. You return to a blank Current Jobs tab on the Geneticist Assistant 
main window.
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To modify a Batch Variants report configuration

When you modify a Batch Variants report configuration, any reports that were generated 
according to the “old” (previous) configuration are not affected. Going forward, the report is 
generated based on the “new” configuration. 

1. If you have not already done so, open the Runs tab.

2. Select the run or CTRL-click to select the multiple runs for which the Batch Variant 
report is to be generated.

3. Right-click any selected run, and on the context menu that opens, click Export > Create 
Batch Variants report.

4. If a Batch Variants report has previously been generated and saved, then the location in 
which the report was saved is displayed in the Save To field when the Batch Variants 
Report dialog box opens; otherwise, this field is blank. 

5. Do one of the following:

• Leave this location as-is, and then go to Step 6.

• To change this location, then next to the Save To field, click the Browse button , 

and then browse to and select the location in which the report is to be saved.

6. Right-click on any heading in the Input Format pane, and then choose Select Columns.

The Select Columns dialog box opens. 

7. To modify the report configuration, see “To create/modify a pane configuration” on page 
39.

8. Optionally, to preview an onscreen preview of the report before it is generated and 
saved, click Preview.

9. Click OK.

The Batch Variants report is generated for each of the samples in the selected run. After 
the report is successfully generated, a Batch Variants Report Finished dialog box opens, 
with a message that indicates where the report was saved.

10. Click OK.

The dialog box closes. You return to a blank Current Jobs tab on the Geneticist Assistant 
main window.
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To delete a Batch Variants Report configuration

You can delete a Batch Variants report configuration only if you created the report 
configuration. When you delete a Batch Variants report configuration, any reports that were 
generated according to the “old” (previous) configuration are not affected. Going forward, 
the “old” configuration is simply not available for selection.

1. If you have not already done so, open the Runs tab.

2. Select the run or CTRL-click to select the multiple runs for which the Batch Variant 
report is to be generated.

3. Right-click any selected run, and on the context menu that opens, click Export > Create 
Batch Variants report.

4. On the Batch Variants Report dialog box, right-click on any heading in the Input Format 
pane, and then choose Select Columns.

The Select Columns dialog box opens. 

5. See “To delete a pane configuration” on page 41.

6. Click Close (x) to close the Batch Variants Report dialog box.

To generate a Batch Coverage report (Runs tab)
The Batch Coverage report saves a coverage report for each of the samples for a selected run 
or runs in a specific panel or panels and panel group. The report also includes coverage 
statistics for the panel that are calculated based on one of the following options: 

• All panel samples.

• Samples that have been added to the panel within the last 30 days of the current day’s date, 
or a custom date range.

• Selected runs for the panel.

• Selected panel samples.

1. If you have not already done so, open the Runs tab.

2. Select a single run, or CTRL-click to select multiple runs.

3. Right-click on any selected run, and on the context menu that opens, click Export > 
Create Batch Coverage report.

The Batch Coverage Report dialog box opens. All the samples in the selected run are 
displayed in the bottom pane of the dialog box. If multiple runs are selected with 
different panels, then a separate tab is displayed for each panel. See Figure 6-17 on page 
176.

You are not prompted about confirming the deletion of a Batch Variants report 
configuration, so be very sure that the deletion must be deleted before doing so.
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Figure 6-17:  Batch Coverage Report dialog box (Runs tab)

4. Leave the report type set to the default value of HTML, or select a different report type.

5. Next to the Save To field, click the Browse button  to open the Save To dialog box, 
and then browse to and select the location in which to save the reports.

6. To calculate the panel coverage statistics for the report based on all panel samples, click 
OK; otherwise, specify the different options (listed in the table below) by which to 
calculate the panel coverage statistics, and then click OK. 

Option Description

All panel samples 
added between

To specify a custom date range for calculating the panel coverage statistics, 
select added between, and then change one or both dates as needed. To 
change the dates, you can do either of the following:

• You can select any part of the date that you want to change, or the entire 
date, and then manually enter the new value. (The default date range is 
the last 30 days).

• You can select any part of the date that you want to change, and then use 
the Up/Down arrows to change the date accordingly.
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Selected runs To select specific runs for calculating the panel coverage statistics, choose 

Selected runs, and then click the Browse button  that is next to Selected 

runs to open the Select Runs dialog box. All the runs for the panel are 
displayed in the dialog box. Select the appropriate run, or CTRL-click to select 
multiple runs, and then click OK.

Figure 6-18:  Select Runs dialog box

Selected samples To select only specific samples for calculating the panel coverage statistics, 

choose Selected samples and then click the Browse button  that is next 

to Selected samples to open the Select Samples dialog box. All the samples 
for the panel are displayed in the dialog box. Select the appropriate sample, 
or CTRL-click to select multiple samples, and then click OK.

Figure 6-19:  Select Samples dialog box

Option Description
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After you click OK to generate the report, the Current Jobs tab opens. The tab displays 
the progress of calculating the coverage information for every sample that was selected 
for the report. A report file is saved for each sample in the selected run or runs in the 
specified format and the specified location. 

If the panel coverage statistics are to be calculated based on only a small number 
of samples, such as two to four, then, before the statistics are calculated, a Very 
few samples message dialog box opens, warning you of this and asking you if you 
want to continue. You can click Yes, or you can click Cancel to return to the Runs 
tab.
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Many options are available from the Run tab for reviewing your data in Geneticist Assistant.

This chapter covers the following topics:

• “Overview of the Run Tab” on page 181.

• “Samples pane (Run tab)” on page 182.

• “Coverage Regions tab” on page 192.

• “The Samples Pane (Run tab) Context Menu” on page 184.

• “Run’s Status Changes pane” on page 212.

• “Reports pane (Run tab)” on page 213.
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Overview of the Run Tab
The Run tab displays information for a run that was selected on the Runs tab. To open the 
Run tab, do one of the following:

• Right-click a run on the Runs tab, and on the context menu that opens, select Run Details.

• Double-click a run on the Runs tab. 

Figure 7-1:  Run tab

The Run tab has three panes. From top to bottom, these three panes are the following:

• The Samples pane. See “Samples pane (Run tab)” below.

• The Run’s Status Changes pane. See “Run’s Status Changes pane” on page 212.

• The Reports pane. See “Reports pane (Run tab)” on page 213.
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Samples pane (Run tab)
The Samples pane on the Run tab displays an entry for each sample (VCF/BAM file 
combination or single VCF file) that was loaded for the run. The following options are 
available for a sample in the Samples pane on the Run tab:

• Setting the sample status. See “To set the sample status” on page 182.

• Determining missed clinical variants. See “To determine missed clinical variants for a 
sample” on page 183.

• Using the context menu. See “The Samples Pane (Run tab) Context Menu” on page 184.

To set the sample status
By default, after a sample is initially submitted, the status of the sample is set to New on the 
Run tab. 

1. If you have not done so already, open the Run tab. (See “Overview of the Run Tab” on 
page 181.)

2. On the Samples pane, on the Status dropdown list, select a different status for the 
sample.

The Update Sample Status dialog box opens. The dialog box displays the Current status 
and the New status, which is the status that you are changing the sample to.

Figure 7-2:  Update Sample Status dialog box

3. Optionally, in the Comment field, enter an explanation/reason for changing the sample 
status.

The status change and the comment for the status change are displayed in the Status 
Changes pane on the Sample tab. See “Status Changes pane” on page 238.

     

You can select a different value from one of the available default values (New, QC 
Passed, Reviewed, or Complete), or if needed, you can create custom statuses, and 
then select one of these custom statuses instead. See “Managing Objects” on page 
49. 
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4. Click OK.

The Update Sample Status dialog box closes. The Run tab remains open. The newly 
selected sample status is displayed in the Status field on the tab.

To determine missed clinical variants for a sample
If any of the clinically relevant positions that are identified in the Clinical Variants (ClinVar) 
database from NCBI within the panel regions do not have coverage in the samples, then 
“Yes” is displayed in the Missed Clinical Variants column in the Samples pane on the Run 
tab; otherwise, “No” is displayed. 
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The Samples Pane (Run tab) Context Menu
You can right-click a sample (CTRL-click to select multiple samples) in the Samples pane on 
the Run tab to open a context menu with the following options:

Table 7-1: Run tab, Samples pane context menu

Option Description

Compare Samples Displayed only after two or more samples are selected. Opens the Sample Comparison 
dialog box. You use the options on this dialog box to compare the coverage, frequency, 
and read balance information for each sample that is being compared. See “To compare 
selected sample data for a run from the Run tab” on page 188.

Family Comparison Displayed only if three or more samples are selected. At a minimum, you must select two 
parent samples and one child sample. You can always select more than one child sample. 
Opens the Family Comparison dialog box, in which you can specify the options to compare 
the variant calls in family (relation and phenotype) data. See “To compare family data” on 
page 190.

Sample Details Displayed only if a single sample is selected. Opens the Sample tab, which contains 
detailed information about the sample, including the variant list. See Chapter 8, “Geneticist 
Assistant Data Review - Sample Tab,” on page 215.

Coverage Regions Displayed only if a single sample is selected. Opens the Coverage Regions tab, which lists 
the coverage information for every region in your panel. The Status indicates whether the 
region passed or failed the Quality Control (coverage) settings that were set for the run. 
See “Coverage Regions tab” on page 192.

Panel Statistics Opens the Panel Statistics tab. The tab has options for displaying specific information for 
the panel that was used for the run. See “To calculate panel statistics (Run tab)” on page 
197.

Add All to Custom 
Report

Selects all the data that is displayed for all the samples in the run for inclusion in a custom 
report. See Chapter 10, “Geneticist Assistant Reports,” on page 267.

Show Sample 
Variants Filtered by 
Panel

Displays all the variants in the selected sample filtered by a selected panel. If you select 
this option, then the Select Panel to Filter Variants dialog box opens. You must select a 
panel in this dialog box by which to filter the variants for the selected run.

Figure 7-3:  Select Panel to Filter Variants dialog box

Permissions Opens the Permissions dialog box.You use the options on this dialog box to set or modify 
the permissions (Can Read or Can Read and Can Write) that the specified users or groups 
are to have for the sample. If you are an Administrator user, then you can set or modify the 
permissions for any sample in any run that any user has submitted. If you are a standard 
user, then you can set or modify the permissions for only those samples that are contained 
in runs that you have submitted to the Geneticist Assistant database, or for those samples 
that are contained in runs that were submitted by other users and to which you have been 
granted Can Read and Can Write permissions. See “To set or modify the Read/Write 
permissions for the samples in a run on a per sample basis” on page 202.
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Edit Sample

Add Comment Opens the Add Sample Comment dialog box. You add a comment for the associated 
sample in the Add Comment field. The comment is displayed in the Comments field on the 
Samples sub-tab on the Patient tab, the Comments field in the Samples pane on the Run 
tab, and in the Comments pane on the Sample Data sub-tab on the Sample tab. 

Figure 7-4:  Add Sample Comment dialog box

Note: If multiple comments have been added for a sample, then with the exception of the 
Comments pane on the Sample Data sub-tab on the Sample tab, only the last added 
comment is displayed in all the locations detailed above. All the comments that have 
been added for a sample, including the last added, are displayed in reverse 
chronological order in the Comments pane on the Sample Data sub-tab for the 
Sample tab.

Set Subpanel You must select a sample or samples for which a subpanel was not selected during the 
setup of the run. Opens the Select a Subpanel dialog box. The dialog box displays the 
selected sample or samples, the panel for the currently selected sample, and a Subpanel 
dropdown list with all the available subpanels. 

Figure 7-5:  Set Sample Subpanel dialog box

Select a subpanel on the Subpanel dropdown list, and then click OK. The subpanel is 
applied to sample or samples.

Table 7-1: Run tab, Samples pane context menu (Continued)

Option Description
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Set Patient Opens the Set Patient dialog box. Select the patient that is to be associated with the 
sample, and then click OK.

Figure 7-6:  Set Patient dialog box

Note: You also have the option of associating a patient with a sample from the Sample 
tab. See “To associate a patient with a sample” on page 242.

Edit Sample Groups Opens the Edit Sample Group dialog box. You use the options on this dialog box to add a 
sample to a selected sample group, or to remove a sample from a selected sample group.

Note: If the appropriate sample group is not available, you can add it. See “Managing 
Objects” on page 49.

Figure 7-7:  Edit Sample Group dialog box

Delete Sample Deletes the sample from the run.

Exports

Export to VCF Exports all the variants in the selected sample to a VCF file. You must specify both the file 
name and the location in which to save the file.

Table 7-1: Run tab, Samples pane context menu (Continued)

Option Description
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Save Sample 
Reports

Applicable for one or more samples. CTRL-click to select multiple samples. Generates an 
individual sample report for each selected sample. If a single sample is selected, then a 
default location, report name, and report type (HTML) are provided, but you can change 
any or all of these values. If multiple samples are selected, then you can select only the 
location in which to save the report. Each report is named the same as the sample and the 
report format is HTML, and you cannot change either of these values.

Note: For more information about standard reports, see Chapter 10, “Geneticist Assistant 
Reports,” on page 267.

Create Batch 
Variants Report

Opens the Batch Variants Report dialog box for generating the Batch Variants report for 
the selected sample or samples. (CTRL-click to select multiple samples.) See “To manage 
a Batch Variants report (Run tab)” on page 204.

Create Batch 
Coverage Report

Opens the Batch Coverage Report dialog for generating the Batch Coverage report the 
selected sample or samples. (CTRL-click to select multiple samples.). See “To generate a 
Batch Coverage report (Run tab)” on page 208.

Load Columns

Manually Opens the Select Columns dialog box in which you can select columns that are to be 
shown and clear the columns that are to be hidden dynamically, or select a configuration 
from the list of available column configurations. This option is also available on the column 
header context menu for the sub-tab.

Note: For information about showing and hiding columns dynamically, see “To show/hide 
columns in a tab pane” on page 37.

Note: If you set column display preferences here, then you can display preferences for 
variants in all the variant sub-tabs and panes (with the exception of the Sample 
Group columns on the Sample Variant Data sub-tab on the Sample tab and the 
Variant pane on the Variant tab) in a single step. See “To apply shared preferences 
or to clear all tab preferences” on page 58.

Compact Displays the data columns on the sub-tab in a more condensed view. To toggle the display, 
click Compact as needed.

<Saved Pane 
Configuration Name> 
- Saved by <User 
Name>

Publicly available pane configurations. The name of the user who created a pane 
configuration is displayed next to the configuration name.

Load Filters

Manually Opens the Filters table for the Samples pane. See “To filter the data that is displayed in a 
tab pane” on page 32.

<Filter Template 
Name> - Saved by 
<User Name>

Opens the saved Filter template for the Samples pane. Limits the display in the pane to 
only the data (fields) that are defined by the template. See “To filter the data that is 
displayed in a tab pane” on page 32.

Table 7-1: Run tab, Samples pane context menu (Continued)

Option Description
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To compare selected sample data for a run from the Run tab

1. If you have not already done so, open the Run tab. (See “Overview of the Run Tab” on 
page 181.)

2. For the appropriate run, CTRL-click to select the samples that are to be compared, and 
then right-click on any selected sample and on the context menu that opens, click 
Compare Samples.

The Sample Comparison dialog box opens. All the selected samples for the run are 
displayed in the dialog box. 

Figure 7-8:  Sample Comparison dialog box

3. Set the comparison parameters.

To compare all samples within a run, see “To compare all the samples within a 
run from the Runs tab” on page 161.

Option Description

Show columns The data columns that are displayed for each sample on the Sample 
Comparison tab. Allele Frequency (AF) is always displayed and you 
cannot change this option. Coverage (Cov) is displayed by default, but 
you can clear this selection. Read Balance (RB) is not displayed by 
default, but you can select this option.

Filter variants by panel Limits the variants that are displayed on the Sample Comparison tab to 
only those variants that are contained within the selected panel.
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4. Click OK.

The Sample Comparison dialog box closes. The Sample Comparison results are 
displayed on the Sample Comparison tab. A distinct gray vertical line separates the two 
sides of the tab. The left side of the tab shows the sample-specific information, 
identifying each sample as 1, 2, and so on. If you hover your cursor over the column 
heading, then the full sample name is displayed. The right side of the tab shows the 
variant details. 

Figure 7-9:  Sample Comparison tab

     

Shared by Limits the variants that are displayed on the Sample Comparison tab to 
only those variants that meet the required number of samples as 
specified by the operator that is selected on the dropdown list (>, <. or =) 
and the number of samples. If a variant is found in a number of samples 
that does not meet this criteria, then the variant is not displayed in the 
results.

AF difference

• Exclude missing 
variants

Limits the variants that are displayed on the Sample Comparison tab to 
only those variants that have a difference in allele frequency as 
specified by the operator that is selected on the dropdown list (>, <. or =) 
and the number of samples. If a variant is found with an allele frequency 
difference that does not meet this criteria, then the variant is not 
displayed in the results. 

Selected by default. Regardless of the allele frequency difference, 
always display variants that are not found in one or more samples.

AF between Limits the variants that are displayed on the Sample Comparison tab to 
only those variants with an allele frequency that falls within the indicated 
range in at least one of the compared samples.

Option Description
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To compare family data
If the samples for a run are from a family, then you can use the Family Comparison option to 
compare the samples based on the relationships and phenotypes for each sample. At a 
minimum, you must select two parent samples and one child sample. You can always select 
more than one child sample. 

1. If you have not done so already, open the Run tab. 

2. In the Samples pane, CTRL-click to select the family data that is to be compared. 

3. Right-click any selected sample, and on the context menu that opens, click Family 
Comparison.

The Family Comparison dialog box opens. If a patient is associated with a selected 
sample, then patient Relationship (Father, Mother, or so on) is displayed on the 
Relationship dropdown list; otherwise, you must select the appropriate relationship for 
the patient. Likewise, if the phenotype was included with the patient information, then 
the phenotype is automatically displayed on the Phenotype dropdown list for the sample, 
where Affected indicates that the patient has the phenotype and Unaffected indicates that 
the patient does not have the phenotype. If the phenotype is not automatically displayed 
for a sample, then you must select the appropriate value.

Figure 7-10:  Family Comparison dialog box

4. Do any or all of the following as needed:

• On the Phenotype dropdown list at the top of the dialog box, select a different 
phenotype.

• On the Inheritance pattern dropdown list, select the appropriate value for the family, 
and if applicable, based on the selected Inheritance pattern, select Compound 
heterozygous.

At a minimum, you must select two parent samples and one child sample. You can 
always select more than one child sample.
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• Indicate which columns to show or hide in addition to the default columns that are 
displayed for the family data comparison results: AF (Allele Frequency), Cov 
(Coverage), and/or RB (Read Balance).

• To display all the variants in each sample filtered by a selected panel, select Filter 
variants by panel, and then on the Panels dropdown list, select the appropriate panel.

5. Click OK.

The family data comparison is carried out. The Family Comparison tab opens. A distinct 
gray vertical line divides the two sides. The left side of the Family Comparison Results 
pane shows sample-specific information. The results are shown using standard pedigree 
symbols. If the patient that is associated with a sample is affected, then the pedigree 
symbol is shaded; otherwise, the symbol is not shaded. You can hover your cursor over a 
column header to view specific details for the selected sample. The right side of the tab 
shows variant detail information. See Figure 7-11 below and Figure 7-12 on page 192.

Figure 7-11:  Viewing information for a family comparison result

Select Compound heterozygous to carry out compound heterozygous filtering. The 
filtering results are displayed in the Family Data Comparison Results pane. the 
results show all possible combinations of two heterozygous variants in a gene if 
the variants meet the relationship and phenotype settings for the parent samples. 
For example, if a Mother is Unaffected and a Father is Unaffected, but a Son is 
Affected, then one heterozygous variant in the affected son must come from each 
parent.

After you select an Inheritance pattern, the zygosity for each sample is 
automatically adjusted based on the selected inheritance pattern and the 
relationship and phenotype for the sample. If you select an incorrect Inheritance 
pattern based on the relationships and phenotypes, then “Error” is displayed 
instead of a valid zygosity value.

Comparison of family data can take 30 minutes or more depending on a variety of 
factors, including the number of the samples that are being compared and the 
number of variants for each sample.
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Figure 7-12:  Family Comparison Results pane

Coverage Regions tab
The Coverage Regions tab has a single pane, the Coverage Regions pane, that displays the 
coverage information for every region in your panel. The Status column indicates whether 
the panel region passed or failed the Quality Control (coverage) settings that were set for the 
run’s panel. 

Figure 7-13:  Coverage Regions tab

Table 7-2: Coverage Regions tab

Column Description

ID System-generated ID for the region.

Region Name The region description from Column 4 of the BED file.

Chrom The chromosome on which the region is located.

ChromRegionStart The starting chromosome position for the region.

ChromRegionEnd The ending chromosome position for the region.

Note: Together, the ChromRegionStart and ChromregionEnd make up the chromosome position range.

Chrom:Start-End The chromosome position range appended to the chromosome number.

% Covered The percentage of the region that has reads aligned to it.

Average Coverage The average coverage (average number of aligned reads) for the region.
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Minimum Coverage The minimum coverage (number of reads aligned) for any position within the region.

% Covered 
Threshold

The percentage of the region that must have reads aligned to it, or the region does not 
pass the Quality Control settings that have been set for the run’s panel. See “To specify the 
global Quality Control settings” on page 55.

Average Coverage 
Threshold

The average coverage (average number of aligned reads) required for the region, or the 
region does not pass the Quality Control settings that have been set for the run’s panel. 
See “To specify the global Quality Control settings” on page 55..

Minimum Coverage 
Threshold

The minimum coverage (number of reads aligned) that is required for any position within 
the region, or the region does not pass the Quality Control settings that have been set for 
the run’s panel. See “To specify the global Quality Control settings” on page 55.

Status Indicates if the region passed or failed the Quality Control (coverage) settings that were 
specified for the run’s panel. You can manually change the status for a region. If you 
manually change the status for a region, then the Update Panel Region dialog box opens. 
The dialog box lists the new status for the region, and you have the option of adding 
comments for the status change. The comments are displayed in the Status Comment 
field.

Figure 7-14:  Update Panel Region Status dialog box

Note: By default, only two statuses, Passed or Failed, are available, and one of these two 
statuses is always automatically selected for the region. You have the option of 
adding custom Panel Region statuses and manually selecting a status for a region. 
See “Managing Objects” on page 49.

Table 7-2: Coverage Regions tab (Continued)

Column Description
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The context menu for the Coverage Regions tab title bar has the Manage Sample Group 
Statistics option which you can select if you used sample groups for a run and you want to 
calculate statistics for the run. (This option is also available on the tab title bar context menu 

Status Comment Displays any comments that were added when the region status is manually changed. You 
can double-click in this field to add a new comment or modify an existing comment. After 
you add or edit a comment, and then click out of the field, the Update Region Status 
Comment dialog box opens. 

Figure 7-15:  Update Status Region Comment dialog box

The dialog box displays the status and region positions for the selected region, the current 
(old) comment, and the new comment. You can make any additional edits to the new 
comment as needed, and then click OK to close the dialog box and add the new or 
modified comment for the region.

Average % Covered Average of the percent covered for the region across all samples for the panel.

Average Average 
Coverage

The average of the average coverage values for the region across all samples for the 
panel.

Average Minimum 
Coverage

The average minimum coverage for the region across all samples for the panel.

Passed The total number of samples for the panel for which the status of the region is Passed.

Passed Percent The percent of the samples for the panel for which the status of the region is Passed.

Failed The total number of samples for the panel for which the status of the region is Failed.

Total The total number of samples that were submitted for the panel.

Gene The gene on which the region is located.

Transcript The accession number for the mRNA transcript.

Protein The accession number for the protein transcript.

Exon Number The coding exon number for the region.

SD % Covered The standard deviation for the “% Covered” value across all samples for the panel.

SD Average 
Coverage

The standard deviation for the “Average Coverage” value across all samples for the panel.

SD Minimum 
Coverage

The standard deviation for the “Minimum Coverage” value across all samples for the 
panel.

Table 7-2: Coverage Regions tab (Continued)

Column Description
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for the Sample Variant Data sub-tab on the Sample tab. See “Sample Variant Data sub-tab” 
on page 218.) You can also right-click anywhere on the Coverage Regions tab to open a 
context menu with the following options:
 

To add selected panel regions or variants to an Action List

An Action list is a list of items that require some type of follow up. You can create multiple 
action lists relative to the type of follow up that is needed. You can create an Action List for 
panel regions on the Coverage Regions tab or the Coverage Regions sub-tab on the Coverage 
QC tab or for variants on the Variants sub-tab on the Coverage QC tab or the Sample Variant 
Data sub-tab on the Sample tab. For example, if several panel regions failed the coverage 
settings for a run sample, then you can make an Action List that consists of these regions and 

Table 7-3: Coverage Regions tab context menu

Option Description

Add Selected 
Regions to Action 
List

Adds the selected panel region to an Action List. CTRL-click to select multiple regions. 
See “To add selected panel regions or variants to an Action List” on page 195.

Add Selected 
Regions to Custom 
Report

Selects all the data that is displayed for the selected panel region for inclusion in a custom 
report. CTRL-click to select multiple regions. See Chapter 10, “Geneticist Assistant 
Reports,” on page 267.

Add All to Custom 
Report

Selects all the data that is displayed for all the panel regions for inclusion in a custom 
report. See Chapter 10, “Geneticist Assistant Reports,” on page 267.

Load Columns

Manually Opens the Select Columns dialog box in which you can select columns that are to be 
shown and clear the columns that are to be hidden dynamically, or select a configuration 
from the list of available column configurations. This option is also available on the column 
header context menu for the sub-tab.

Note: For information about showing and hiding columns dynamically, see “To show/hide 
columns in a tab pane” on page 37.

Note: If you set column display preferences here, then you can display preferences for 
variants in all the variant sub-tabs and panes (with the exception of the Sample 
Group columns on the Sample Variant Data sub-tab on the Sample tab and the 
Variant pane on the Variant tab) in a single step. See “To apply shared preferences 
or to clear all tab preferences” on page 58.

Compact Displays the data columns on the sub-tab in a more condensed view. To toggle the display, 
click Compact as needed.

<Saved Pane 
Configuration Name> 
- Saved by <User 
Name>

Publicly available pane configurations. The name of the user who created a pane 
configuration is displayed next to the configuration name.

Load Filters

Manually Opens the Filters table for the Coverage Regions pane. See “To filter the data that is 
displayed in a tab pane” on page 32.

<Filter Template 
Name> - Saved by 
<User Name>

Opens the saved Filter template for the Coverage Regions pane. Limits the display in the 
pane to only the data (fields) that are defined by the template. See “To filter the data that is 
displayed in a tab pane” on page 32.
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indicate that you want to review the coverage values for these regions.

1. Do one of the following:

• To select a single panel region for the Action list, right-click the appropriate panel 
region on the Coverage Regions tab or the Coverage Regions sub-tab on the 
Coverage QC tab, and on the context menu that opens, click Add Selected Regions 
to Action List.

• To select multiple panel regions, press and hold the CTRL key as you select the 
appropriate panel regions on the Coverage Regions tab or the Coverage Regions 
sub-tab on the Coverage QC tab, and then right-click any selected panel region, and 
on the context menu that opens, click Add Selected Regions to Action List.

• To select a single variant for the Action list, right-click on the appropriate variant on 
the Variants sub-tab on the Coverage QC tab or the Sample Variant Data sub-tab on 
the Sample tab, and on the context menu that opens, click Add Selected Variants to 
Action List.

• To select multiple variants, press and hold the CTRL key as you select the 
appropriate variants on the Variants sub-tab on the Coverage QC tab or the Sample 
Variant Data sub-tab on the Sample tab, and then right-click on any selected variant, 
and on the context menu that opens, click Add Selected Variants to Action List.

The Add To Action List dialog box opens. If the Action Type that you want to use is 
already available on the Action type dropdown list, then go to Step 5; otherwise, if this is 
the first time that you are creating an Action List for the pane or the Action Type that you 
want to use is not available on the Action Type dropdown list, then you must add at least 
one type to the list. Go to Step 2.

Figure 7-16:  Add To Action List dialog box

2. Click New Type.

The Add To Action List dialog box is refreshed with an option for adding an action type.

3. In the New Type field, enter an action type (for example, Review Coverage), and then 
click Add.

The action type is added to the Action Type list. The Add to Action List dialog box is 
refreshed to show the full Action Type dropdown list and Comment field.
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4. Repeat Step 2 and Step 3 as needed to add more action types.

5. On the Action Type dropdown list, select the appropriate action type.

6. Optionally, in the Comment field, enter a comment that explains/supports your decision 
for adding the selected panel regions or variants to an Action list.

7. Click OK.

The Add To Action List dialog box closes. The Action List tab for the sample opens. 
Different panes (grouped by Action Type) list any panel regions for the sample that have 
been selected for an Action list and any variants for the sample that have been selected 
for an Action list.

Figure 7-17:  Action List tab

To calculate panel statistics (Run tab)
The Panel Statistics tab has options for displaying specific information based on a selected 
panel and panel group as well as any or all of the following criteria: 

• All panel samples.

• Samples that have been added to the panel within the last 30 days of the current day’s date, 
or a custom date range.

• Selected runs for the panel.

• Selected panel samples.

If you are creating an Action List for panel regions, then only the action types that 
were created specifically for panel regions are available. Likewise, if are creating 
an Action List for variants, then only the action types that were created 
specifically for variants are available. 

To save an Action List, you can generate a standard Action List Report. If multiple 
panes are included on the Action List tab, then by default, all these panes are 
included in the report. To remove a pane from the report, before generating the 
report, right-click the pane that you want to remove, and then click Remove. See 
“Generating a Standard Report” on page 269.
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To display data on the Panel Statistics tab

1. If you have not already done so, open the Run tab for the appropriate run. (See 
“Overview of the Run Tab” on page 181.)

2. In the Samples pane, select a sample or CTRL-click to select multiple samples, and then 
right-click on any selected sample and on the context menu that opens, click Panel 
Statistics. 

The Panel Statistics tab opens. The Coverage Regions sub-tab is the open tab. The panel 
and panel group that were used for the run are selected. You can select a different panel 
from the Panel dropdown list to view statistics for a different panel. You can also select a 
different panel to change the panel group, but you cannot change the panel group 
directly. By default, the statistics are calculated for all the samples in the selected run 
that have been added to the panel. 

Figure 7-18:  Coverage Regions sub-tab (Panel Statistics tab)

3. Optionally, modify any or all of the calculation criteria as needed, and then click OK to 
recalculate the panel statistics and update the display accordingly. 

If you select a small number of samples, such as two to four, then, by default, the 
panel statistics are calculated based only on the selected samples and before the 
statistics are calculated, a Very few samples message dialog box opens, warning 
you of this and asking you if you want to continue. You can click Yes, or you can 
click Cancel to return to the Run tab and select more samples.

Option Description

All panel samples If you select this option, then by default, all samples that have been added to 
the panel are displayed. To specify a custom date range, select added 
between, and then change one or both dates as needed. To change the 
dates, you can do either of the following:

• You can select any part of the date that you want to change, or the entire 
date, and then manually enter the new value. (The default date range is 
the last 30 days).

• You can select any part of the date that you want to change, and then use 
the Up/Down arrows to change the date accordingly.
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Selected runs To select specific runs for the panel, choose Selected runs, and then click the 

Browse button  that is next to Selected Runs to open the Select Runs 

dialog box. All the runs for the selected panel are displayed in the dialog box. 
Select the appropriate run, or CTRL-click to select multiple runs, and then 
click OK.

Figure 7-19:  Select Runs dialog box

Selected samples To select only specific samples for the panel, choose Selected samples and 

then click the Browse button  that is next to Selected samples to open 

the Select Samples dialog box. All the samples for the selected panel are 
displayed in the dialog box. Select the appropriate sample, or CTRL-click to 
select multiple samples, and then click OK.

Figure 7-20:  Select Samples dialog box

Option Description
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4. Optionally, after calculating the panel statistics, continue to any of the following needed 
to view information on any of the five sub-tabs that are available for the Panel Statistics 
tab:

• Coverage Regions sub-tab. See “Coverage Regions sub-tab (Panel Statistics tab)” on 
page 200.

• Samples sub-tab. See “Samples sub-tab (Panel Statistics tab)” on page 200.

• Variants sub-tab. See “Variants sub-tab (Panel Statistics tab)” on page 201.

• Patients sub-tab. See “Patients sub-tab (Panel Statistics tab)” on page 167.

• Reports sub-tab. See “Reports sub-tab (Panel Statistics tab)” on page 168.

Coverage Regions sub-tab (Panel Statistics tab)

The Coverage Regions sub-tab has a single pane, the Coverage Regions pane, that lists by 
default, the coverage information across all the samples of the selected run for every region 
in the selected panel and panel group. See “Coverage Regions tab” on page 192 for a detailed 
discussion of the information that is displayed on this sub-tab.

Figure 7-21:  Coverage Regions sub-tab (Panel Statistics tab)

Samples sub-tab (Panel Statistics tab)

The Samples sub-tab has a single pane, the Samples pane, that lists by default, all the 
samples for the selected run that were imported for the selected panel and panel group. (See 
Figure 7-22 on page 201.) You can double-click a sample on this sub-tab to open the Sample 
tab. (See Chapter 8, “Geneticist Assistant Data Review - Sample Tab,” on page 215.) You 
can also right-click a sample on the sub-tab to open a context menu that has options that are 
identical to options that are on the context menu for the Samples pane on the Run tab. See 
“The Samples Pane (Run tab) Context Menu” on page 184.
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Figure 7-22:  Panel Statistics tab, Samples pane

Variants sub-tab (Panel Statistics tab)

The Variants sub-tab has a single pane, the Variants pane, that lists by default, all the variants 
that were detected in all the samples for the selected run that were imported for the selected 
panel and panel group. The information that is displayed on this sub-tab is identical to the 
information that is displayed on the Variants sub-tab on the Patient tab. You can double-click 
a variant on this sub-tab to open the Variant tab. (See Chapter 9, “Geneticist Assistant Data 
Review - Variant Tab,” on page 245.) You can also right-click a variant on this sub-tab to 
open a context menu that has options that are identical to options that are on the context 
menu for the Sample Variant Data sub-tab on the Sample tab. See “Sample Variant Data sub-
tab” on page 218.

Figure 7-23:  Panel Statistics tab, Variants sub-tab

Reports sub-tab (Panel Statistics tab)

The Reports sub-tab contains a single pane, the Reports pane, that lists by default, all the 
reports that were generated for the samples for the selected run that were imported for the 
selected panel and panel group and saved to the Geneticist Assistant database. See Figure 7-
24 on page 202.

You can also select Reports > Saved Reports on the Geneticist Assistant main 
menu to open a Reports tab that includes these same reports.
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Figure 7-24:  Panel Statistics tab, Reports sub-tab

You can right-click anywhere on this sub-tab to open a context menu with options that are 
identical to the options that are on context menu for the Reports pane on the Patient sub-tab 
on the Patient tab. See “Patient tab, Patient sub-tab, Reports pane” on page 126.

To set or modify the Read/Write permissions for the samples in a 
run on a per sample basis

1. If you have not already done so, open the Run tab. (See “Overview of the Run Tab” on 
page 181.)

2. In the Samples pane, select the samples, or CTRL-click to select the multiple samples for 
which the permissions are being set.

3. Right-click any selected sample, and on the context menu that opens, click Permissions.

The Permissions dialog box opens. See Figure 7-25 on page 203.

• The first time that the dialog box opens, if the run was submitted using a Geneticist 
Assistant version with a build date of 4/8/15 or later, then the name of the user who 
submitted the run is displayed in the lower pane of the dialog box and both the Can 
Read and Can Write permissions are selected. If a standard user submitted the run, 
then the Administrator user name is also displayed. 

• For runs that were submitted using earlier versions of Geneticist Assistant, the pane 
is blank. For subsequent openings, the dialog box displays the names of all the users 
and/or groups and their assigned permissions for the run. 

For detailed information about generating and saving Panel Statistics reports, see 
Chapter 10, “Geneticist Assistant Reports,” on page 267.

You can assign Read and Write permissions for all the samples in a run in a single 
step. See “To set or modify the Read/Write permissions for a run” on page 168.
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Figure 7-25:  Permissions dialog box (Run tab, Samples pane)

4. Modify the permissions for any user or group as needed and then click OK; otherwise, to 
add permissions for a new user or group, go to Step 5.

5. Enter a user name (the login name for the user), or to assign the same permissions to 
multiple users in a single step, enter a group name.

As you enter a user name or a group name, a dropdown list opens. The list is 
dynamically updated with user names or group names that are in your Geneticist 
Assistant database and that match the search string that you are entering.

6. Select the appropriate user name or group name from the list, and then click Add.

The user name or group name is displayed in the lower pane of the dialog box. The Read 
permission is already assigned for the selected user or group. If just this permission is 
selected, then the user or group can simply view the sample record. They cannot modify 
it.

7. Optionally, if the user or group must be able to modify the sample record as well, then 
select the Can Write permission.

8. Click OK.

A Permission Updated message opens.

     

You can add or remove the Can Write permission for a user or group, or you can 
remove both the Can Read and Can Write permissions. Removing the Can Read 
permission but leaving the Can Write permission selected for a user or group has 
no effect.

The search string is not case-sensitive, but the string must begin with the user or 
group name. For example, a search string of “Ja” or “ja” returns a user with the 
name of Jane Doe, but a search string of “Doe” does not.
Geneticist Assistant User’s Manual 203



Chapter 7
Geneticist Assistant Data Review - Run Tab
9. Click OK. 

Both the message and the Permissions dialog box close. The specified permissions are 
set for the sample record.

To manage a Batch Variants report (Run tab)
A Batch Variants report is a report that includes information for variants in a selected 
sample, and allows you to create multiple reports for multiple samples in a single step. If you 
generate a Batch Variants report from the Run tab, then a separate report is saved for each of 
the selected samples in the run. A Batch Variants report configuration determines the data 
that is to be included in the report. You choose if the configuration is to be available only to 
the user who created it, or to all users. The configuration does not include the report format 
(PDF, HTML and so on), or the location in which the report is to be saved. Instead, you must 
specify the format and location in which to save the report every time you generate a report 
for a new or saved configuration. 

Figure 7-26:  Batch Variants Report dialog box

In Geneticist Assistant, you can generate a Batch Variants report according to a new or saved 
configuration, modify a Batch Variants report configuration, or delete a Batch Variants report 
configuration. See:

• “To generate a Batch Variants report based on a new configuration” below.

• “To generate a Batch Variants report based on a saved configuration” on page 206.

• “To modify a Batch Variants report configuration” on page 207.

• “To delete a Batch Variants report configuration” on page 208.

To generate the report for all variants in all the samples for the run, see “To 
manage a Batch Variants report (Runs tab)” on page 170.)
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To generate a Batch Variants report based on a new configuration

The name for a Batch Variants report is automatically assigned based on the sample ID 
number and sample name for the first sample in the list of samples which you are generating 
the report (for example, 76_800458.variants.filter) and you cannot change this. You must 
select a location in which to save the report.

1. If you have not already done so, open the Run tab.

2. In the Samples pane, select the sample or CTRL-click to select the multiple samples for 
which the Batch Variant report is to be generated.

3. Right-click any selected sample, and on the context menu that opens, click Export > 
Create Batch Variants report.

4. On the Batch Variants Report dialog box, on the Report Type dropdown list, select the 
report type. (The default value is PDF.)

5. If a Batch Variants report has previously been generated and saved, then the location in 
which the report was saved is displayed in the Save To field when the Batch Variants 
Report dialog box opens; otherwise, this field is blank. Do one of the following:

• Leave this location as-is, and then go to Step 6.

• To change this location, then next to the Save To field, click the Browse button , 

and then browse to and select the location in which the report is to be saved.

6. Optionally, to filter the data that is to be displayed in the report, click Filter, and then 
from the Filter dropdown list, select the appropriate pre-configured filter.

7. Optionally, to set the display preferences for the report, do any of the following as 
needed:

• Rearrange the data columns.

• Rename a column header.

• Show/hide columns (manually or by loading a configuration).

8. Optionally, to view an onscreen preview of the report before it is generated and saved, 
click Preview.

     

For detailed information about filtering the data that is displayed in a report, see 
“To filter the data that is displayed in a tab pane” on page 32.

For detailed information about working with data columns, including moving and 
renaming columns, or showing/hiding columns, see “Setting Display Preferences 
in the Geneticist Assistant Main Window” on page 31.
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9. Click OK.

The Batch Variants report is generated for each of the selected samples. After the report 
is successfully generated, a Batch Variants Report Finished dialog box with a message 
that indicates that the report was generated and where the report was saved.

10. Click OK.

The dialog box closes. You return to a blank Current Jobs tab on the Geneticist Assistant 
main window.

To generate a Batch Variants report based on a saved 
configuration
1. If you have not already done so, open the Run tab.

2. In the Samples pane, select the sample or CTRL-click to select the multiple samples for 
which the Batch Variant report is to be generated.

3. Right-click any selected sample, and on the context menu that opens, click Export > 
Create Batch Variants report.

4. On the Batch Variants Report dialog box, select the output format for the report.

5. If a Batch Variants report has previously been generated and saved, then the location in 
which the report was saved is displayed in the Save To field when the Batch Variants 
Report dialog box opens; otherwise, this field is blank. Do one of the following:

• Leave the location as-is, and then go to Step 6.

• To change this location, then next to the Save To field, click the Browse button , 

and then browse to and select the location in which the report is to be saved.

6. Right-click on any heading in the Input Format pane, and then choose Select Columns.

The Select Columns dialog box opens. 

7. Click Load Configuration.

The Load Configuration dialog box opens. The dialog box displays all your private and 
public configurations as well as all the configurations that other users have made public.

Figure 7-27:  Load Configuration dialog box
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8. Select a configuration, and then click Load.

The Load Configuration dialog box closes. The Select Columns dialog box remains 
open. The dialog box now reflects the columns that are to be included in the report based 
on the selected configuration.

9. Click Close (x) to close the Select Columns dialog box.

10. Optionally, to preview an onscreen preview of the report before it is generated and 
saved, click Preview.

11. Click OK.

The Batch Variants report is generated for each of the selected samples. After the report 
is successfully generated, a Batch Variants Report Finished dialog box with a message 
that indicates that the report was generated and where the report was saved.

12. Click OK.

The dialog box closes. You return to a blank Current Jobs tab on the Geneticist Assistant 
main window.

To modify a Batch Variants report configuration

When you modify a Batch Variants report configuration, any reports that were generated 
according to the “old” (previous) configuration are not affected. Going forward, the report is 
generated based on the “new” configuration. 

1. If you have not already done so, open the Run tab.

2. In the Samples pane, select the sample or CTRL-click to select the multiple samples for 
which the Batch Variant report is to be generated.

3. Right-click any selected sample, and on the context menu that opens, click Export > 
Create Batch Variants report.

If a Batch Variants report has previously been generated and saved, then the location in 
which the report was saved is displayed in the Save To field when the Batch Variants 
Report dialog box opens; otherwise, this field is blank. 

4. Do one of the following:

• Leave this location as-is, and then go to Step 5.

• To change this location, then next to the Save To field, click the Browse button , 

and then browse to and select the location in which the report is to be saved.

5. Right-click on any heading in the Input Format pane, and then choose Select Columns.

The Select Columns dialog box opens. 

6. To modify the report configuration, see “To create/modify a pane configuration” on page 
39.
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7. Optionally, to preview an onscreen preview of the report before it is generated and 
saved, click Preview.

8. Click OK.

The Batch Variants report is generated for each of the selected samples. After the report 
is successfully generated, a Batch Variants Report Finished dialog box opens, with a 
message that indicates where the report was saved.

9. Click OK.

The dialog box closes. You return to a blank Current Jobs tab on the Geneticist Assistant 
main window.

To delete a Batch Variants report configuration

You can delete a Batch Variants report configuration only if you created the report 
configuration. When you delete a Batch Variants report configuration, any reports that were 
generated according to the “old” (previous) configuration are not affected. Going forward, 
the “old” configuration is simply not available for selection.

1. On the Batch Variants Report dialog box, right-click on any heading in the Input Format 
pane, and then choose Select Columns.

The Select Columns dialog box opens. 

2. See “To delete a pane configuration” on page 41.

3. Click Close (x) to close the Batch Variants Report dialog box.

To generate a Batch Coverage report (Run tab)
The Batch Coverage report generates a coverage report for each of the selected samples in a 
run in a specific panel or panels and panel group. The report also includes coverage statistics 
for the panel that are calculated based on one of the following options: 

• All panel samples.

• Samples that have been added to the panel within the last 30 days of the current day’s date, 
or a custom date range.

• Selected runs for the panel.

• Selected panel samples.

1. If you have not already done so, open the Run tab.

     

You are not prompted about confirming the deletion of a Batch Variants report 
configuration, so be very sure that the deletion must be deleted before doing so.
208 Geneticist Assistant User’s Manual



Chapter 7
Geneticist Assistant Data Review - Run Tab
2. In the Samples pane, right-click a sample (CTRL-click to select multiple samples), and 
on the context menu that opens, click Export > Create Batch Coverage report.

The Batch Coverage Report dialog box opens. All the selected samples for the run are 
displayed in the bottom pane of the dialog box. If multiple samples are selected with 
different panels, then a separate tab is displayed for each panel. 

Figure 7-28:  Batch Coverage Report dialog box (Runs tab)

3. Leave the report type set to the default value of HTML, or select a different report type.

4. Next to the Save To field, click the Browse button  to open the Save To dialog box, 
and then browse to and select the location in which to save the report.

5. To calculate the panel coverage statistics for the report based on all panel samples, click 
OK; otherwise, specify the different options by which to calculate the panel coverage 
statistics, and then click OK. 

Option Description

All panel samples 
added between

To specify a custom date range for calculating the panel coverage statistics, 
select added between, and then change one or both dates as needed. To 
change the dates, you can do either of the following:

• You can select any part of the date that you want to change, or the entire 
date, and then manually enter the new value. (The default date range is 
the last 30 days).

• You can select any part of the date that you want to change, and then use 
the Up/Down arrows to change the date accordingly.
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Selected runs To select specific runs for calculating the panel coverage statistics, choose 

Selected runs, and then click the Browse button  that is next to Selected 

runs to open the Select Runs dialog box. All the runs for the panel are 
displayed in the dialog box. Select the appropriate run, or CTRL-click to select 
multiple runs, and then click OK.

Figure 7-29:  Select Runs dialog box

Selected samples To select only specific samples for calculating the panel coverage statistics, 

choose Selected samples and then click the Browse button  that is next 

to Selected samples to open the Select Samples dialog box. All the samples 
for the panel are displayed in the dialog box. Select the appropriate sample, 
or CTRL-click to select multiple samples, and then click OK.

Figure 7-30:  Select Samples dialog box

Option Description
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After you click OK to generate the report, the Current Jobs tab opens. The tab displays 
the progress of calculating the coverage information for every sample that was selected 
for the report. A report file is saved for each selected sample in the specified format and 
the specified location. 

If the panel coverage statistics are to be calculated based on only a small number 
of samples, such as two to four, then, before the statistics are calculated, a Very 
few samples message dialog box opens, warning you of this and asking you if you 
want to continue. You can click Yes, or you can click Cancel to return to the Runs 
tab.
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Run’s Status Changes pane
The Run’s Status Changes pane shows the history of all the status changes that have been 
made for the run in chronological order. A New status entry is always displayed for a run. 
You can right-click anywhere on this pane to open a context menu with the following 
options:

Option Description

Add All to Custom 
Report

Selects all the information that is displayed for all the statuses for inclusion in a custom 
report. See Chapter 10, “Geneticist Assistant Reports,” on page 267.

Load Columns

Manually Opens the Select Columns dialog box in which you can select columns that are to be 
shown and clear the columns that are to be hidden dynamically, or select a configuration 
from the list of available column configurations. This option is also available on the column 
header context menu for the sub-tab.

Note: For information about showing and hiding columns dynamically, see “To show/hide 
columns in a tab pane” on page 37.

Note: If you set column display preferences here, then you can display preferences for 
variants in all the variant sub-tabs and panes (with the exception of the Sample 
Group columns on the Sample Variant Data sub-tab on the Sample tab and the 
Variant pane on the Variant tab) in a single step. See “To apply shared preferences 
or to clear all tab preferences” on page 58.

Compact Displays the data columns on the sub-tab in a more condensed view. To toggle the display, 
click Compact as needed.

<Saved Pane 
Configuration Name> 
- Saved by <User 
Name>

Publicly available pane configurations. The name of the user who created a pane 
configuration is displayed next to the configuration name.

Load Filters

Manually Opens the Filters table for the Run Status Changes pane. See “To filter the data that is 
displayed in a tab pane” on page 32.

<Filter Template 
Name> - Saved by 
<User Name>

Opens the saved Filter template for the Run Status Changes pane. Limits the display in the 
pane to only the data (fields) that are defined by the template. See “To filter the data that is 
displayed in a tab pane” on page 32.
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Reports pane (Run tab)
The Reports pane displays all the reports that were generated for the selected run and saved 
to the Geneticist Assistant database.

You can right-click anywhere on this pane to open a context menu with options that are 
identical to the options that are on context menu for the Reports pane on the Patient sub-tab 
on the Patient tab. See “Patient tab, Patient sub-tab, Reports pane” on page 126.

You can also select Reports > Saved Reports on the Geneticist Assistant main 
menu to open a Reports tab that includes these same reports.

For detailed information about generating and saving both standard and custom 
Run reports, see Chapter 10, “Geneticist Assistant Reports,” on page 267.
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Chapter 8
Geneticist Assistant Data Review - 
Sample Tab

Many options are available from the Sample tab for reviewing your data in Geneticist 
Assistant.

This chapter covers the following topics:

• “Overview of the Sample Tab” on page 217.

• “Sample Variant Data sub-tab” on page 218.

• “Sample Data sub-tab” on page 238.
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Overview of the Sample Tab
The Sample tab displays information for a sample that was selected from the Run tab. To 
open the Sample tab, do one of the following:

• Right-click a sample entry on the Run tab, and on the context menu that opens, select 
Sample Details.

• Double-click a sample entry on the Run tab.

Figure 8-1:  Sample tab, Sample Variant Data sub-tab

The Sample tab has two sub-tabs:

• The Sample Variant Data sub-tab. See “Sample Variant Data sub-tab” on page 218.

• The Sample Data sub-tab. See “Sample Data sub-tab” on page 238.
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Sample Variant Data sub-tab
The Sample Variant Data sub-tab is the sub-tab the opens after you open the Sample tab 

Figure 8-2:  Sample tab, Sample Variant Data sub-tab

The Sample Variant Data sub-tab has a single pane, the Variants pane, that displays 
information about all the variants that were identified in the selected sample. By default, two 
types of information are displayed on the sub-tab: variant annotation information and global 
variant count and frequency information. The pane also displays statistical information if a 
sample group was used for the run and statistics were calculated for the sample group. A 
variety of options are available for working with a variant that is displayed on this sub-tab, 
and a context menu is also available. See:

• “Variant annotation information” on page 219.

• “Global variant count and frequency information” on page 224.

• “Sample group statistical information” on page 225.

• “Variant options on the Sample Variant Data sub-tab” on page 226.

• “Sample Variant Data sub-tab context menu” on page 228.

The information that is displayed on the Sample Variant Data sub-tab was divided 
into two tables simply for ease of reading in this manual and locating and 
identifying the information on the sub-tab. There is no visible division of this 
information on the sub-tab itself.

• Remember, you can select which columns to show and hide in a pane. See “To 
show/hide columns in a tab pane” on page 37. 

• Remember, you can specify how the information about the variants is displayed 
on the sub-tab. See “To specify variant preferences” on page 60. 

• Selected columns from the various reference information panes on the Variant 
tab can also be displayed here. See Chapter 9, “Geneticist Assistant Data 
Review - Variant Tab,” on page 245.
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Variant annotation information

Table 8-1: Sample Variant Data sub-tab: Variant Annotation information

Column Description

ID System-generated value that identifies the variant. 

Chromosome The chromosome on which the variant is located.

Chromosome 
Position

The chromosome position where the variant is located.

Chr:ChrPos The chromsome:chromosome position for the variant location.

Rs The dbSNP database identification for the variant. 

Note: If a value other than N/A is displayed, then it is a hyperlink to the NCBI dbSNP web 
page for the variant.

Ref The reference nucleotide at the variant position.

Ref AA The reference amino acid coded for by the codon that includes the variant position.

Alt The variant nucleotide at the variant position.

Alt AA The variant amino acid coded for by the codon that includes the variant position.

Type The type of variant based on the amino acid change that the variant caused. Values are 
Missense, Synonymous, Frameshift, or Nonsense.

Coverage The coverage (number of reads) aligned to the variant location in the sample.
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Pathogenicity The pathogenicity of the variant, which is the potential for the variant to cause disease. By 
default, the pathogenicity is always set to an initial value of Unassigned. You must review 
the information for the variant and then decide what the pathogenicity should be; for 
example, Deleterious. (If you cannot determine the pathogenicity of the variant even after 
reviewing all the relevant information, you can set the status to Unknown.) After you set 
the pathogenicity for a variant, the next time that the variant is detected in another sample, 
this is the pathogenicity that is displayed for the variant. To open the Submit Pathogenicity 
Status dialog box, double-click in this column for the selected variant. You can update the 
pathogenicity for the selected variant and/or the status of the pathogenicity in this dialog 
box. You can also add a comment about the pathogenicity change and/or pathogenicity 
status change

Note: The option to update the pathogenicity and/or pathogenicity status (“Update 
Pathogenicity”) is also available on the context menu for the sub-tab. 

Figure 8-3:  Submit Pathogenicity dialog box

The following information is relevant to updating the pathogenicity and/or pathogenicity 
status for a variant:

• By default, only five statuses—Deleterious, Likely Deleterious, Unknown, Likely Benign, 
and Benign—are available. You have the option of adding custom pathogenicities. See 
“Managing Objects” on page 49.

• Optionally, you can add supporting information for this pathogenicity change. See “To 
add supporting information for a variant” on page 257.

• You always have the option of updating just the pathogenicity status for a variant at a 
later date. See “Pathogenicity Status” below.

Table 8-1: Sample Variant Data sub-tab: Variant Annotation information (Continued)

Column Description
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Pathogenicity Status The status of the selected pathogenicity. You must manually set this value.To open the 
Update Variant Pathogenicity Status dialog box, double-click in this column for the 
selected variant. You can set just the pathogenicity status for the variant in this dialog box. 
You can also add a comment about the status change.

Note: The option to update just the status (“Update Pathogenicity Status”) is also available 
on the context menu for the sub-tab. 

Figure 8-4:  Update Variant Pathogenicity Status dialog box

Table 8-1: Sample Variant Data sub-tab: Variant Annotation information (Continued)

Column Description
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Artifact Type The artifact type for the selected variant. You must manually set this value. Double-click in 
this column for the selected variant to open the Update Artifact Type dialog box. You 
specify the artifact type (for example, Sequencing) for the variant in this dialog box. If the 
appropriate artifact type is not available, then an option is provided to create a new type.

Note: The option to update the artifact type (“Update Artifact Type”) is also available on 
the context menu for the sub-tab.

Figure 8-5:  Update Variant Artifact Type dialog box

When you specify the artifact type, you can set the artifact type as the following:

• Set globally—Selected by default. Set this artifact type for the variant, regardless of the 
sample in which the variant is detected.

• Set for Sample—Set this artifact type for this variant only for the indicated sample.

You also have the option of adding comments for the variant artifact type.

The following information is relevant to updating the artifact type for a variant:

• You can CTRL-click to select multiple variants for updating the artifact type at the same 
time.

• You can also define artifact types and set the artifact type for a variant on the Variants 
sub-tab on the Patient tab, on the Variants sub-tab on the Panel Statistics tab from the 
Runs tab or the Run tab, or on the Sample Variant Data sub-tab on the Sample tab.

• By default, only a single artifact type, None, is available. You have the option of adding 
custom artifact types. See “Managing Objects” on page 49.

Variant Frequency The frequency at which the variant was detected in the sample. Any value < 1 is allowed, 
with 1 = 100%, 0.5 = 50%, and so on.

Zygosity Indicates whether the variant is heterozygous or homozygous.

Note: The selected zygosity is based on the Zygosity settings that you have specified on 
the Variant Preferences tab of the Settings dialog box. See “To specify variant 
preferences” on page 60.

Read Balance The balance in forward and reverse oriented reads with the variant as reported in the VCF 
file.

Gene The gene on which the variant is located.

Gene Strand The strand (+ or -) for the gene in which the variant is located.

Exon Number The exon within the gene in which the variant is located. “Intron” is displayed for intronic 
variants.

Table 8-1: Sample Variant Data sub-tab: Variant Annotation information (Continued)

Column Description
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Transcript The accession number for the preferred mRNA transcript that is used for the HGVS 
nomenclature columns.

Protein The accession number for the protein transcript that is associated with the preferred 
mRNA transcript and is used for the HGVS nomenclature columns.

Coding Base The position in the coding regions for the gene where the variant is located.

Codon Position The position within the codon where the variant is located (1, 2, or 3).

AA Position The amino acid number within the gene for the amino acid coded for by the codon that 
includes the variant position.

HGVS Genomic The HGVS genomic nomenclature for the variant. (www.hgvs.org/mutnomen).

HGVS Coding The HGVS coding DNA nomenclature for the variant relative to the reference accession 
that is shown in the Transcript column. (www.hgvs.org/mutnomen).

HGVS Protein The HGVS protein nomenclature for the variant relative to the reference accession that is 
shown in the Protein column. (www.hgvs.org/mutnomen).

Variant Comment The last added comment for the variant. You can also double-click in this field, and then 
add or edit a comment as needed. After you click out of the field, the Update Variant 
Comment dialog box opens. 

Figure 8-6:  Update Variant Comment dialog box

The dialog box displays the variant for which you are adding or editing the comment, the 
current (old) comment, and the new comment. You can make additional edits to the new 
comment needed, and then click OK to close the dialog box and save the new or modified 
comment for the variant.

Note: You can also add comments for a variant with an option on the context menu for this 
sub-tab. See “Add Variant Comment” on page 229.

Note: If multiple comments have been added for a variant, then with the exception of the 
Variant Comments pane on the Variant tab, only the last added comment is 
displayed here and on the Variants sub-tab on the Patient tab, the Sample Variant 
Data sub-tab in the Sample tab, the Variant pane on the Variant tab, and the Variant 
Comments pane on the Variant tab. All the comments that have been added for a 
variant, including the last added, are displayed in reverse chronological order in the 
Variant Comments pane on the Variant tab.

Times Observed Per 
Run

The number of times that the variant was detected across all samples in the run.

Panel The panel that was used for the run.

Table 8-1: Sample Variant Data sub-tab: Variant Annotation information (Continued)

Column Description
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Global variant count and frequency information

Panel Group The panel group to which the panel is assigned.

Trans Indicates whether the variant is Transition (Ti) or Transversion (Tv).

Sample The sample name.

HGMD Mutation The amino acid changes that was caused by the variant as recorded in HGMD.

HGMD HGVS The HGVS code relative to HGMD.

HGMD ID The ID for the variant in HGMD.

Note: If you have not specified your login settings for the HGMD database (see “To specify HGMD settings” on 
page 62), then these last three columns are not displayed.

Table 8-1: Sample Variant Data sub-tab: Variant Annotation information (Continued)

Column Description

Table 8-2: Sample Variant Data sub-tab: Global Variant Count and Frequency information

Column Description

Samples Per Panel The total number of samples submitted per panel.

Coverage Region 
Status

Indicates whether the region passed or failed the Quality Control (coverage) settings that 
were specified for the run’s panel. 

Note: Any of the following values that can also be reported as real or related to the artifact type for the variant are 
marked with an asterisk. For example, for Times Observed Per Panel, two additional columns are also 
displayed—Times Observed As Real Per Panel and Times Observed As Artifact Per Panel, where the 
number of samples for which the Artifact Type is set to None is reported for any Observed as Real value and 
the number of samples for which the Artifact Type is set to any other value, such as Sequencing, is reported 
for any Observed as Artifact value.

Times Observed Per 
Panel*

The number of times that the variant was detected across all samples per panel.

Frequency Observed 
Per Panel*

The frequency at which the variant was detected across all samples per panel.

Samples Per Patient 
Per Panel

The number of samples that are included in the Geneticist Assistant database for the 
patient who is associated with the selected sample relative to the panel that is assigned for 
the selected sample.

Times Observed Per 
Patient Per Panel*

The number of times that the variant was detected for the patient who is associated with 
the selected sample relative to the panel that is assigned for the selected sample.

Frequency Observed 
Per Patient Per 
Panel*

The frequency at which the variant was detected for the patient who is associated with the 
selected sample relative to the panel that assigned for the selected sample.

Samples Per Panel 
Group

The number of samples that are included in the panel group that include the panel that is 
assigned to the selected sample.

Times Observed Per 
Panel Group*

The number of samples that include the variant and that are assigned to any panel that is 
included in the same panel group as the panel for the selected sample.

Frequency Observed 
Per Panel Group*

The frequency at which the variant was detected in all samples that are assigned to any 
panel that is included in the same panel group as the panel for the selected sample.

Patient Variant 
Frequency

The frequency of the variant found in the patient sample. If multiple samples for a patient 
have been loaded, then all samples are considered.
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Sample group statistical information

Samples With 
Passed Regions Per 
Panel

The number of samples that are assigned to the panel for the selected sample where the 
panel region in which the variant is located has a status of Passed for the sample.

Times Observed In 
Passed Regions Per 
Panel

The number of samples that are assigned to the panel for the selected sample where the 
variant is reported and the panel region in which the variant is located has a status of 
Passed for the sample.

Frequency Observed 
In Passed Regions 
Per Panel

The frequency at which the variant was detected considering only those samples that are 
assigned to the same panel as the selected sample and where the panel region in which 
the variant is located has a status of Passed.

Samples With 
Passed Regions Per 
Patient Per Panel

The number of samples that are assigned to the patient and panel that are assigned to the 
current sample where the panel region in which the variant is located has a status of 
Passed.

Times Observed In 
Passed Regions Per 
Patient Per Panel

The number of samples that are assigned to the patient and panel that are assigned to the 
current sample where the variant is found and the panel region in which the variant is 
located has a status of Passed.

Frequency Observed 
In Passed Regions 
Per Patient Per 
Panel

The frequency at which the variant was detected in all samples that are assigned to the 
patient and panel that are assigned to the current sample, and the panel region has a 
status of Passed.

Samples With 
Passed Regions Per 
Panel Group

The number of samples that are assigned to any panel that is included in the same panel 
group as the panel for the selected sample where the panel region in which the variant is 
located has a status of Passed.

Times Observed In 
Passed Regions Per 
Panel Group

The number of samples that are assigned to any panel that is included in the same panel 
group as the panel for the selected sample where the variant is found and the panel region 
in which the variant is located has a status of Passed.

Frequency Observed 
In Passed Regions 
Per Panel Group

The frequency at which the variant was detected in all samples that are assigned to any 
panel that is included in the same panel group as the panel for the selected sample where 
the panel region in which the variant is located has a status of Passed.

Table 8-2: Sample Variant Data sub-tab: Global Variant Count and Frequency information (Continued)

Column Description

To calculate the statistics for the sample group, use the Manage Sample Group 
Statistics option on the column header context menu for the sub-tab. See “Sample 
Variant Data sub-tab context menu” on page 228.

Table 8-3: Sample Group Statistics Columns on the Sample Variant Data sub-tab

Column Description

Number of Samples Number of samples that.have been submitted for the sample group to which this sample is 
assigned.

Number of Samples 
Having the Variant

Number of samples in the group that contained the variant.

Coverage Min The minimum coverage (number of reads) for the variant in the sample group.

Coverage Max The maximum coverage (number of reads) for the variant in the sample group.
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Variant options on the Sample Variant Data sub-tab
You can do the following for a variant that is displayed on the Sample Variant Data sub-tab 
on the Sample tab:

• You can specify how the information about the variants is to be displayed on this sub-tab. 
See “To specify variant preferences” on page 60.

• If the variant is located where there are overlapping genes, then you can select a different 
gene for the variant on the Gene dropdown list. If you select a different gene, then the 
gene that is used on the current tab for the current Geneticist Assistant session is 
temporarily changed. After you close and then re-open Geneticist Assistant, the selected 
gene is reset to the preferred gene. To permanently change the gene that is used for 
variant, you can add a preferred gene for the panel. See “To set or delete a preferred gene 
for a panel” on page 92.

• You can select a different transcript for the variant on the Transcript dropdown list. If you 
select a different transcript, then the transcript that is used on the current tab for the 
current Geneticist Assistant session is temporarily changed. After you close and then re-
open Geneticist Assistant, the selected transcript is reset to the preferred transcript. 

Coverage Median The median coverage (number of reads) for the variant in the sample group.

Coverage Standard 
Deviation

The variation from the Coverage mean for the variant in the sample group.

Variant Frequency 
Min

The minimum frequency at which the variant was detected in the sample group. Any value 
< 1 is allowed, with 1 = 100%, 0.5 = 50%, and so on.

Variant Frequency 
Max

The maximum frequency at which the variant was detected in the sample group. Any value 
< 1 is allowed, with 1 = 100%, 0.5 = 50%, and so on.

Variant Frequency 
Median

The median frequency at which the variant was detected in the sample group. Any value < 
1 is allowed, with 1 = 100%, 0.5 = 50%, and so on.

Variant Frequency 
Mean

The mean frequency at which the variant was detected in the sample group. Any value < 1 
is allowed, with 1 = 100%, 0.5 = 50%, and so on.

Variant Frequency 
Standard Deviation

The variation from the Frequency mean for the variant in the sample group.

Read Balance Min The minimum value for the balance in forward and reverse oriented reads with the variant 
in the sample group as reported in the VCF file.

Read Balance Max The maximum value for the balance in forward and reverse oriented reads with the variant 
in the sample group as reported in the VCF file.

Read Balance 
Median

The median value for the balance in forward and reverse oriented reads with the variant in 
the sample group as reported in the VCF file.

Read Balance Mean The mean value for the balance in forward and reverse oriented reads with the variant in 
the sample group as reported in the VCF file.

Read Balance 
Standard Deviation

The variation from the Read Balance mean for the variant in the sample group.

Table 8-3: Sample Group Statistics Columns on the Sample Variant Data sub-tab (Continued)

Column Description
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• You can single click twice in the Variant Comment field to select the current comment in 
the field and edit it, or if the field is blank, enter a new comment. After you add or edit a 
comment, and then click out of the field, the Update Variant Comment dialog box opens. 

Figure 8-7:  Update Variant Comment dialog box

The dialog box displays the variant for which you are adding or editing the comment, the 
current (old) comment, and the new comment. You can make additional edits to the new 
comment needed, and then click OK to close the dialog box and save the new or 
modified comment for the variant.

• You can click once in the Type field, the Zygosity field, the HGVS Genomic field, the 
HGVS Coding field, the HGVS Protein field, and/or the Read Balance field to select the 
current value in the field and edit it, or if the field is blank, enter a new value.

     

To permanently change the transcript that is used for a gene or genes, you can do 
one of two things: You can right-click the variant, and on the context menu that 
opens, click Edit Variant > Update Preferred Transcript (see “Sample Variant 
Data sub-tab context menu” on page 228), or you can add a preferred transcript 
list for the panel. See “To set or delete a preferred transcript list for a panel” on 
page 90.

You can also use the Add Variant Comment option that is available on the context 
menu for the variant to add a new variant comment. See “Add Variant Comment” 
on page 229. 

If you make a change to any of these values for the variant, then these changes are 
recorded for the variant on the Variant Changes pane on the Variant tab. See 
“Variant Changes pane” on page 253. These changes are also reflected in the 
appropriate fields on all the variant tabs, sub-tabs, and panes in the Geneticist 
Assistant application.
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Sample Variant Data sub-tab context menu
You can right-click any column header on the Sample Variant Data sub-tab to open a context 
menu that, in addition to the standard column header context menu options, contains a 
Manage Sample Group Statistics Columns option. This option opens the Select Sample 
Groups dialog box. 

Figure 8-8:  Select Sample Groups dialog box

• If you used sample groups for a run, then you can indicate the date range for which to 
calculate statistics based on the added samples.

• If you did not use sample groups for a run, you can clear the options for selected sample 
groups, which hides the corresponding Sample Group Statistics columns from the sub-tab 
display. 

You can also right-click a variant in the Variants pane on the sub-tab to open a context menu 
with the following options:

Table 8-4: Sample tab, Sample Variant Data sub-tab context menu

Option Description

Variant Details Opens the Variant tab, which displays detailed information about the variant. See 
Chapter 9, “Geneticist Assistant Data Review - Variant Tab,” on page 245.

Show Variants Filtered 
by Panel

Displays all the variants in the selected sample filtered by a selected panel. If you 
select this option, then the Select Panel to Filter Variants dialog box opens. You must 
select a panel in this dialog box by which to filter the variants for the selected run.

Figure 8-9:  Select Panel to Filter Variants dialog box

Show Samples with 
Selected Variants

Opens the Samples with variants pane, which displays a list of all the samples in your 
Geneticist Assistant database that contain the selected variant. You can right-click a 
sample in the list to open a context menu with sample-specific options. See “The 
Samples Pane (Run tab) Context Menu” on page 184.
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Edit Variant - Contains all the sub-menu options for editing and deleting a variant.

Add Variant Comment Opens the Add Variant Comment dialog box. You can add a comment for the variant in 
the Add Comment field, and then click OK. You can also CTRL-click to select multiple 
variants and add the same comment to all the selected variants in a single step. The 
comment is displayed in the Variant Comment field in the Variants pane on the Search 
Results tab, the Variant Comment field on the Sample Variant Data sub-tab on the 
Sample tab, the Variant Comment field in the Variant pane on the Variant tab, and the 
Variant Comments pane on the Variant tab.

Figure 8-10:  Add Variant Comment dialog box

Note: If multiple comments have been added for a variant, then with the exception of 
the Variant Comments pane on the Variant tab, only the last added comment is 
displayed in all the locations that are detailed above. All the comments that have 
been added for a variant, including the last added, are displayed in reverse 
chronological order in the Variant Comments pane on the Variant tab.

Table 8-4: Sample tab, Sample Variant Data sub-tab context menu (Continued)

Option Description
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Update Pathogenicity Opens the Submit Pathogenicity dialog box. You can update the pathogenicity for the 
selected variant and/or the status of the pathogenicity in this dialog box. You can also 
add a comment about the pathogenicity change and/or pathogenicity status change. By 
default, the pathogenicity is always set to an initial value of Unassigned. You must 
review the information for the variant and then decide what the pathogenicity should be; 
for example, Deleterious. (If you cannot determine the pathogenicity of the variant even 
after reviewing all the relevant information, you can set the status to Unknown.) After 
you set the pathogenicity for a variant, the next time that the variant is detected in 
another sample, this is the pathogenicity that is displayed for the variant. 

Figure 8-11:  Submit Pathogenicity dialog box

Note: You can also double-click in the Pathogenicity column to open the Submit 
Pathogenicity dialog box.You can also CTRL-click to select multiple variants for 
updating the pathogenicities and the pathogenicity statuses at the same time. 

Note: You can also update the Pathogenicity and the Pathogenicity Status for a variant 
on the Variants sub-tab on the Patient tab.

The following information is relevant to updating the pathogenicity and/or pathogenicity 
status for a variant:

• By default, only five statuses—Deleterious, Likely Deleterious, Unknown, Likely 
Benign, and Benign—are available. You have the option of adding custom 
pathogenicities. See “Managing Objects” on page 49.

• Optionally, you can add supporting information for this pathogenicity change. See 
“To add supporting information for a variant” on page 257.

• You always have the option of updating just the pathogenicity status for a variant at a 
later date. See “Update Pathogenicity Status” below.

Table 8-4: Sample tab, Sample Variant Data sub-tab context menu (Continued)

Option Description
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Update Pathogenicity 
Status

Opens the Update Variant Pathogenicity Status dialog box. You can update the 
pathogenicity status for the variant in this dialog box. You can also add a comment for 
the variant. 

Figure 8-12:  Update Variant Pathogenicity Status dialog box

Note: By default, only two statuses, Pending or Confirmed, are available. You have the 
option of adding custom pathogenicity statuses. See “Managing Objects” on 
page 49.

Note: You can also update the Pathogenicity Status for a variant on the Variants sub-
tab on the Patient tab.

Note: You can also double-click in the Pathogenicity Status column for a variant to 
open the Update Variant Pathogenicity Status dialog box. You can also CTRL-
click to select multiple variants for updating the pathogenicity statuses at the 
same time.

Table 8-4: Sample tab, Sample Variant Data sub-tab context menu (Continued)

Option Description
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Update Artifact Type Opens the Update Artifact Type dialog box. You can specify the artifact type (for 
example, Sequencing) for the variant in this dialog box. If the appropriate artifact type is 
not available, then an option is provided to create a new type.

Figure 8-13:  Update Variant Artifact Type dialog box

When you specify the artifact type, you can set the artifact type as the following:

• Set globally—Selected by default. Set this artifact type for the variant, regardless of 
the sample in which the variant is detected.

• Set for Sample—Set this artifact type for this variant only for the indicated sample.

You also have the option of adding comments for the variant artifact type.

The following information is relevant to updating the artifact type for a variant:

• You can CTRL-click to select multiple variants for updating the artifact type at the 
same time.

• You can also define artifact types and set the artifact type for a variant on the 
Variants sub-tab on the Patient tab, or on the Variants sub-tab on the Panel Statistics 
tab from the Runs or the Run tab.

• By default, only a single artifact type, None, is available. You have the option of 
adding custom artifact types. See “Managing Objects” on page 49.

Table 8-4: Sample tab, Sample Variant Data sub-tab context menu (Continued)

Option Description
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Update Preferred 
Transcript

Opens the Update Preferred Transcript dialog box. You can select a different preferred 
transcript for the variant on the Change Transcript To dropdown list. 

Figure 8-14:  Update Preferred Transcript dialog box

Note: When you select a different transcript here, then the preferred transcript that is 
used for a gene or genes is permanently changed for the panel. You can also 
permanently change the preferred transcript by adding a preferred transcript list 
for the panel. See “To set or delete a preferred transcript list for a panel” on page 
90. To temporarily change the preferred transcript for a gene or genes, you 
simply select the transcript on the Transcript dropdown list on a tab or sub-tab.

Delete Variant Deletes the selected variant from the sample.

External - Contains all the sub-menu options for viewing the variant in third-party tools.

View in Alamut Opens the variant for viewing in Alamut.

Note: To view a variant in Alamut, your Alamut settings must be specified. See “To 
specify Alamut settings” on page 61.

View in UCSC Opens the variant for viewing in the UCSC Variant Genome Browser. 

Table 8-4: Sample tab, Sample Variant Data sub-tab context menu (Continued)

Option Description
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View PubMed Abstract Searches PubMed for the variant and displays the appropriate abstract in the PubMed 
window. 

Figure 8-15:  PubMed window

You can do the following for the abstract:

• In the Link field, enter a different PubMed URL, and then click the Go To icon  to 

navigate to abstract.

• Click Save As to save the abstract as a PDF with a name and in a location of your 
choosing.

• Click Print to print the abstract.

Export - Contains all the sub-menu options for exporting a variant.

Export Selected Variants 
to VCF

Exports the selected variants to a VCF file. CTRL-click to select multiple variants. You 
must specify both the file name and the location in which to save the file.

Export All Variants to 
VCF

Exports all the variants to a VCF file. You must specify both the file name and the 
location in which to save the file.

Reports - Contains all the sub-menu options for generating a report that includes the variant.

Add Selected Variants to 
Action List

Adds the selected variant to an Action List. CTRL-click to select multiple variants. See 
“To add selected panel regions or variants to an Action list” on page 235.

Add Selected Variants to 
Custom Report

Selects all the data that is displayed for the selected variants for inclusion in a custom 
report. CTRL-click to select multiple variants. See Chapter 10, “Geneticist Assistant 
Reports,” on page 267.

Add All Variants to 
Custom Report

Selects all the data that is displayed for all the variants for inclusion in a custom report. 
See Chapter 10, “Geneticist Assistant Reports,” on page 267.

Table 8-4: Sample tab, Sample Variant Data sub-tab context menu (Continued)

Option Description
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To add selected panel regions or variants to an Action list

An Action list is a list of items that require some type of follow up. You can create multiple 
action lists relative to the type of follow up that is needed. You can create an Action List for 
panel regions on the Coverage Regions tab or the Coverage Regions sub-tab on the Coverage 
QC tab or for variants on the Variants sub-tab on the Coverage QC tab or the Sample Variant 
Data sub-tab on the Sample tab. For example, if several panel regions failed the coverage 
settings for a run sample, then you can make an Action List that consists of these regions and 
indicate that you want to review the coverage values for these regions.

1. Do one of the following:

• To select a single panel region for the Action list, right-click the appropriate panel 
region on the Coverage Regions tab or the Coverage Regions sub-tab on the 
Coverage QC tab, and on the context menu that opens, click Add Selected Regions 
to Action List.

• To select multiple panel regions, press and hold the CTRL key as you select the 
appropriate panel regions on the Coverage Regions tab or the Coverage Regions 
sub-tab on the Coverage QC tab, and then right-click any selected panel region, and 
on the context menu that opens, click Add Selected Regions to Action List.

Load Columns

Manually Opens the Select Columns dialog box in which you can select columns that are to be 
shown and clear the columns that are to be hidden dynamically, or select a 
configuration from the list of available column configurations. This option is also 
available on the column header context menu for the sub-tab.

Note: For information about showing and hiding columns dynamically, see “To show/
hide columns in a tab pane” on page 37.

Note: If you set column display preferences here, then you can display preferences for 
variants in all the variant sub-tabs and panes (with the exception of the Sample 
Group columns on the Sample Variant Data sub-tab on the Sample tab and the 
Variant pane on the Variant tab) in a single step. See “To apply shared 
preferences or to clear all tab preferences” on page 58.

Compact Displays the data columns on the sub-tab in a more condensed view. To toggle the 
display, click Compact as needed.

<Saved Pane 
Configuration Name> - 
Saved by <User Name>

Publicly available pane configurations. The name of the user who created a pane 
configuration is displayed next to the configuration name.

Load Filters

Manually Opens the Filters table for the Variants pane. See “To filter the data that is displayed in 
a tab pane” on page 32.

<Filter Template Name> 
- Saved by <User 
Name>

Opens the saved Filter template for the Variants pane. Limits the display in the pane to 
only the data (fields) that are defined by the template. See “To filter the data that is 
displayed in a tab pane” on page 32.

Table 8-4: Sample tab, Sample Variant Data sub-tab context menu (Continued)

Option Description
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• To select a single variant for the Action list, right-click on the appropriate variant on 
the Variants sub-tab on the Coverage QC tab or the Sample Variant Data sub-tab on 
the Sample tab, and on the context menu that opens, click Add Selected Variants to 
Action List.

• To select multiple variants, press and hold the CTRL key as you select the 
appropriate variants on the Variants sub-tab on the Coverage QC tab or the Sample 
Variant Data sub-tab on the Sample tab, and then right-click on any selected variant, 
and on the context menu that opens, click Add Selected Variants to Action List.

The Add To Action List dialog box opens. If the Action Type that you want to use is 
already available on the Action type dropdown list, then go to Step 5; otherwise, if this is 
the first time that you are creating an Action List for the pane or the Action Type that you 
want to use is not available on the Action Type dropdown list, then you must add at least 
one type to the list. Go to Step 2.

Figure 8-16:  Add To Action List dialog box

2. Click New Type.

The Add To Action List dialog box is refreshed with an option for adding an action type.

3. In the New Type field, enter an action type (for example, Review Coverage), and then 
click Add.

The action type is added to the Action Type list. The Add to Action List dialog box is 
refreshed to show the full Action Type dropdown list and Comment field.

4. Repeat Step 2 and Step 3 as needed to add more action types.

5. On the Action Type dropdown list, select the appropriate action type.

6. Optionally, in the Comment field, enter a comment that explains/supports your decision 
for adding the selected panel regions or variants to an Action list.

     

If you are creating an Action List for panel regions, then only the action types that 
were created specifically for panel regions are available. Likewise, if are creating 
an Action List for variants, then only the action types that were created 
specifically for variants are available. 
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7. Click OK.

The Add To Action List dialog box closes. The Action List tab for the sample opens. 
Different panes (grouped by Action Type) list any panel regions for the sample that have 
been selected for an Action list and any variants for the sample that have been selected 
for an Action list.

Figure 8-17:  Action List tab

To save an Action List, you can generate a standard Action List Report. If multiple 
panes are included on the Action List tab, then by default, all these panes are 
included in the report. To remove a pane from the report, before generating the 
report, right-click the pane that you want to remove, and then click Remove. See 
“Generating a Standard Report” on page 269.
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Sample Data sub-tab
The Sample Data sub-tab contains five panes—Status Changes, Comments, Patient, Related 
Patients, and Reports—that provide different information about the sample. 

Figure 8-18:  Sample tab, Sample Data sub-tab

A context menu is available for each pane. See:

• “Status Changes pane” below.

• “Comments pane (Sample Data sub-tab on the Sample tab)” on page 240.

• “Patient pane (Sample Data sub-tab for the Sample tab)” on page 241.

• “Related Patients pane” on page 242.

• “Reports pane (Sample data sub-tab on the Sample tab)” on page 244.

Status Changes pane
The Status Changes pane lists an entry for each time the status was changed for the sample. 
Each entry details the value for the sample status, the name of the user who changed the 
sample status, the date and time of the status change, and any comments that the user entered 
in support of the change. The pane always contains an entry for the initial submission of the 
sample with the status of the sample set to New. 

     

Remember, you can change the status for a sample on the Run tab. See “To set the 
sample status” on page 182.
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You can-right click a status change in the pane to open a context menu with the following 
options:

     

Table 8-5: Sample tab, Sample Data sub-tab, Status Changes pane context menu

Option Description

Add All To Custom 
Report

Selects all the information that is displayed for the selected patient for inclusion in a 
custom report. See Chapter 10, “Geneticist Assistant Reports,” on page 267.

Load Columns

Manually Opens the Select Columns dialog box in which you can select columns that are to be 
shown and clear the columns that are to be hidden dynamically, or select a configuration 
from the list of available column configurations. This option is also available on the column 
header context menu for the sub-tab.

Note: For information about showing and hiding columns dynamically, see “To show/hide 
columns in a tab pane” on page 37.

Note: If you set column display preferences here, then you can display preferences for 
variants in all the variant sub-tabs and panes (with the exception of the Sample 
Group columns on the Sample Variant Data sub-tab on the Sample tab and the 
Variant pane on the Variant tab) in a single step. See “To apply shared preferences 
or to clear all tab preferences” on page 58.

Compact Displays the data columns on the sub-tab in a more condensed view. To toggle the display, 
click Compact as needed.

<Saved Pane 
Configuration Name> 
- Saved by <User 
Name>

Publicly available pane configurations. The name of the user who created a pane 
configuration is displayed next to the configuration name.

Load Filters

Manually Opens the Filters table for the Status Changes pane. See “To filter the data that is 
displayed in a tab pane” on page 32.

<Filter Template 
Name> - Saved by 
<User Name>

Opens the saved Filter template for the Status Changes pane. Limits the display in the 
pane to only the data (fields) that are defined by the template. See “To filter the data that is 
displayed in a tab pane” on page 32.
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Comments pane (Sample Data sub-tab on the Sample tab)
The Comments pane displays all the comments that have been added for the sample in 
reverse chronological order. You can-right click a comment in the pane to open a context 
menu with the following options:

Table 8-6: Sample tab, Sample Data sub-tab, Comments pane context menu

Option Description

Add Sample 
Comment

Opens the Add Sample Comment dialog box. You add a comment for the sample in the 
Add Comment field.

Figure 8-19:  Add Sample Comment dialog box

Note: If multiple comments have been added for a sample, then these comments are 
displayed in reverse chronological order in the Comments pane on this tab. Only the 
last added comment is displayed in the Comments field in the Samples pane on the 
Samples data sub-tab on the Patient tab and in the Samples pane on the Run tab.

Delete Sample 
Comment

Opens the Add Delete Comment dialog box. Click OK to delete the comment for the 
sample and close the dialog box.

Figure 8-20:  Delete Comment dialog box
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Patient pane (Sample Data sub-tab for the Sample tab)
The Patient pane displays information about the patient who is associated with the sample. If 
a patient is not associated with the sample, then Set Patient is available on the context menu 
for the pane and you can associate one. You can also right-click anywhere on the information 
for the associated patient to open a context menu with the following options:

     

Add All To Custom 
Report

Selects all the information that is displayed for the selected patient for inclusion in a 
custom report. See Chapter 10, “Geneticist Assistant Reports,” on page 267.

Load Columns

Manually Opens the Select Columns dialog box in which you can select columns that are to be 
shown and clear the columns that are to be hidden dynamically, or select a configuration 
from the list of available column configurations. This option is also available on the column 
header context menu for the sub-tab.

Note: For information about showing and hiding columns dynamically, see “To show/hide 
columns in a tab pane” on page 37.

Note: If you set column display preferences here, then you can display preferences for 
variants in all the variant sub-tabs and panes (with the exception of the Sample 
Group columns on the Sample Variant Data sub-tab on the Sample tab and the 
Variant pane on the Variant tab) in a single step. See “To apply shared preferences 
or to clear all tab preferences” on page 58.

Compact Displays the data columns on the sub-tab in a more condensed view. To toggle the display, 
click Compact as needed.

<Saved Pane 
Configuration Name> 
- Saved by <User 
Name>

Publicly available pane configurations. The name of the user who created a pane 
configuration is displayed next to the configuration name.

Load Filters

Manually Opens the Filters table for the Comments pane. See “To filter the data that is displayed in a 
tab pane” on page 32.

<Filter Template 
Name> - Saved by 
<User Name>

Opens the saved Filter template for the Comments pane. Limits the display in the pane to 
only the data (fields) that are defined by the template. See “To filter the data that is 
displayed in a tab pane” on page 32.

Table 8-6: Sample tab, Sample Data sub-tab, Comments pane context menu (Continued)

Option Description

Table 8-7: Sample tab, Sample Data sub-tab, Patient pane context menu

Option Description

Add All To Custom 
Report

Selects all the information that is displayed for the selected patient for inclusion in a 
custom report. See Chapter 10, “Geneticist Assistant Reports,” on page 267.

Add Patient External 
ID to Custom Report

Selects only the External ID for the patient for inclusion in a custom report. See Chapter 
10, “Geneticist Assistant Reports,” on page 267.

Set Patient Opens the Set Patient dialog box in which you can associate a patient with a sample. See 
“To associate a patient with a sample” below.
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To associate a patient with a sample

1. If you have not already done so, do one of the following to open the Sample tab for the 
sample:

• Right-click a sample entry on the Run tab, and on the context menu that opens, 
select Sample Details.

• Double-click a sample entry on the Run tab.

2. Open the Sample Data sub-tab.

3. Right-click in the Patient pane, and on the context menu that opens, click Set Patient.

The Set Patient dialog box opens. The dialog box lists all the patients in your Geneticist 
Assistant database.

Figure 8-21:  Set Patient dialog box

4. Select the patient, and then click OK.

The Set Patient dialog box closes. The patient information is displayed in the Patient 
pane.

Related Patients pane
The Related Patients pane displays all the relatives of the patient who is associated with the 
sample. Right-click a patient in the Related Patients pane to open a context menu with the 
following options:

Table 8-8: Sample tab, Related Patients pane context menu

Option Description

Patient Details Opens the Patient tab for the selected related patient. All the options on the Patient tab are 
now available for the related patient. See “Accessing and Reviewing Patient Records” on 
page 112.

Note: You can also double-click a patient entry to open the Patient tab.
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Add New 
Relationships

The Add New Patient dialog box opens. By default, the Is Related to Existing Patient 
option is selected and unavailable. Add the needed relationships for the patient. See Step 
3 of “To add new patients one at a time” on page 107.

Remove Patient’s 
Relationships

Deletes the selected relationship for the patient. To remove multiple relationships, CTRL-
click as you select the relationships.

Add All To Custom 
Report

Selects all the information that is displayed for the selected patient for inclusion in a 
custom report. See Chapter 10, “Geneticist Assistant Reports,” on page 267.

Load Columns

Manually Opens the Select Columns dialog box in which you can select columns that are to be 
shown and clear the columns that are to be hidden dynamically, or select a configuration 
from the list of available column configurations. This option is also available on the column 
header context menu for the sub-tab.

Note: For information about showing and hiding columns dynamically, see “To show/hide 
columns in a tab pane” on page 37.

Note: If you set column display preferences here, then you can display preferences for 
variants in all the variant sub-tabs and panes (with the exception of the Sample 
Group columns on the Sample Variant Data sub-tab on the Sample tab and the 
Variant pane on the Variant tab) in a single step. See “To apply shared preferences 
or to clear all tab preferences” on page 58.

Compact Displays the data columns on the sub-tab in a more condensed view. To toggle the display, 
click Compact as needed.

<Saved Pane 
Configuration Name> 
- Saved by <User 
Name>

Publicly available pane configurations. The name of the user who created a pane 
configuration is displayed next to the configuration name.

Load Filters

Manually Opens the Filters table for the Related Patients pane. See “To filter the data that is 
displayed in a tab pane” on page 32.

<Filter Template 
Name> - Saved by 
<User Name>

Opens the saved Filter template for the Related Patients pane. Limits the display in the 
pane to only the data (fields) that are defined by the template. See “To filter the data that is 
displayed in a tab pane” on page 32.

Table 8-8: Sample tab, Related Patients pane context menu (Continued)

Option Description
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Reports pane (Sample data sub-tab on the Sample tab)
The Reports pane displays all the reports that were generated for the selected sample and 
saved to the Geneticist Assistant database.

You can right-click anywhere on this sub-tab to open a context menu with options that are 
identical to the options that are on context menu for the Reports pane on the Patient sub-tab 
on the Patient tab. See “Patient tab, Patient sub-tab, Reports pane” on page 126.

You can also select Reports > Saved Reports on the Geneticist Assistant main 
menu to open a Sample Reports tab that includes these same reports.

For detailed information about generating and saving both standard and custom 
Sample reports, see Chapter 10, “Geneticist Assistant Reports,” on page 267.
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Many options are available from the Variant tab for reviewing your data in Geneticist 
Assistant.

This chapter covers the following topics:

• “Overview of the Variant Tab” on page 247.

• “Working with Reference Information Panes on the Variant Tab” on page 257.
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Overview of the Variant Tab
The Variant tab displays detailed information for a selected variant. To open the Variant tab, 
do one of the following:

• Double-click a variant on the Variants sub-tab on the Patient tab.

• Double-click a variant on the Variant sub-tab on the Panel Statistics tab.

• Right-click a variant on the Sample Variant Data sub-tab on the Sample tab, and on the 
context menu that opens, select Variant Details.

• Double-click a variant on the Sample Variant Data sub-tab on the Sample tab.

Figure 9-1:  Variant tab

By default, the Variant tab displays 16 panes when it first opens. The panes are of two types: 
variant information panes, which display user-specified information for a variant such as its 
pathogenicity, any comments, its artifact type, and so on, and reference information panes, 
which display information about the variant that has been culled from a specific reference 
database such as the dbSNP database. Every pane has a context menu associated with it. 
Some of the menu commands that are available are common to all the pane context menus, 
and some are pane-specific. See:

• “Variant information panes” on page 248.

• “Reference information panes” on page 256.

If any of the reference information panes are not displayed, contact SoftGenetics 
to download the latest reference files.
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Variant information panes
Variant information panes display user-specified information for a variant such as its 
pathogenicity, any comments, its artifact type, and so on. By default, the following eight 
variant information panes are displayed on the Variant tab when it first opens:

• “Variant pane” on page 249.

• “Supporting Information pane” on page 251.

• “Variant Comments pane” on page 252.

• “Pathogenicity Changes pane” on page 253.

• “Artifact Changes pane” on page 253.

• “Variant Changes pane” on page 253.

• “Associated Samples pane” on page 253.

• “Variant’s Reports pane” on page 255.

The following commands are displayed on the context menu for every variant information 
pane:

Because so many panes can be displayed on the Variant tab, remember, you can 
always select which panes to show and which to hide to make it easier for you to 
review variant data. See “To show/hide a tab pane” on page 32.

Option Description

Add All To Custom 
Report

Selects all the information that is displayed in the pane for inclusion in a custom report. 
See Chapter 10, “Geneticist Assistant Reports,” on page 267.

Load Columns

Manually Opens the Select Columns dialog box in which you can select columns that are to be 
shown and clear the columns that are to be hidden dynamically, or select a configuration 
from the list of available column configurations. This option is also available on the column 
header context menu for the sub-tab.

Note: For information about showing and hiding columns dynamically, see “To show/hide 
columns in a tab pane” on page 37.

Note: If you set column display preferences here, then you can display preferences for 
variants in all the variant sub-tabs and panes (with the exception of the Sample 
Group columns on the Sample Variant Data sub-tab on the Sample tab and the 
Variant pane on the Variant tab) in a single step. See “To apply shared preferences 
or to clear all tab preferences” on page 58.

Compact Displays the data columns on the sub-tab in a more condensed view. To toggle the display, 
click Compact as needed.

<Saved Pane 
Configuration Name> 
- Saved by <User 
Name>

Publicly available pane configurations. The name of the user who created a pane 
configuration is displayed next to the configuration name.
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Variant pane

The Variant pane is a read-only pane that lists all the same information that is displayed by 
default for the variant on the Sample Variant Data sub-tab. (See “Sample Variant Data sub-
tab” on page 218.) You can right-click in the pane to open a context menu that, in addition to 
the command pane commands, has the following pane-specific commands: 

Load Filters

Manually Opens the Filters table for the pane. See “To filter the data that is displayed in a tab pane” 
on page 32.

<Filter Template 
Name> - Saved by 
<User Name>

Opens the saved Filter template for the pane. Limits the display in the pane to only the 
data (fields) that are defined by the template. See “To filter the data that is displayed in a 
tab pane” on page 32.

Option Description

Option Description

Submit Supporting 
Hyperlink

Opens the Add Supporting Info dialog box, which, by default, displays the dbSNP web 
page for the variant. You can use the browser in this dialog box to select this web page as 
supporting information for the variant, or navigate to a different page. 

Figure 9-2:  Add Supporting Info dialog box

Note: See Step 9 of “To add supporting information for a variant” on page 257.
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Add Comment Opens the Add Variant Comment dialog box. You can add a comment for the variant in the 
Add Comment field, and then click OK. The comment is displayed in the Variant Comment 
field in the Variant pane on the Variant tab, the Variant Comments pane on the Variant tab, 
the Variant Comment field in the Variants pane on the Search Results tab, the Variant 
Comment field on the Variants sub-tab on the Patient tab, and the Variant Comment field 
on the Sample Variant Data sub-tab on the Sample tab.

Figure 9-3:  Add Variant Comment dialog box

Note: If multiple comments have been added for a variant, then with the exception of the 
Variant Comments pane on the Variant tab, only the last added comment is 
displayed in all the locations that are detailed above. All the comments that have 
been added for a variant, including the last added, are displayed in reverse 
chronological order in the Variant Comments pane on the Variant tab.

Option Description
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Supporting Information pane

The Supporting Information pane displays all the reference information and/or links that you 
have submitted as supporting information for a variant. (See “To add supporting information 
for a variant” on page 257.) You can right-click in the pane to open a context menu that, in 
addition to the command pane commands, has the following pane-specific commands: 

     

Option Description

Submit Supporting 
Hyperlink

Opens the Add Supporting Info dialog box, which, by default, displays the dbSNP web 
page for the variant. You can use the browser in this dialog box to select this web page as 
supporting information for the variant, or navigate to a different page. 

Figure 9-4:  Add Supporting Info dialog box

Note: See Step 9 of “To add supporting information for a variant” on page 257.
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Variant Comments pane

The Variant Comments pane displays all the comments that have been added for the variant 
in reverse chronological order. You can right-click in the pane to open a context menu that, in 
addition to the command pane commands, has the following pane-specific commands: 

Option Description

Add Comment Opens the Add Variant Comment dialog box. You can add a comment for the variant in the 
Add comment field, and then click OK. The comment is displayed in the Variant Comment 
field in the Variant pane on the Variant tab, the Variant Comments pane on the Variant tab, 
the Variant Comment field in the Variants pane on the Search Results tab, the Variant 
Comment field on the Variants sub-tab on the Patient tab, and the Variant Comment field 
on the Sample Variant Data sub-tab on the Sample tab.

Figure 9-5:  Add Variant Comment dialog box

Note: If multiple comments have been added for a variant, then with the exception of the 
Variant Comments pane on the Variant tab, only the last added comment is 
displayed in all the locations that are detailed above. All the comments that have 
been added for a variant, including the last added, are displayed in reverse 
chronological order in the Variant Comments pane on the Variant tab.

Delete Comment Opens the Delete Comment dialog box. Click OK to delete the comment for the variant 
and close the dialog box.

Figure 9-6:  Delete Comment dialog box
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Pathogenicity Changes pane

The Pathogenicity Changes pane displays the history of the changes that have been made to 
the pathogenicity for the variant in reverse chronological order. When a variant is first added 
to the Geneticist Assistant database, the Pathogenicity is set to Unassigned and the 
Pathogenicity Status does not have a value. If the Pathogenicity is changed to Deleterious, 
and the Status is set to Confirmed, for example, then this change and the name of the user 
who made the change, and the date and the time of the change are recorded and displayed in 
this pane. For a description of the context menu options for the pane, see “Variant 
information panes” on page 248.

Artifact Changes pane

The Artifact Changes pane displays the history of the changes that have been made to the 
artifact type for the variant in reverse chronological order. When a variant is first added to 
the Geneticist Assistant database, the Artifact Type is set to None. If the Artifact Type is set 
to Sequencing, for example, then this change and the name of the user who made the change, 
and the date and the time of the change are recorded and displayed in this pane. For a 
description of the context menu options for the pane, see “Variant information panes” on 
page 248.

Variant Changes pane

The Variant Changes pane displays the history of the changes that have been made to the 
variant in reverse chronological order, for example, a change in the zygosity of the variant 
from heterozygous to homozygous. The value that was changed for the variant, the name of 
the user who made the change, and the date and the time of the change are recorded and 
displayed in this pane. For a description of the context menu options for the pane, see 
“Variant information panes” on page 248.

Associated Samples pane

The Associated Samples pane lists all the samples in which the variant has been identified. 
You can right-click in the pane to open a context menu that, in addition to the command pane 
commands, has the following pane-specific commands: 

Option Description

Sample Detail Opens the Sample tab for the sample. See Chapter 8, “Geneticist Assistant Data Review - 
Sample Tab,” on page 215.

Permissions Opens the Permissions dialog box.You use the options on this dialog box to set or modify 
the permissions (Can Read or Can Read and Can Write) that the specified users or groups 
are to have for selected samples. If you are an Administrator user, then you can set or 
modify the permissions for a sample that any user has submitted. If you are a standard 
user, then you can set or modify the permissions for only those samples that you have 
submitted to the Geneticist Assistant database, or for those samples that other users have 
submitted and to which you have been granted Can Read and Can Write permissions. See 
“To set or modify the Read/Write permissions for the samples in which a selected variant 
was found” on page 254.
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To set or modify the Read/Write permissions for the samples in which a 
selected variant was found

1. If you have not already done so, open the Variant tab for the appropriate variant.

2. In the Associated Samples pane, select the sample, or CTRL-click to select multiple for 
which the permissions are being set.

3. Right-click any selected sample, and on the context menu that opens, click Permissions.

The Permissions dialog box opens. 

Figure 9-7:  Permissions dialog box (Variant tab, Associated Samples pane)

• The first time that the dialog box opens, if any sample was submitted within a run 
using a Geneticist Assistant version with a build date of 4/8/15 or later, then the 
names of the users who submitted the runs are displayed in the lower pane of the 
dialog box and both the Can Read and Can Write permissions are selected. If a 
standard user submitted any run, then the Administrator user name is also displayed. 

• For samples that were submitted within runs using earlier versions of Geneticist 
Assistant, the pane is blank. For subsequent openings, the dialog box displays the 
names of all the users and/or groups and their assigned permissions for the samples.

4. Modify the permissions for any user or group as needed and then click OK; otherwise, to 
add permissions for a new user or group, go to Step 5.

     

You can add or remove the Can Write permission for a user or group, or you can 
remove both the Can Read and Can Write permissions. Removing the Can Read 
permission but leaving the Can Write permission selected for a user or group has 
no effect.
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5. Enter a user name (the login name for the user), or to assign the same permissions to 
multiple users in a single step, enter a group name.

As you enter a user name or a group name, a dropdown list opens. The list is 
dynamically updated with user names or group names that are in your Geneticist 
Assistant database and that match the search string that you are entering.

6. Select the appropriate user name or group name from the list, and then click Add.

The user name or group name is displayed in the lower pane of the dialog box. The Read 
permission is already assigned for the selected user or group. If just this permission is 
selected, then the user or group can simply view the sample records. They cannot modify 
them.

7. Optionally, if the user or group must be able to modify the sample records as well, then 
select the Can Write permission.

8. Click OK.

A Permission Updated message opens. 

9. Click OK. 

Both the message and the Permissions dialog box close. The specified permissions are 
set for the sample records.

Variant’s Reports pane

The Reports pane displays all the reports that were generated for the selected variant and 
saved to the Geneticist Assistant database.

You can right-click anywhere on this sub-tab to open a context menu with options that are 
identical to the options that are on context menu for the Reports pane on the Patient sub-tab 
on the Patient tab. See “Patient tab, Patient sub-tab, Reports pane” on page 126.

     

The search string is not case-sensitive, but the string must begin with the user or 
group name. For example, a search string of “Ja” or “ja” returns a user with the 
name of Jane Doe, but a search string of “Doe” does not.

You can also select Reports > Saved Reports on the Geneticist Assistant main 
menu to open a Reports tab that includes these same reports.

For detailed information about generating and saving both standard and custom 
Run reports, see Chapter 10, “Geneticist Assistant Reports,” on page 267.
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Reference information panes
By default, the following eight reference information panes are always displayed when the 
Variant tab first opens:

You can right-click any information in any of these reference information panes to open a 
context menu with the following options:

Database Description

OMIM Data pane Displays the information for the variant from the OMIM (Online Mendelian Inheritance in 
Man) database. 

Note: To view OMIM data, OMIM settings must be configured for your Geneticist Assistant 
installation. See “To specify the OMIM settings” on page 65.) 

LOVD Data pane Displays the information for the variant from the LOVD (Leiden Open Variation Database) 
database. 

World-Wide LOVD 
Data pane

Displays information for the variant from the LOVD (Leiden Open Variation Database) 
world-wide database. 

dbSNP (*/00-All.vcf) 
pane

Displays the information for the variant from the dbSNP database.

Exome Variant 
Server (*/ESP*.vcf) 
pane

Displays the information for the variant from the Exome Variant Server database for the 
NHLBI GO Exome Sequencing Project (ESP).

Exome Aggregation 
Consortium 
(ExAC.r*.*.sites.vep.
vcf) pane

Displays the information for the variant from the Exome Aggregation Consortium database 
for selected global sequencing projects.

ClinVar (*/clinvar_00-
latest.vcf) pane

Displays the information for the variant from the ClinVar database.

dbNSFP pane Displays the information for the variant from the dbNSFP database.

Option Description

Submit as 
Supporting Info

Submits the information in the field as supporting information for a variant. See “To add 
supporting information for a variant” on page 257.

Add Values to Variant 
Table

Adds values from a selected field in the Reference database to the Variant pane and the 
Variants pane on the Sample Variant Data sub-tab on the Sample tab. You can also create 
a custom formula based on multiple fields and add the resulting value to the these same 
variant panes and tables. See “To add fields from a reference database to variant tables 
and panes” on page 260 or “To add a custom field to variant tables and panes” on page 
262.
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Working with Reference Information Panes on 
the Variant Tab

A variety of options are available for working with the information that is displayed in the 
various reference information panes on the Variant tab. You can do the following:

• Add supporting information for a variant. See “To add supporting information for a 
variant” below.

• Add fields from a reference database to variant tables and panes. See “To add fields from 
a reference database to variant tables and panes” on page 260.

• Add a custom field to variant tables and panes. See “To add a custom field to variant 
tables and panes” on page 262.

To add supporting information for a variant
You can add supporting information for a variant. Typically, this is information that you used 
to determine the appropriate pathogenicity for the variant. You can reference information 
from an external database or from a web page as supporting information. The supporting 
information is displayed in the Supporting Information pane on the Variant tab. (See 
“Supporting Information pane” on page 251.) 

1. If you have not done so already, do one of the following to open the Variant tab:

• Double-click a variant on the Variants sub-tab on the Patient tab.

• Double-click a variant on the Variant sub-tab on the Panel Statistics tab.

• Right-click a variant on the Sample Variant Data sub-tab on the Sample tab, and on 
the context menu that opens, select Variant Details.

• Double-click a variant on the Sample Variant Data sub-tab on the Sample tab.

2. Do one of the following:

• To reference information from any reference track, go to Step 3. 

• To reference a specific web page, go to Step 8.

3. In the appropriate reference information pane, review the information that is to be used 
for supporting information. See “Reference information panes” on page 256.

 

     

This information is included in the References folder. Use the scroll bar at the 
bottom of the pane to view the available reference information for the variant. 
Note that all reference information is not available for all variants. 
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4. Right-click any information in a pane, and on the context menu that opens, click Submit 
As Supporting Info.

The Supporting Info Submit dialog box opens. The dialog box lists all the reference 
information and the corresponding values that can be selected from the pane as 
supporting information. 

Figure 9-8:  Supporting Info Submit dialog box

5. Select the information that is to be used as supporting information, and then click OK.

The Add Supporting Info dialog box closes. The information is displayed in the 
Supporting Information pane. See “Supporting Information pane” on page 251.

6. Repeat Step 3 through Step 5 for each piece of reference information that is to be added 
as supporting information.

7. Optionally, continue to Step 8 to also add supporting information for the variant from a 
web page.
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8. Right-click anywhere on the Variant pane or the Supporting Information pane, and on 
the context menu that opens, click Submit Supporting Hyperlink.

The Add Supporting Info (for a web page) dialog box opens. By default, the dialog box 
displays the dbSNP page for the variant. 

Figure 9-9:  Add Supporting Info dialog box

9. Do one of the following:

• Click the Use This Link icon  to accept the NCBI dbSNP page. The URL is 

added under Supporting Info on the dialog box.

• Enter a new URL, click the Go To icon  to navigate to the web page, and then 

click the Use This Link icon  to accept the web page. The URL is added under 

Supporting Info on the dialog box.

10. Click OK.

The Add Supporting Info dialog box closes. The URL is displayed in the Supporting 
Information pane on the Variant tab. See “Supporting Information pane” on page 251.

     

You can also use the Add Supporting Info dialog box like a standard web browser 
and search for the necessary URL.
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To add fields from a reference database to variant tables and 
panes

You can add fields from a reference database to the Variant pane and the Variants pane on the 
Sample Variant Data sub-tab on the Sample tab. Fields in the reference database can contain 
single values, or they can contain multiple values. For example, the Allele Frequency (AF) 
field in the ExAC Reference database contains a frequency value for the variant nucleotide 
and a frequency value for the reference nucleotide. Depending on the options that you 
specify, the field can be added with a just a single value (for example, the value for just the 
variant nucleotide), or the field can be added with multiple values (the values for both the 
variant nucleotide and the reference nucleotide). 

1. If you have not done so already, do one of the following to open the Variant tab:

• Double-click a variant on the Variants sub-tab on the Patient tab.

• Double-click a variant on the Variant sub-tab on the Panel Statistics tab.

• Right-click a variant on the Sample Variant Data sub-tab on the Sample tab, and on 
the context menu that opens, select Variant Details.

• Double-click a variant on the Sample Variant Data sub-tab on the Sample tab.

2. Right-click in the appropriate reference information pane, for example, the ExAC Data 
pane, and on the context menu that opens, click Add Values to Variant Table.

The Add Values to Variant Table dialog box opens. The dialog box lists all the fields in 
the selected Reference database. It also provides a description of the value that is 
contained in each field.

Figure 9-10:  Add Values to Variant Table dialog box

     
260 Geneticist Assistant User’s Manual



Chapter 9
Geneticist Assistant Data Review - Variant Tab
3. Do one of the following to select a field:

• Double-click the field.

• Right-click the field, and on the context menu that opens, click Add Value(s).

The Field Configuration dialog box opens. You use the options on the dialog box to 
specify which values in the selected field are to be added to the various variant panes and 
tables. 

Figure 9-11:  Field Configuration dialog box

4. Select the values in the field that are to be added to the various panes and tables.

     

Value Description and Options

R (one value for each possible 
allele including the reference)

The field contains multiple values, with one value for each 
possible allele, including the reference allele.

• All alleles - Add all values for all possible alleles (multiple 
values)

• Matching Alt allele - Add the value only for the matching 
alternate allele (single value)

• Ref allele - Add the value only for the reference allele (single 
value)

A (one value per alternate allele The field can contain multiple values, with one value for each 
alternate allele.

• All alt alleles - Add all values for all alternate alleles (multiple 
values possible if more than one alternate allele exists)

• Match Alt allele - Add the value only for the matching 
alternate allele (single value)

Fixed Value • All - Add all values (multiple values)

• Fixed - Add only the specified number of fixed values. If 1 is 
specified, then this is a single value; otherwise, 2 or greater 
adds multiple values.

. (number of possible values 
varies, is unknown, or is 
unfounded)

Based on different variants, the number of values in the field can 
vary. 
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5. Click OK.

The Field Configuration dialog box closes. The Add Values to Variant Table dialog box 
remains open.

6. Optionally, to change the name of a Field tab, select the tab to make it the active tab, and 
then in the Column Name field, enter a new name.

7. Optionally, to add another field, click the (+) tab to open a new blank Field tab, and then 
repeat Step 3 through Step 6 to add the field to the various panes and tables for the 
selected variant. Repeat these steps as many times as needed to add all the necessary 
fields.

8. Click OK on the Add Values to Variant Table dialog box.

The selected field is added to the various variant tables and panes. The dialog box closes. 
The Variant tab remains open.

To add a custom field to variant tables and panes
You can combine multiple fields in a reference database to create a custom field, and then 
add the custom field and its value to the Variant pane and the Variants pane on the Sample 
Variant Data sub-tab on the Sample tab. When you select a reference database field to use for 
creating a custom field, if the field contains multiple values, then you can select only a single 
value from the field. For example, the Allele Frequency (AF) field in the ExAC Reference 
database contains a frequency value for the variant nucleotide and a frequency value for the 
reference nucleotide. If you select the AF field, then you must select either the frequency 
value for the variant nucleotide or the frequency value for the reference nucleotide. You 
cannot select both values.

1. If you have not done so already, do one of the following to open the Variant tab:

• Double-click a variant on the Variants sub-tab on the Patient tab.

• Double-click a variant on the Variant sub-tab on the Panel Statistics tab.

• Right-click a variant on the Sample Variant Data sub-tab on the Sample tab, and on 
the context menu that opens, select Variant Details.

After you select the values that are to be added, the following happens:

• A tab that is named the same as the selected field, a Field tab, opens below the 
list of available fields.

• A preview of the selected field and its values is displayed in the Work Area of the 
dialog box (the blank area below the Field tab).

• A preview of the selected field and its values is also displayed in the Preview 
pane (the bottom pane of the dialog box).

If you add a field in error, then right-click it in the Work Area, and on the context 
menu that opens, click Remove. 
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• Double-click a variant on the Sample Variant Data sub-tab on the Sample tab.

2. Right-click in a Reference pane, and on the context menu that opens, click Add Values to 
Variant Table.

The Add Values to Variant Table dialog box opens. The dialog box lists all the fields in 
the selected Reference database. It also provides a description of the value that is 
contained in each field. 

Figure 9-12:  Add Values to Variant Table dialog box

3. Do one of the following to select a field:

• Double-click the field.

• Right-click the field, and on the context menu that opens, click Add Value(s).

The Field Configuration dialog box opens. You use the options on the dialog box to 
specify the field value that is to be used for the custom formula.

Figure 9-13:  Field Configuration dialog box

4. Select the value in the field that is to be used in the formula for the custom field.
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5. Click OK.

6. Do one of the following:

• Click in the Add Text field, enter the needed text (for example, if you are creating a 
field to show a ratio, you might select a forward slash), and then click Add Text.

The text is displayed on the Field tab and in the Work Area and the Preview pane.

• To create a formula, select Formula, and then select the operator for the formula. 
Parentheses are also available for setting the order of operations in the formula.

As you create the formula, the following happens:

• A preview of the formula, including the selected fields, their values, and the 
operators, is displayed on the Field tab and in the Work area of the dialog box 
(the blank area below the tabs).

• The Preview pane displays the current value for the formula. 

Value Description and Options

R (one value for each 
possible allele 
including the 
reference)

The field contains multiple values, with one value for each possible allele, 
including the reference allele. Therefore, the values that you can select 
are the following:

• Matching Alt allele - Add the value only for the matching alternate allele 
(single value)

• Ref allele - Add the value only for the reference allele (single value)

A (one value per 
alternate allele

The field can contain multiple values, with one value for each alternate 
allele. Therefore, the values that you can select are the following:

• All alt alleles - Add all values for all alternate alleles (A single value if 
only one alternate allele exists; however, multiple values possible if 
more than one alternate allele exists)

• Match Alt allele - Add the value only for the matching alternate allele 
(single value)

Fixed Value • Fixed - Add only the specified number of fixed values. If 1 is specified, 
then this is a single value

After you select the value that is to be added, the following happens:

• A tab that is named the same as the selected field, a Field tab, opens below the 
list of available fields.

• A preview of the selected field and its value is displayed in the Work area of the 
dialog box (the blank area below the Field tab).

• A preview of the selected field and its value is also displayed in the Preview 
pane (the bottom pane of the dialog box).

If you add a field, a text separator, or an operator in error, then right-click it in the 
Work Area, and on the context menu that opens, click Remove. 
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7. Repeat Step 3 through Step 6 as needed to produce the final custom field.

As you select multiple fields for the custom field, the display on the Field tab and in the 
Work Area and the Preview pane are dynamically updated.

8. Optionally, to add another custom field, click the (+) tab to open a new blank tab, and 
then repeat Step 3 through Step 7. Repeat these steps as many times as needed to add all 
the necessary custom fields.

9. Optionally, to change the name of the Field tab, select the tab to make it the active tab, 
and then in the Column Name field, enter a new name for the tab.

10. Click OK.

The Field Configuration dialog box closes. The Add Values to Variant Table dialog box 
remains open. 

11. Click OK on the Add Values to Variant Table dialog box.

The custom fields are added to the various variant tables and panes. The dialog box 
closes. The Variant tab remains open.
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As discussed in the various data review chapters in this manual, after a run is successfully 
completed, many options are available for reviewing the data on the various tabs and panes 
on the Geneticist Assistant main window. If you want to generate an output file of the data, 
then you have two options. You can generate a standard report, or you can select some or all 
of the data for inclusion in a custom report. 

This chapter covers the following topics:

• “Generating a Standard Report” on page 269.

• “Generating a Custom Report” on page 273.
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Generating a Standard Report
To generate an output file of the data after a run is successfully completed, you generate a 
standard report. A standard report includes all the data that is displayed in a selected pane or 
panes on a data tab, for example, the Samples pane on the Run tab. Six different standard 
reports are available in Geneticist Assistant:

• Run report—You generate the standard Run report from the Run tab. The report includes 
all the information that is displayed in the Samples pane and/or the Run's Status Changes 
pane on the tab.

• Coverage Regions report—You generate the Coverage Regions report from the Coverage 
Regions tab. The report includes all the information that is displayed on the tab.

• Panel Statistics reports—You generate a standard Panel Statistics report from the Panel 
Statistics tab. The report includes all the information that is displayed in any of the 
following four sub-tabs that you specify—Coverage Regions, Samples, Variants, and/or 
Patients.

• Sample report—You generate a standard Sample report from the Sample tab. The report 
includes all the information that is displayed in the panes that you specify— the Variants 
pane on the Sample Variant Data sub-tab and/or any of the four panes (Status Changes, 
Patient, Related Patients, or Comments) on the Sample Data sub-tab.

• Variant report—You generate a standard Variant report from the Variant tab. The report 
includes all the information that is displayed in any of the following five panes that you 
specify—Variant, Pathogenicity Changes, Artifact Changes, Variant Changes, Variant 
Comments, Supporting Information, and/or Associated Samples.

• Action List report—You generate the Action List report from the Action List tab. The 
report includes all the information that is displayed in the panes that you specify—the 
Variants pane and/or the Coverage Regions pane.

To generate a standard report
1. Open the appropriate tab. See:

• Chapter 7, “Geneticist Assistant Data Review - Run Tab,” on page 179.

• “Coverage Regions tab” on page 192.

• The Panel Statistics tab: See “Reviewing Panel Statistics” on page 98, “To calculate 
panel statistics (Runs tab)” on page 163 or “To calculate panel statistics (Run tab)” 
on page 197. 

• Chapter 8, “Geneticist Assistant Data Review - Sample Tab,” on page 215.

• Chapter 9, “Geneticist Assistant Data Review - Variant Tab,” on page 245.
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2. Do one of the following:

The appropriate report dialog box, for example, the Run Report or Sample dialog box, 
opens. All the data that can be selected for inclusion in the report is displayed in the 
Sections and Tables pane of the dialog box. 

Figure 10-1:  Run Report dialog box

To generate an Action List report, you must first create the Action List to open the 
Action List tab. See “To add selected panel regions or variants to an Action List” 
on page 195 or “To add selected panel regions or variants to an Action list” on 
page 235.

Table 10-1: Available standard reports

Report to be Generated Action

Run On the Geneticist Assistant main menu, click Reports > Run 
Report.

Coverage Regions On the Geneticist Assistant main menu, click Reports > 
Coverage Regions Report.

Panel Statistics On the Geneticist Assistant main menu, click Reports > Panel 
Statistics Report.

Sample On the Geneticist Assistant main menu, click Reports > Sample 
Report.

Variant On the Geneticist Assistant main menu, click Reports > Variant 
Report.

Action List On the Geneticist Assistant main menu, click Reports > Action 
List report.
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3. Optionally, to remove a sub-tab or pane from the report, right-click the row for the 
sub-tab or pane, and then click “Remove Selected Row” to remove the data from the 
indicated pane or sub-tab from inclusion in the report.

4. Select the report type.

5. Optionally, for reports that contain variants, such as the Sample report, the Variant 
report, or the Action List report, select one or both of the following:

• HGVS Coding/Translation: separate row, separate columns: If multiple transcripts 
are shown for the HGVS Coding or HGVS Protein for a variant, then select this 
option to create a separate row for each transcript and two separate columns—one 
for the transcript ID and one for the actual call—within each row.

• Report Supporting Info For Variants: If supporting information has been added for 
any of the variants for which you are generating the report, then select this option to 
include this supporting information in a separate Supporting Information section in 
the report.

6. Do any or all of the following as needed:

Only the data columns that are shown in the selected sub-tabs or panes at the time 
that the report is generated are included in the report. Hidden data columns are 
not included. See “To show/hide columns in a tab pane” on page 37.

Four formats are available—PDF (the default value), HTML, XML, or CSV, which 
is a comma-separated values file.

Table 10-2: Standard report options

Option Description

Click Preview To preview the report in the Preview pane on the Report dialog box before you 
print it and/or save it. After you click Preview, two new options become available:

• Close Preview—Close the Preview and leave a blank Report dialog box 
open.

• Refresh—Refresh the preview in real time.

Click Save As To save the report. You must specify the name of the report and the location for 
the saved report.

Click Print To print the report.
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7. Click Close to close the Report dialog box.

Save to 
Database

To save the report to the Geneticist Assistant database. When you select this 
option, a Report Name dialog box opens. Regardless of the options that were 
selected for the report, the same default name is displayed for the report. For 
example, if you generate a standard Sample report, then the default report name 
is always the sample name.

Figure 10-2:  Report Name dialog box

Note: If you have previously saved a report with the default name, then you can 
enter a new name to distinguish the new report from the previously saved 
report.

Note: If filters were applied to the data for which you are generating the report, then these filters 
are explicitly displayed in a separate Filters Applied section in the report. 

Table 10-2: Standard report options (Continued)

Option Description
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Generating a Custom Report
If you want to generate a custom output file of the data after a run is successfully completed, 
you can generate a custom report. A custom report contains only selected data that you 
specify from a data tab or tabs. 

To generate a custom report
1. Open the appropriate tab. See:

• Chapter 7, “Geneticist Assistant Data Review - Run Tab,” on page 179.

• “Coverage Regions tab” on page 192.

• The Panel Statistics tab: See “Reviewing Panel Statistics” on page 98, “To calculate 
panel statistics (Runs tab)” on page 163 or “To calculate panel statistics (Run tab)” 
on page 197. 

• Chapter 8, “Geneticist Assistant Data Review - Sample Tab,” on page 215.

• Chapter 9, “Geneticist Assistant Data Review - Variant Tab,” on page 245.

2. Right-click the data that are you including in a custom report, and then select an 
appropriate option: 

• Add Selected < > to Custom Report—Adds only the data that you select to the 
custom report. You must CTRL-click to select multiple items for inclusion in the 
report.

• Add All to Custom Report—Adds all the data that is currently displayed in the pane 
to the custom report.

3. On the Geneticist Assistant main menu, click Reports > Custom Report.

The Custom Report dialog box opens. All the data that is to be included in the report is 
displayed in the Sections and Tables pane of the dialog box. See Figure 10-3 on page 
274.

To generate an Action List report, you must first create the Action List to open the 
Action List tab. See “To add selected panel regions or variants to an Action List” 
on page 195 or “To add selected panel regions or variants to an Action list” on 
page 235.

For both options, only the columns that are shown in the pane can be selected for 
inclusion in the report. Hidden data columns cannot be selected. See “To show/
hide columns in a tab pane” on page 37.
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Figure 10-3:  Custom Report dialog box

4. Optionally, if data has been selected in error for the custom report, or you want to 
remove some selected data before you generate the report, right-click the entry in the 
Sections and Tables pane, and on the context menu that opens, click Remove Selected 
Row.

5. Select the report type.

     

If you previously generated a custom report, and you did not click Clear All before 
you clicked Cancel, or closed the report dialog box, then any new information that 
you select on any tab for inclusion in a custom report is simply appended to this 
existing report. 

Four formats are available—PDF (the default value), HTML, XML, or CSV, which 
is a comma-separated values file.
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6. Do any or all of the following as needed:

7. Click Clear All.

8. Click Close to close the Report dialog box.

Table 10-3: Custom report options

Option Description

Click Preview To preview the report in the Preview pane on the Report dialog box before you 
print it and/or save it. After you click Preview, two new options become available:

• Close Preview—Close the Preview and leave a blank Report dialog box 
open.

• Refresh—Refresh the preview in real time.

Click Save As To save the report. You must specify the name of the report and the location for 
the saved report.

Click Print To print the report.

Save to 
Database

To save the report to the Geneticist Assistant database. When you select this 
option, a Report Name dialog box opens. Regardless of the options that were 
selected, the report name is always given the same default name, 
Custom_Report.

Figure 10-4:  Report Name dialog box

1. Rename the report.

2. Click OK.

Note: You should rename the report, even though you are not required to do so. 
Each custom report is saved at its own entry with a unique date and 
timestamp in the Geneticist Assistant database; however, if you do not 
change the report name, then each entry is also displayed with the same 
name in the appropriate Reports pane and therefore, one entry is not 
distinguishable from another.

This ensures that information that is selected for a new custom report is not simply 
appended to an existing report.
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Geneticist Assistant contains several tools for working with and analyzing your sample data, 
including a tool for building a BED file, a tool for managing pathogenicity changes, a tool 
for specifying pathogenicities for specific variants in a panel, and a tool for combining BAM 
files into a single sample.

This chapter covers the following topics:

• “Building a BED File with the BED File Builder Tool” on page 279.

• “Deleting Pathogenicity Changes with the Delete Pathogenicity Changes Tool” on page 
283.

• “Importing Variants with the Import Variants Tool” on page 285.

• “Merging BAM Files with the Merge BAM Files Tool” on page 288.
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Building a BED File with the BED File Builder 
Tool

You use BED files to create panels for Geneticist Assistant. A BED file defines the genomic 
regions that are targeted for your particular study or test, which are referred to as panel 
regions. If do not have a BED file for a panel, you can use the BED File Builder tool to build 
one based on the information that you specify. 

To build a BED file with the BED File Builder tool
1. On the Geneticist Assistant main menu, click Tools > BED File Builder.

The BED File Builder dialog box opens.

Figure 11-1:  BED File Builder dialog box

2. Do one of the following:

• To manually specify the gene name, in the Gene Name field, enter the name for the 
gene that is in the panel, and then click Add Gene. Repeat this step for each gene that 
is in the panel.

As you enter the gene name, a list of all genes in the database that meet the search 
criteria is dynamically updated. You can select the gene from this list. The search 
is not case-sensitive, but the search string must begin with the gene name. For 
example, a search string of “as” returns ASH1L-AS1 but a search string of “as1” 
does not.
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• To load the gene names from a file, click the Browse button  to open the Select a 
gene file dialog box, browse to and select the correct file, and then click Load Genes.

The following information is displayed for all the different transcripts that are available 
for the gene in the top pane of the dialog box—Region Name, Chromosome, Region 
Start position, Region End position, and Region Length.

3. Select the mode, which determines the information that is available for creating the BED 
file.

4. Do one of the following:

• For Exon mode and All Exon mode—Select the appropriate transcript, or click the 
Expand icon  next to the transcript, and then select the coding region and/or 
untranslated regions for building the BED file.

Figure 11-2:  BED File Builder tool, Exon mode

• For Transcript mode—Select the appropriate transcript.

     

The file must be a text file with one line per gene. Optionally, you can specify a 
transcript for each gene, with a tab between the gene name and the transcript.

Mode Description

Exon The default mode. You can include only the coding regions in the BED 
file, only the untranslated regions, or both. Introns are not included in 
Exon mode.

Transcript mode Adds the full transcript, including introns, to the BED file.

All Exon Mode Includes all the specified exons from all the selected transcripts in the 
BED file. You can include only the coding regions in the BED file, only 
the untranslated regions, or both. Introns are not included in Exon 
mode.

Select an entire 
transcript, or click the 
Expand icon.

Specify the coding 
region and/or 
untranslated regions. 
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5. Optionally, do any or all of the following as needed:

Option Steps

To open the Preview pane and view 
a preview of the BED file

Click Preview. The information for each region 
(Chromosome, Region Start, Region End, Region Name, 
Score, and Strand) is displayed in the preview.

Note: For detailed information about the fields that are 
displayed in the preview, see https://
genome.ucsc.edu/FAQ/FAQformat.html#format1. 

You can leave the Preview pane open, or you can close it 
after viewing the BED file. If you leave the pane open, and 
then make any changes to any of the BED file settings, you 
must click Refresh to update the preview.

To adjust the region start and end 
positions

Enter a different Region Start and/or Region End value (the 
default value is zero). For example, to include 20 bases at 
the end of each exon, enter 20 for both the Region Start 
value and the Region End value

To apply the current settings (the 
selected mode nd the Start/End 
Region values) to all genes, 
including any previously added 
genes

1. Click Apply Settings to All. 

An Overwrite warning message opens, indicating that all 
your gene-specific settings will be lost and asking you if 
you want to continue.

Figure 11-3:  Overwrite warning message

2. Click Yes to close the message and overwrite all the 
current gene-specific settings with the current gene 
settings.

To immediately use the BED file as a 
panel

1. Click Import as Panel.

The Panel Name dialog box opens.

Figure 11-4:  Panel Name dialog box

2. Enter the name for the panel, and then click OK.

The Panel Name dialog box closes, and the Manage 
Panels dialog box opens. The full directory path to the 
imported panel, including the panel name, is displayed in 
the Import from Panel File field.

3. Continue to “Importing a Panel” on page 85.
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6. Click OK.

The Save As dialog box opens. By default, the BED file is named default.bed.

7. Modify the name of the BED file as needed, and save it in a location of your choosing.
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Deleting Pathogenicity Changes with the Delete 
Pathogenicity Changes Tool

Sometimes, you might determine that a pathogenicity change or changes might not be valid. 
You use the Delete Pathogenicity Changes Tool to delete all the historical pathogenicity 
changes for all variants that were made during a certain time period. After you delete a 
historical pathogenicity change for a variant, the pathogenicity of the variant might be reset. 
For example, if the pathogenicity of a variant was changed from Unknown to Likely 
Deleterious on January 13, 2013, and you delete all the historical pathogenicity changes that 
were made from January 1, 2013 to January 31, 2013, then the pathogenicity of the variant is 
reset to Unassigned. If you changed the pathogenicity of the same variant from Likely 
Deleterious to Deleterious on February 1, 2013, and you delete all the historical 
pathogenicity changes that were made from January 1, 2013 to January 31, 2013, then the 
pathogenicity change from Unassigned to Likely Deleterious is deleted for the variant, but 
the pathogenicity of the variant remains Deleterious.

To delete historical pathogenicity changes with the Delete 
Pathogenicity Changes tool

1. On the Geneticist Assistant main menu, click Tools > Delete Pathogenicity Changes.

The Delete Pathogenicity Changes dialog box opens.

Figure 11-5:  Delete Pathogenicity Changes dialog box

2. Change the From value, the To value, or both values as needed. To change the value, 
select the value that is to be changed, for example, the month, and then you can manually 
enter the new value, or you can use the Up/Down field arrows to change the value. 

     

You must select each value that is to be changed one at a time. If you need to 
confirm the time period, remember that the Pathogenicity Changes pane on the 
Variant tab displays the date and time that a pathogenicity change was made. See 
“Pathogenicity Changes pane” on page 253.
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3. Click OK.

A Confirm Deleting Pathogenicity Changes message opens, asking you if you are sure 
that you want to delete “x” number of pathogenicity changes within the date range.

Figure 11-6:  Confirm Deleting Pathogenicity Changes message

4. Click Yes.

All the historical pathogenicity changes that were made during the specified time period 
are deleted from the Geneticist Assistant database. If applicable, the pathogenicities for 
some variants are reset. 
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Importing Variants with the Import Variants Tool
You can use the Import Variant Tool to import all the variants that are contained in a VCF file 
into your Geneticist Assistant database. If the VCF file contains the pathogenicity and 
pathogenicity status for the variants and/or comments for the variants, then you can also 
import this information. If the VCF file’s INFO fields do not contain this information, then 
you can still use the tool to import the variants that are contained in the file, but then you can 
manually set the pathogenicity and/or pathogenicity status for the variants, as well as add a 
comment for the variants. For either situation, this means that if multiple variants have the 
same pathogenicity for a panel group, you do not have to set the pathogenicity of each 
variant individually. Instead, you can set the same pathogenicity for all the variants at once 
using this tool.

To import variants with the Import Variants tool
1. On the Geneticist Assistant main menu, click Tools > Import Variants.

The Import Variants dialog box opens.

Figure 11-7:  Import Variants dialog box

2. Next to the Sample File field, click the Browse button  to open the Select a Variant 
File dialog box, and then browse to and select the appropriate VCF file.

3. On the Reference dropdown list, select the appropriate reference.

4. On the Panel dropdown list, select the panel for which you are settings the variants’ 
pathogenicity.

The Panel group name is displayed for Panel Group. 
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5. Continue to one of the following:

• “To automatically set the variants’ pathogenicities and statuses from the VCF file” 
below.

• “To manually set the variants’ pathogenicity and status” below.

To automatically set the variants’ pathogenicities and statuses 
from the VCF file

1. Leave Import from VCF’s INFO fields selected.

2. Do either or both of the following as needed:

• If the VCF file contains the pathogenicity and pathogenicity status for each variant, 
then to import this information, leave the Pathogenicity and Pathogenicity Status 
option selected. Otherwise, if the VCF file does not contain this information, or you 
do not want to import this information, then clear this option.

• If the VCF file contains comments for the variants, then to import this information, 
leave the Variant Comment option selected. Otherwise, if the VCF file does not 
contain this information, or you do not want to import this information, then clear 
this option.

3. Click OK.

The Import Variants dialog box closes. A Current Jobs tab opens that shows the progress 
of importing the VCF file. The tab remains open after the import is complete. The 
variants with the selected information are now imported into the Geneticist Assistant 
database. These variants will now be displayed with the imported information (such as 
the pathogenicity) in any samples that contain these variants.

To manually set the variants’ pathogenicity and status

When you manually set the pathogenicity and status for the variants in the VCF file, then the 
pathogenicity and status are set to the same values for all the variants in the file. If you add a 
comment, then the same comment is added for all the variants.

1. Select the Select Manually option.

The Import Variants dialog box is updated with options for setting the pathogenicity and 
the pathogenicity status for the variants as well entering a common comment for the 
variants. See Figure 11-8 on page 287.
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Figure 11-8:  Import Variants dialog box, Select manually option

2. Do any or all of the following as needed:

• On the Pathogenicity dropdown list, select the pathogenicity for the variants.

• On the Pathogenicity Status dropdown list, select the pathogenicity status for the 
variants.

• In the Pathogenicity Comment field, enter a common comment for all the variants.

3. Click OK.

The Import Variants dialog box closes. A Current Jobs tab opens that shows the progress 
of importing the VCF file. The tab remains open after the import is complete. The 
variants with the selected information are now imported into the Geneticist Assistant 
database. These variants will now be displayed with the specified information (such as 
the pathogenicity) in any samples that contain these variants.

Remember, you have the option of specifying custom pathogenicity types. Also, by 
default, only two statuses are available—Pending or Confirmed. You have the 
option of adding custom pathogenicity statuses. See “Managing Objects” on page 
49.
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Merging BAM Files with the Merge BAM Files 
Tool

If you have multiple BAM files for a sample, you do not need to submit each file as an 
individual sample, and then assign each file to the same patient. Instead, you can use the 
Merge BAM Files tool to merge all the BAM files into one file and then submit the file as a 
single sample.

To merge BAM files
1. On the Geneticist Assistant main menu, click Tools > Merge BAM Files.

The Merge BAM Files dialog box opens.

Figure 11-9:  Merge BAM Files dialog box

2. At the top of the dialog box, click the Browse button  to open the Select a file to add 

dialog box, and browse to and select the BAM files that are to be merged.

3. Next to the Save As field, click the Browse button  to open the Select file to save 

dialog box, and do the following:

• In the File name, enter the name for the merged BAM file. (The extension is .bam 
and you cannot change this.

• Browse to and select the directory in which to save the merged BAM files. 

CTRL-click to select the multiple BAM files.
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4. Click Save.

The Select file to save dialog box closes, and you return to the Merge BAM files dialog 
box.

5. Click Merge.

The message “Merging files now” is displayed at the top of the Merge BAM files dialog 
box. After the BAM files are successfully merged, the message “Merge complete” is 
displayed at the top of the Merge BAM files dialog box.

6. Click Close (x) to close the Merge BAM Files dialog box and return to the Geneticist 
Assistant main window.

Be patient during the merging of the BAM files. Depending on the number of files 
selected and the sizes of the files, merging might take several minutes.
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A
Action List

A list of items that require some type of follow up. In Geneticist Assistant, an Action List 
can be created for coverage regions on the Coverage Regions tab or for variants on the 
Sample tab.

Administrator user

A user of Geneticist Assistant to whom all available privileges are automatically assigned. 
Both Administrator privileges and Staff status can be assigned to the same Administrator 
user.

All Exon Mode

One of the allowed modes for the BED File Builder tool. Includes all the exons from all the 
selected transcripts in the BED file.

Artifact Type

Indicates that the variant at is not naturally present in the sample, but instead, it is formed by 
artificial means, such as during preparation of the sample; for example, a Sequencing 
artifact. A single default value, None, is supplied for artifact type. Additional values can be 
specified through the Add/Edit Object function in Geneticist Assistant.

Average Coverage

The average number of aligned reads for a region. This value is reported for all panel regions 
on the Coverage Regions tab and the Coverage Regions sub-tab on the Panel Statistics tab. A 
minimum value for the status of a region to be classified as “Passed” can be set on the 
Quality Control tab of the Settings dialog box.

B
BED file

A BED file is a tab-delimited text file. A panel can be created from a BED file for use in 
Geneticist Assistant. Each row in the file contains a region of the reference that is to be used 
in the application. At a minimum, the file contains the following information:

• Field #1 - Chromosome number for the region

• Field #2 - Chromosome start position

• Field #3 - Chromosome end position

• Field #4 - Optional comment column
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C
Chemistry

Refers to the chemistry that was used to prepare the samples for sequencing. Values can be 
specified through the Add/Edit Object function in Geneticist Assistant.

ClinVar pane

Found on the Variant tab. Displays the information for a variant from the ClinVar database. 
See http://www.ncbi.nlm.nih.gov/clinvar/intro/.

Coverage Downstream

The number of base pairs after the end of a panel region to which the quality control settings 
must apply. The quality control settings are specified on the Quality Control tab of the 
Settings dialog box.

Coverage Region Status

Indicates whether a panel region passed or failed the coverage settings that were set for the 
run. The status for every region in a panel is displayed on the Coverage Regions tab. Default 
values are Passed or Failed. Additional values can be specified through the Add/Edit Object 
function in Geneticist Assistant.

Coverage Threshold

The minimum required coverage values that a panel region must meet, or it is flagged as 
failed region for a run. Thresholds can be set globally (applies to all panel regions in all runs) 
on the Quality Control tab on the Settings dialog box, or it can set on a per panel basis.

Coverage Upstream

The number of base pairs before the start of a panel region to which the quality control 
settings must apply. The quality control settings are specified on the Quality Control tab of 
the Settings dialog box.

Custom report

Contains only user-specified data. 

D
dbNSFP pane

Found on the Variant tab. Displays the information from the dbNSFP database for a variant. 
See https://sites.google.com/site/jpopgen/dbNSFP.
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dbSNP pane

Found on the Variant tab. Displays the information from the dbSNP database for a variant. 
See http://www.ncbi.nlm.nih.gov/SNP/get_html.cgi?whichHtml=overview.

E
Exome Aggregation Consortium pane

Found on the Variant tab. Displays the information for the variant from the Exome 
Aggregation Consortium database for selected global sequencing projects. See 
http://exac.broadinstitute.org/.

Exome Variant Server pane

Found on the Variant tab. Displays the information from the Exome Variant Server database 
for the NHLBI GO Exome Sequencing project for a variant. See 
http://evs.gs.washington.edu/EVS/.

Exon Mode

The default mode for the BED File Builder tool. Allows for the inclusion of the coding 
regions in the BED file, the untranslated regions, or both.

G
Gene Direction

A display setting for sample variants’ reference alleles and observed alleles. Display the 
reference alleles and observed alleles based on the gene orientation. Set on the Variant 
Preferences tab for the Settings dialog box.

Group

Two or more users considered a single unit for the purpose of applying the same permissions 
in a single step.

H
Heterozygosity Lower Bound (%)

The minimum variant frequency for a variant to be considered heterozygous. Set on the 
Variant Preferences tab of the Settings dialog box. The default value is 20%.

Heterozygosity Upper Bound (%)

The maximum variant frequency for a variant to be considered heterozygous. Set on the 
Variant Preferences tab of the Settings dialog box. The default value is 80%.
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I
Instrument

Refers to the instrument that was used to sequence the samples. Values can be specified 
through the Add/Edit Object function in Geneticist Assistant.

L
LOVD Data pane

Found on the Variant tab. Displays the information from the LOVD (Leiden Open Variation 
Database) for the variant. See http://www.lovd.nl/3.0/docs/.

M
Minimum Coverage

The minimum coverage depth for a region. This value is reported for all panel regions on the 
Coverage Regions sub-tab on the Panel Statistics tab and the Coverage Regions tab. A 
minimum value for the status of a region to be classified as “Passed” can be set on the 
Quality Control tab of the Settings dialog box.

Missed Clinical Variant

A clinically relevant position that was identified in the Clinical Variants (ClinVar) database 
from the NCBI, and that was not covered for the sample. 

O
Object

Holds a value or variable that can be applied for carrying out runs in Geneticist Assistant. 

OMIM Data pane

Found on the Variants tab. Displays the information for the variant from the OMIM (Online 
Mendelian Inheritance in Man) database. See http://www.omim.org/.

P
Panel

A collection of genomic regions that are targeted for a specific genomic test or study. Panels 
are added to Geneticist Assistant by providing a BED file that defines the targeted regions, 
known as panel regions. Each sample that is submitted in Geneticist Assistant is assigned to 
a specific panel.

Panel Group
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Separately tracks the pathogenicities of variants that might be found in multiple panels. For 
example, the pathogenicity of a selected variant might be set to Deleterious for multiple 
cancer panels; however, the pathogenicity can be set to benign for a cardiac panel. You can 
create a group for each panel, and then assign the appropriate panels to each group.

Panel Region

The regions that have been targeted for a specific panel/test as defined by the BED file that 
was used to create the panel. 

Pathogenicity

The pathogenicity for a selected variant, which is the likelihood that the variant will cause a 
disease. Default values are Deleterious, Likely Deleterious, Unknown, Likely Benign, and 
Benign. Additional values can be specified through the Add/Edit Object function in 
Geneticist Assistant.

Pathogenicity Status

Indicates the status for changing the pathogenicity for a selected variant; for example, from 
Unknown to Benign. Default values are Pending and Confirmed. Additional values can be 
specified through the Add/Edit Object function in Geneticist Assistant.

Patient

Refers to an individual from whom a sample was taken. Any sample that is submitted to 
Geneticist Assistant can be associated with a patient.

Percent Covered (%)

The percent of a panel region that has reads aligned to it. This value is reported for all panel 
regions on the Coverage Regions sub-tab on the Panel Statistics tab and the Coverage 
Regions tab. A minimum value for the status of a region to be classified as “Passed” can be 
set on the Quality Control tab of the Settings dialog box.

Phenotype

The phenotype for a patient. Values can be specified through the Add/Edit Object function in 
Geneticist Assistant.

Preferred Transcript List

A tab-delimited text file that defines the specific transcript or isoform that is to be used for a 
gene. You can use different transcripts for different panels. The first column in the text file 
contains the gene name. The second column in the text file specifies the transcript by its 
nm_accession number.
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R
Read Balance

The balance in forward and reverse oriented reads with the variant as reported in the VCF 
file.

Reference Directory

Contains the information for the reference that was used for aligning data and/or detecting 
variants.

Run

Refers to loading a BAM file and a VCF file or just a VCF file into Geneticist Assistant for 
the purposes of importing a list of variants into the Geneticist Assistant database and/or 
reviewing a list of variants. 

Run Status

The status for a run. Default values are New, QC Passed, Reviewed, and Complete. 
Additional values can be specified through the Add/Edit Object function in Geneticist 
Assistant.

S
Sample Group

Two or more samples considered a single unit for the purpose of repeated processing over a 
period of time; for example, a group of control samples for which the coverage or variant 
frequency is to be tracked. Values can be specified through the Add/Edit Object function in 
Geneticist Assistant.

Sample Group Statistics

Various statistics that can be displayed for a sample group. Displayed on the Sample Variant 
Data sub-tab for the Sample tab.

Sample Status

The status for a sample. Default values are New, QC Passed, Reviewed, and Complete. 
Additional values can be specified through the Add/Edit Object function in Geneticist 
Assistant. 

Staff user

A user who can log into the django web administrator site. The actions that the Staff user can 
carry out depend upon the permissions assigned to him/her. Both Administrator privileges 
and Staff status can be assigned to the same user.
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Standard report

A report that includes all the data that is displayed in a selected pane on a data tab, for 
example, the Samples pane on the Run tab. Six different standard reports are available in 
Geneticist Assistant—Run, Coverage Regions, Panel Statistics, Sample, Variant, and Action 
List.

Standard user

A Geneticist Assistant user who has neither Administrator privileges nor Staff status. 

Subpanel

Contains a fixed number of regions that are contained within a selected panel. To verify 
coverage for a smaller number of regions that are within the panel that has been selected for 
a run, you can use a subpanel.

Supporting Information

Reference information and/or links to the appropriate websites that have been submitted to 
support the pathogenicity that is specified for a variant. Displayed in the Supporting 
Information pane on the Variant tab.

T
Trans

A column on the Sample Variant Data sub-tab on the Sample tab. Indicates whether the 
variant is Transition (Ti) or Transversion (Tv).

Transcript mode

One of the allowed modes for the BED File Builder tool. Adds the full transcript, including 
introns, to the BED file.

U
User

A person who logs into Geneticist Assistant either to add and review content, or use the 
application in a read-only capacity. Three types of users are available in Geneticist 
Assistant—an Administrator user, a Staff user, and a standard user. 

V
Variant Frequency

The frequency at which a variant is detected in a sample. In Geneticist Assistant, any value
< 1 is allowed, with 1 = 100%, 0.5 = 50%, and so on.
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Variant Preferences

Determines how information about the variants is displayed in all the variant sub-tabs or 
panes in Geneticist Assistant. Set on the Variant Preferences tab for the Settings dialog box.

Z
Zygosity

Indicates whether the variant is heterozygous or homozygous. In Geneticist Assistant, the 
selected zygosity is based on the Zygosity settings that are specified on the Variant 
Preferences tab of the Settings dialog box.
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defined ................... 130, 170, 204
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from the Run tab ...................204
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from the Run tab ...................204
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from the Run tab ...................204

from the Runs tab .................170

from the Samples sub-tab on the 
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in the Patient pane on the Patient 
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